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RESUMO 

 

 Neste trabalho de mestrado desenvolvemos um estudo sobre a aplicação de 

diferentes tipos de sistemas de projeto auxiliado por computador (CAD) e de 

prototipagem rápida no processo de projetação arquitetônica. Nosso objetivo foi o de 

avaliar como ocorre a transferência de informação dos elementos geométricos entre 

estes sistemas e como as dificuldades de interoperabilidade entre os mesmos 

podem afetar a fidedignidade dos modelos físicos gerados a partir dos modelos 

virtuais originais. Por isto elaboramos a hipótese que afirma que o uso de diferentes 

tipos de sistemas CAD e de prototipagem rápida resulta em diferentes níveis de 

sucesso na transferência de informações entre os mesmos, devido ao grau de 

precisão de cada sistema. Apesar do variado grau de precisão, estes sistemas 

produzem modelos físicos digitais com a representação satisfatória em relação ao 

modelo virtual original, portanto sem necessidade de retrabalho. A partir da 

realização de seis experimentos elaboramos uma análise comparativa entre os 

aspectos formais resultantes da modelagem e da prototipagem de um mesmo 

projeto arquitetônico em diferentes tipos de sistemas CAD: Revit, AutoCAD e FormZ. 

Os modelos CAD foram importados pelos softwares de prototipagem rápida 

ReplicatorG da Makerbot e Zprint da ZCorporation para serem produzidos por suas 

respectivas impressoras tridimensionais, pelo processo de adição de camadas. Os 

resultados obtidos a partir da experimentação foram avaliados em duas etapas: a 

primeira constatou que é possível obter a interoperabilidade integral das geometrias 

do modelo entre os diferentes sistemas CAD e os diferentes softwares de 

prototipagem rápida utilizados. A segunda etapa demonstrou que os sistemas 

apresentam diferentes graus de precisão, observados principalmente no momento 

de importação e reprodução das superfícies curvas e complexas do modelo.  Ao final 

desta dissertação, sugerimos um conjunto de recomendações para facilitar a 

utilização destas ferramentas digitais por parte dos arquitetos, para que as mesmas 

contribuam agilizando e tornando mais precisas as tomadas de decisão, durante o 

processo de projetação. Reduz-se, assim, a probabilidade de retrabalho do modelo 

virtual original, após sua importação por meio dos sistemas de prototipagem rápida. 

 

Palavras-chave: Sistemas CAD. Prototipagem Rápida. Interoperabilidade. Projeto 

de Arquitetura. 



  

ABSTRACT 

 

In this Master research work we develop a study about the application of 

different types of computer aided design (CAD) and rapid prototyping systems in the 

process of architectural design. Our goal is to assess how the transfer of geometric 

elements information between these systems occurs and also the difficulties of 

interoperability between them can affect the reliability of physical models generated 

from the original virtual models. Therefore we developed the hypothesis that the use 

of different types of CAD and rapid prototyping systems results in different levels of 

successful transfer of information between them, due to the accuracy of each 

system. Although the varied degree of precision, these systems produce digital 

physicals models with the satisfactory representation in relation to the original virtual 

model, so there is no need for rework. Upon completion of six experiments we 

performed a comparative analysis of the resulting formal aspects of modeling and 

prototyping of the same architectural design in different CAD systems: Revit, 

AutoCAD and FormZ. The CAD models were imported by the software for rapid 

prototyping of ReplicatorG MakerBot and Zprint of ZCorporation to be produced by 

their respective three-dimensional printers, in the process of adding layers. The 

results from the trial were evaluated in two stages: the first one found it possible to 

achieve full interoperability of the model geometry between different CAD systems 

and different software used for rapid prototyping. The second stage showed that the 

systems have varying degrees of precision, mainly observed at the time of importing 

and reproduction of curved and complex surfaces model. At the end of this 

Dissertation, we suggest a set of recommendations in order to make it easier for the 

architects to use these digital tools, so that the same ones may contribute to 

accelerate it and also, to make it possible for these professionals to get more 

accuracy, when making up their minds, during the entire process. Thus, the need to 

rework the proposed model after importing it to the rapid prototyping systems is 

reduced.  

 

Keywords: CAD Systems. Rapid  Prototyping. Interoperability. Architectural Design. 

 

 

 



  

LISTA DE FIGURAS  

 

Figura 1 - Modelo virtual e protótipo rápido, projeto Ópera, Walter Mourão, 2º 

semestre 2010 ........................................................................................................... 18 

Figura 2 - Modelo virtual e protótipo rápido, projeto Museu, Bianca Ilha, 1º semestre 

2011 .......................................................................................................................... 18 

Figura 3 - Desenho em Papiro, Egito, Dinastia XVIII ................................................. 25 

Figura 4 - Elevação do Palácio de Sansedoni, 1340, arquiteto Giovanni di Agostino

 .................................................................................................................................. 27 

Figura 5 - Representação de sólido em épura .......................................................... 29 

Figura 6 - O Crystal Palace, Londres (1951), Joseph Paxton ................................... 31 

Figura 7 - Escola Bauhaus, arquiteto Walter Gropius, Desseau, Alemanha, 1926 ... 32 

Figura 8 - O papel integrador do modelo digital ........................................................ 34 

Figura 9 - Mapeamento proposto por Lawson ........................................................... 36 

Figura 10 - À esquerda projeto urbano, The pick, Hong Kong, 1982; à direita Estádio 

Al Whada, em Abu Dhabi, 1988, Zaha Hadid ............................................................ 39 

Figura 11 - (a) Croquis; (b) e (c) Pinturas; (d) e (e) Fotos da obra da estação de trem, 

em Strasbourg, França (2001), Zaha Hadid .............................................................. 42 

Figura 12 - Museu Nacional de Arte do Século 21, Roma, Zaha Hadid, 2009 .......... 44 

Figura 13 - Pavilhão Chanel Mobile Art, Hong Kong, Tóquio, Nova York, Zaha Hadid, 

2010 .......................................................................................................................... 44 

Figura 14 - Imagens do modelo virtual, Museu de Guggenheim em Taichung, Zaha 

Hadid, 2006 ............................................................................................................... 45 

Figura 15 - Fotos do Modelo Prototipado, Museu de Guggenheim em Taichung, 

Zaha Hadid, 2006 ...................................................................................................... 45 

Figura 16 - Modelagem B-Rep e Modelagem CSG ................................................... 48 

Figura 17 - O processo de digitalização do modelo físico, no escritório de Frank 

Gehry ........................................................................................................................ 52 

Figura 18 - Mecanismo Jacquard de 1804, no Musée des arts et métiers, França ... 56 

Figura 19 - A Escultura do Peixe, Frank Gehry, Barcelona, 1992 ............................. 57 

Figura 20 - Processos de fabricação digital: (a) Conformação e (b) Corte ................ 58 

Figura 21 - Processos de fabricação digital: (c) Subtração e (d) Adição ................... 59 

Figura 22 - Pavilhão "Dynaform" da BMW, Bernhard Franken, Frankfurt, 2001 ........ 61 



  

Figura 23 - (a) Impressora 3D, modelo ZPrinter 310 Plus, da Z Corporation; (b) 

Impressora 3D RapMan 3.1 Ultimate, da 3D Systems .............................................. 67 

Figura 24 - (a) Equipamento de estereolitografia (SLA); (b) Sinterização seletiva a 

laser (SLS); (c) Equipamento de modelagem de objeto laminado (LOM); (d) 

Modelagem por deposição e fusão (FDM) ................................................................ 70 

Figura 25 - Fases do processo de prototipagem rápida por adição de camadas ...... 71 

Figura 26 - Protótipo rápido do projeto do Edifício de Artes Dramáticas e Mídia 

Eletrônica do Instituto Politécnico de Rensselaer, Morphosis, EUA .......................... 75 

Figura 27 - Representação da normal e dos vértices de cada triângulo no arquivo 

STL em ASCII ........................................................................................................... 82 

Figura 28 - Estrutura de um arquivo STL em ASCII .................................................. 82 

Figura 29 - Estrutura de um arquivo STL binário ....................................................... 83 

Figura 30 - Exemplo de rachadura (crack): (a) superfície lisa; (b) superfície 

representada por faces planas; (c) superfície com faces planas corrigidas .............. 85 

Figura 31 - Exemplos de: a) Orientação inconsistente da normal; b) Objeto com 

normais trocadas; ...................................................................................................... 86 

Figura 32 - Exemplos de geometria duplicada: a) Cubo com um lado triangulado e 

desviado; ................................................................................................................... 86 

Figura 33 - Exemplo de Erros de Cavidade. a) Superfície original (traçado vermelho)

 .................................................................................................................................. 86 

Figura 34 - Local do terreno do experimento (@-15.841028,-47.897456) ................ 95 

Figura 35 - Fotos do processo de fabricação na impressora ZCorporation ............. 120 

Figura 36 - Fotos do processo de fabricação na impressora Thing-O-Matic da 

MakerBot ................................................................................................................. 120 

Figura 37 - Fotos do processo de limpeza do protótipo na impressora Zprinter...... 121 

Figura 38 - Fotos dos equipamentos de prototipagem rápida do LFDC .................. 122 

 

 

 

  



  

LISTA DE QUADROS 

 

Quadro 1 - Resumo esquemático da problemática ................................................... 19 

Quadro 2 - Resumo esquemático da evolução das ferramentas de representação na 

arquitetura ................................................................................................................. 35 

Quadro 3 - Campos de utilização de prototipagem rápida e fabricação digital ......... 63 

Quadro 4 - Comparações entre os tipos de prototipagem digital .............................. 72 

Quadro 5 - Comparações entre prototipagem rápida (PR), modelo virtual (MV) e às 

etapas de modelagem convencional ......................................................................... 73 

Quadro 6 - Etapas gerais do processo de prototipagem rápida por adição de 

camadas .................................................................................................................... 75 

Quadro 7 - Fases do método de investigação ........................................................... 88 

Quadro 8 - Especificações técnicas da impressora ZPrinter 310 plus monocromática

 .................................................................................................................................. 93 

Quadro 9 - Especificações técnicas da impressora Thing-O-Matic ........................... 94 

Quadro 10 - Comparação entre os resultados da Fase 1 e da Fase 2 (Modelo AZ)

 ................................................................................................................................ 112 

Quadro 11 - Comparação entre os resultados da Fase 1 e da Fase 2 (Modelo BZ)

 ................................................................................................................................ 113 

Quadro 12 - Comparação entre os resultados da Fase 1 e da Fase 2 (Modelo CZ)

 ................................................................................................................................ 114 

Quadro 13 - Comparação entre os resultados da Fase 1 e da Fase 2 (Modelo AX)

 ................................................................................................................................ 115 

Quadro 14 - Comparação entre os resultados da Fase 1 e da Fase 2 (Modelo BX)

 ................................................................................................................................ 116 

Quadro 15 - Comparação entre os resultados da Fase 1 e da Fase 2 (Modelo CX)

 ................................................................................................................................ 117 

Quadro 16 - Tamanho dos arquivos dos modelos CAD, STL e número de faces ... 118 

Quadro 17 - Tempo e material gasto no processo de prototipagem dos experimentos

 ................................................................................................................................ 119 

Quadro 18 - Comparação entre os resultados da Fase 1, Fase 2 e Fase 4 (Modelo 

AX) .......................................................................................................................... 124 

Quadro 19 - Diferenças na representação do protótipo rápido AX (Thing-O-Matic) 

comparado ao modelo CAD A (Revit) ..................................................................... 125 



  

Quadro 20 - Comparação entre os resultados da Fase 1, Fase 2 e Fase 4 (Modelo 

AZ) .......................................................................................................................... 127 

Quadro 21 - Diferença na representação do protótipo rápido AZ (Zprinter) 

comparado ao modelo CAD A (Revit) ..................................................................... 128 

Quadro 22 - Comparação entre os resultados da Fase 1, Fase 2 e Fase 4 (Modelo 

BX) .......................................................................................................................... 129 

Quadro 23 - Diferenças na representação do protótipo rápido BX ((Thing-O-Matic) 

comparado ao modelo CAD B (AutoCAD) .............................................................. 130 

Quadro 24 - Comparação entre os resultados da Fase 1, Fase 2 e Fase 4 (Modelo 

BZ) .......................................................................................................................... 132 

Quadro 25 - Diferenças na representação do protótipo rápido BZ (Zprinter) 

comparado ao modelo CAD B (AutoCAD) .............................................................. 133 

Quadro 26 - Comparação entre os resultados da Fase 1, Fase 2 e Fase 4 (Modelo 

CX) .......................................................................................................................... 134 

Quadro 27 - Diferenças na representação do protótipo rápido CX (Thing-O-Matic) 

comparado ao modelo CAD C (FormZ) ................................................................... 135 

Quadro 28 - Comparação entre os resultados da Fase 1, Fase 2 e Fase 4 (Modelo 

CZ) .......................................................................................................................... 137 

Quadro 29 - Diferenças na representação do protótipo rápido CZ (Zprinter) 

comparado ao modelo CAD C (FormZ) ................................................................... 138 

Quadro 30 - Comparação entre o resumo dos resultados do experimento (Modelo 

AX) .......................................................................................................................... 141 

Quadro 31 - Comparação entre o resumo dos resultados do experimento (Modelo 

AZ) .......................................................................................................................... 142 

Quadro 32 - Comparação entre o resumo dos resultados do experimento (Modelo 

BX) .......................................................................................................................... 143 

Quadro 33 - Comparação entre o resumo dos resultados do experimento (Modelo 

BZ) .......................................................................................................................... 144 

Quadro 34 - Comparação entre o resumo dos resultados do experimento (Modelo 

CX) .......................................................................................................................... 145 

Quadro 35 - Comparação entre o resumo dos resultados do experimento (Modelo 

CZ) .......................................................................................................................... 146 

Quadro 36 - Tamanho dos arquivos dos modelos CAD e STL e tempo total de 

fabricação ................................................................................................................ 149 



  

Quadro 37 - Recomendações gerais para modelagem em CAD e prototipagem 

rápida por adição ..................................................................................................... 152 

Quadro 38 - Recomendações específicas para modelagem em CAD e prototipagem 

rápida por adição ..................................................................................................... 153 

  



  

LISTA DE ABREVIATURAS E SIGLAS 

 

3D  Três dimensões ou Tridimensional 

3DP  Tridimensional Printer - Impressão ou impressora Tridimensional 

AA  Architectural Association - School of Architecture 

ASCII  American Standard Code for Information Interchange - Código Padrão 

  Americano para Intercâmbio de Informação 

BIM  Building Information Modeling - Modelagem de Informação de  

  Edificação 

CAD  Computer Aided Design - Projeto Auxiliado por Computador 

CAM  Computer Aided Manufacturing - Manufatura Auxiliada por Computador 

CIS/2  CIMSteel Integration Standards 

CNC  Computer Numerical Control - Controle Numérico Computadorizado 

DWG  extensão de arquivo do software AutoCAD 

FDM  Fused Deposition Modeling - Modelagem por Deposição e Fusão 

FMZ  extensão de arquivo do software FormZ 

GCode extensão de arquivo do software ReplicatorG 

IFC  Industry Foundation Classes 

ISO  International Standardization organization - Organização Internacional 

  de Padronozação 

KB  Kilobyte 

LAPAC Laboratório de Automação e Prototipagem Rápida para Arquitetura e 

  Construção - UNICAMP  

LFDC  Laboratório de Fabricação Digital e Costumização em Massa - UnB 

LOM  Laminated Object Manufacturing - Modelagem de Objeto Laminado  

PR  Protótipo ou Prototipagem Rápida - Rapid Prototyping or Prototype 

RVT  extensão de arquivo do software Revit 

SLA   Stereolithography - Estereolitografia  

SLS  Selecitve Laser Sintering - Sinterização Seletiva a Laser 

STL  extensão de arquivo utilizado em sistemas de prototipagem rápida e 

  fabricação digital 

TIC  Tecnologia de Informação e Comunicação 

ZBD  extensão de arquivo do software Zprint 

  



  

SUMÁRIO 

1 INTRODUÇÃO ................................................................................................... 14 

1.1 Problemática ............................................................................................................................ 15 

1.2 Hipótese ................................................................................................................................... 20 

1.3 Objetivos .................................................................................................................................. 21 

1.4 Estrutura desta Dissertação ................................................................................................... 21 

2 REVISÃO BIBLIOGRÁFICA .............................................................................. 24 

2.1 A evolução do processo de projetação arquitetônica......................................................... 24 

2.2 O processo digital de projetação arquitetônica ................................................................... 34 

3 ESTUDO DE PRECEDENTE ZAHA HADID ARQUITETOS .............................. 38 

3.1 O processo de projeto ............................................................................................................ 39 

3.2 O uso de ferramentas digitais ................................................................................................ 43 

4 SISTEMAS CAD ................................................................................................. 47 

4.1 Modelos CAD ........................................................................................................................... 51 

4.2 Modelos BIM ............................................................................................................................ 53 

5 SISTEMAS CAM ................................................................................................ 56 

5.1 A prototipagem rápida ............................................................................................................ 62 

5.2 O modelo físico ........................................................................................................................ 64 

5.3 O protótipo rápido ................................................................................................................... 66 

5.4 O processo de prototipagem rápida na arquitetura ............................................................ 74 

6 INTEROPERABILIDADE ................................................................................... 77 

6.1 Tipos de formatos ................................................................................................................... 78 

6.2 O formato STL .......................................................................................................................... 80 

6.3 A interoperabilidade CAD/CAM .............................................................................................. 83 

6.4 A qualidade do modelo CAD .................................................................................................. 84 

7 MÉTODO DE INVESTIGAÇÃO .......................................................................... 88 

7.1 Equipamentos e softwares de sistemas CAD ...................................................................... 90 

7.2 Equipamentos e softwares de sistemas de prototipagem rápida ...................................... 92 

7.3 Descrição do método de investigação .................................................................................. 94 

7.3.1 Fase 1 (Modelagem no sistema CAD) .............................................................................. 95 

7.3.2 Fase 2 (Planejamento) ...................................................................................................... 98 

7.3.3 Fase 3 (Fabricação no sistema de prototipagem rápida) .................................................. 99 

7.3.4 Fase 4 (Acabamento) ...................................................................................................... 100 



  

8 EXPERIMENTAÇÃO ........................................................................................ 101 

8.1 Fase 1 (Modelagem no sistema CAD) ................................................................................. 101 

8.1.1 Modelo CAD A (Revit) ..................................................................................................... 102 

8.1.2 Modelo CAD B (AutoCAD) .............................................................................................. 104 

8.1.3 Modelo CAD C (FormZ)................................................................................................... 107 

8.2 Fase 2 (Planejamento) .......................................................................................................... 108 

8.2.1 Software Zprint ................................................................................................................ 109 

8.2.2 Software ReplicatorG ...................................................................................................... 110 

8.3 Fase 3 (Fabricação no sistema de prototipagem rápida) .................................................. 118 

8.4 Fase 4 (acabamento) ............................................................................................................. 121 

9 ANÁLISE DOS RESULTADOS ........................................................................ 123 

10 CONCLUSÃO ............................................................................................... 150 

10.1 Desdobramentos Futuros ..................................................................................................... 154 

REFERÊNCIAS BIBLIOGRÁFICAS ....................................................................... 155 

APÊNDICE A - DESENHOS DO PROJETO ARQUITETÔNICO DO MODELO DO 

EXPERIMENTO ...................................................................................................... 162 

APÊNDICE B - VISTAS EXTERNAS RENDERIZADAS DOS MODELOS CAD .... 171 

APÊNDICE C - VISTAS EXTERNAS DOS MODELOS IMPORTADOS PARA 

PROTOTIPAGEM ................................................................................................... 177 

APÊNDICE D - FOTOS DOS PROTÓTIPOS RÁPIDOS ........................................ 189 

APÊNDICE E - IMAGENS DOS ARQUIVOS STL DOS MODELOS CAD 

IMPORTADOS NO SOFTWARE FORMZ............................................................... 201 

 



 14 

1 INTRODUÇÃO 

 

A tecnologia digital, em constante evolução, apresenta ferramentas cada vez 

mais acessíveis em termos de interatividade e custo, para auxiliar nos processos de 

projetação, de fabricação digital de elementos arquitetônicos e de construção de 

edificações. Tais processos de projeto possuem condicionantes difíceis de atender, 

quando adotados os padrões tradicionais, ou seja, não digitais para representar e 

produzir principalmente as formas complexas. A evolução do processo e das 

ferramentas utilizadas para representação e produção da arquitetura, desde a 

antiguidade até os dias atuais são descritos na revisão bibliográfica. 

A proposta desta pesquisa é estudar a aplicação de ferramentas digitais, 

como a modelagem virtual associada ao uso da prototipagem rápida, inseridas no 

contexto do processo de projetação arquitetônica e seus respectivos resultados. Os 

benefícios obtidos por arquitetos, com a apropriação de ferramentas computacionais 

para o desenvolvimento de projetos, podem ser observados em trabalhos de 

escritórios com referência internacional, alguns apresentados nesta pesquisa, por 

meio de abordagem e foco no processo de projetação.  

Se, por um lado, existem vantagens potencializadas pelo uso associado das 

ferramentas de projeto e manufatura auxiliada por computador (CAD/CAM), como a 

redução do tempo de elaboração e maior precisão da representação do projeto; por 

outro, problemas como transmissão de dados da geometria do modelo podem 

ocorrer entre estes sistemas, produzindo modelos físicos diferentes dos modelos 

virtuais, em relação à intenção original do projetista.  

A partir do entendimento da utilização da modelagem virtual e prototipagem 

rápida, pretende-se aumentar a capacidade de interoperabilidade, por meio de 

procedimentos preventivos e de configurações, além de enfatizar as diversas 

vantagens e benefícios dessas tecnologias adequadas no auxílio de todo o processo 

de projetação arquitetônica. 

O objetivo específico desta dissertação é o de avaliar a capacidade de 

interoperabilidade entre os modelos virtuais gerados a partir de diferentes tipos de 

sistemas de projeto auxiliado por computador (CAD) e de sistemas de fabricação 

digital (CAM). De maneira que essas ferramentas possam ser utilizadas sem gerar 

retrabalho durante a produção do protótipo rápido, auxiliando desde o início do 
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processo de projetação, por representar de forma fidedigna as intenções do 

arquiteto. 

Neste sentido, para poder propor os procedimentos necessários à redução 

dos problemas de interoperabilidade entre os sistemas, foi definido, para efeito de 

método de investigação, um mesmo projeto a ser modelado em três diferentes tipos 

de sistemas CAD (Computer Aided Design) e exportado para dois diferentes tipos de 

impressora tridimensional, com a intenção de obter o protótipo rápido idêntico ao 

modelo original virtual. 

 O processo de experimentação foi dividido em quatro fases, que inicia com 

a definição e modelagem do projeto, posteriormente a importação do modelo para o 

sistema de prototipagem, em sequência a fabricação do modelo físico digital e, por 

último, o acabamento do protótipo. Os resultados obtidos em cada fase possibilitam 

testar a hipótese deste trabalho. 

Espera-se com este estudo contribuir efetivamente na redução de retrabalho 

na modelagem e no tempo para obtenção do protótipo digital, com o consequente 

aumento de tempo disponível para a experimentação do modelo gerado. Nesse 

aspecto, a prioridade não é apenas elaborar projetos em prazo reduzido, mas 

projetos de arquitetura melhores, principalmente quanto aos quesitos formais, 

funcionais e de desempenho estrutural e energético. Estes quesitos se apresentam 

como condicionantes fundamentais de uma edificação sustentável, que preconiza a 

redução do impacto ambiental que uma construção pode gerar, atendendo a uma 

demanda legal e atual de mercado. 

 

 

1.1 Problemática 

 

O arquiteto, quando ciente das possibilidades da fabricação digital, tem a 

expectativa de obter, diretamente do modelo virtual, o modelo físico de forma 

idêntica e automatizada, reduzindo o tempo de elaboração do projeto e garantindo 

precisão no produto final.  

Além do caso estudado no presente trabalho, sobre Zaha Hadid, outros 

escritórios estrangeiros como Foster & Partners, Garafalo Architects e Gehry 

Associates, que adotaram o uso de modelagem digital e de prototipagem rápida no 

processo de projetação, apresentam resultados surpreendentes em termos de 
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qualidade e produtividade (PUPO, 2008, p. 11). Nos escritórios brasileiros, a 

prototipagem rápida raramente é utilizada no início do processo, e eventualmente 

visa à apresentação final de um projeto. Uma das razões apontadas por Celani e 

Bertho (2007) para a pouca utilização dessas ferramentas é a falta de conhecimento 

das suas técnicas. 

Em termos gerais, a deficiência na formação de profissionais de arquitetura, 

no sentido de utilizar as ferramentas de fabricação digital, contribui para agravar a 

lentidão na incorporação destes recursos. Além da desinformação formal de 

tendências mais amplas de projeto, soma-se a desinformação tecnológica em 

relação ao uso dos programas de modelagem tridimensional digital (KOLAREVIC, 

2003, p. 6). 

A utilização da prototipagem rápida em projeto de arquitetura, em nosso 

país, ainda é incipiente. Em outras áreas, esta se concentra principalmente na 

produção de modelos para a engenharia mecânica, desenho industrial e 

paleontologia, além de contramoldes para fundição de próteses, utilizadas em 

cirurgias de reconstrução bucomaxilofacial e cranial. No caso de muitos escritórios 

de arquitetura americanos, europeus e asiáticos, a prototipagem rápida é utilizada 

desde as fases iniciais do processo de projeto (CELANI; BERTHO, 2007, p. 5).  

É importante ressaltar que esses recursos vêm sendo utilizados desde a 

década 1980 pelas indústrias brasileiras de aeronaves e de automóveis. A partir do 

ano 2000, a fabricação suportada por sistemas digitais também tem apresentado 

aplicação em parte da indústria da construção civil no Brasil, como por exemplo, nas 

fábricas de estruturas de aço e de armações de metal (CUNHA, 2008, p. 70-91). 

Alguns dos exemplos nacionais de fabricação digital são o Memorial Darcy Ribeiro, 

do arquiteto João Filgueiras Lima, 2011 (DARCY, 2010, p.55-59), e os esferóides no 

memorial JK, do artista Darlan Rosa, 2002 (ROSA, 2011), ambos em Brasília, no 

Distrito Federal. 

Nardelli e Vicent (2009) revelam como os escritórios de arquitetura 

paulistanos utilizam as tecnologias de informação e comunicação (TICs). A 

tecnologia digital é utilizada de maneira conservadora, praticamente em todas as 

etapas do processo de produção dos projetos, limitando-se à automatização de 

processos. A concepção do projeto, em praticamente 90%, ainda é desenvolvida por 

meio de croquis. O uso da prototipagem rápida CNC (Computer Numeric Control) 

tem sido aplicada em caso isolado (NARDELLI; VICENT, 2009).  

http://www.flickr.com/
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O pouco uso da prototipagem rápida durante o processo de projetação 

arquitetônica pode estar relacionado ao fato da materialização do modelo virtual em 

protótipo rápido não ocorrer de forma direta e simples, entre outros fatos que não 

serão o foco desta pesquisa. No sentido de obter um protótipo rápido, inicialmente o 

modelo virtual produzido em software CAD tridimensional deve ser exportado para 

um programa CAM ou CNC. Este processo geralmente ocorre com o uso de arquivo 

no formato STL, para ser preparado e finalmente enviado para o maquinário que 

produz o modelo físico. Em raros casos, alguns softwares CAD como, por exemplo, 

o FormZ da AutoDesSys, exportam especificamente no formato nativo de 

determinado sistema CAM de destino, mas ainda assim problemas de tradução 

podem ser detectados.  

Os autores Orciuoli e Celani (2010, p. 70) esclarecem que existem várias 

etapas a serem percorridas entre o modelo tridimensional virtual e o objeto físico 

fabricado:  

 

A expressão “file-to-factory” (do arquivo à fábrica) esconde o fato de que o 
modelo virtual, precisa na maioria dos casos, ser corrigido, adaptado, 
preparado e transformado em código de máquina para que possa ser 
compreendido pelos equipamentos de fabricação digital.  

 
 

Por sua vez, os arquitetos, por não conhecerem adequadamente esses 

equipamentos, acabam não tirando proveito de suas possibilidades. Como exemplo 

de problemas que podem ocorrer na impressão tridimensional de um modelo virtual, 

pode-se citar diferentes trabalhos de projeto final de graduação, desenvolvidos por 

dois alunos da FAU/UnB. Ambos utilizaram o mesmo software CAD tridimensional, o 

Rhinoceros 3D. A Figura 1 apresenta, à esquerda, a imagem do modelo virtual e, à 

direita, o Protótipo Rápido com falhas na fabricação digital, provavelmente devido à 

redução da escala do modelo. Por outro lado, a Figura 2 apresenta, à esquerda, 

uma imagem do modelo virtual e, à direita, o protótipo rápido com falhas na 

fabricação, provavelmente devido aos problemas de transferência de dados da 

geometria complexa do modelo virtual. 
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Figura 1 - Modelo virtual e protótipo rápido, projeto Ópera, Walter Mourão, 2º semestre 2010 
Fonte: Arquivo pessoal 

 

   
 

Figura 2 - Modelo virtual e protótipo rápido, projeto Museu, Bianca Ilha, 1º semestre 2011 
Fonte: Arquivo pessoal 

 

O modelo virtual, quando importado para o software de prototipagem rápida, 

pode apresentar problemas detectados pelo próprio programa de controle numérico, 

tais como erros na modelagem do projeto, inversão das normais de faces e sólidos 

mal formados, entre outros. Estes softwares de controle numérico, por sua vez, 

efetuam correções de forma automática, que podem gerar alterações na forma 

original do modelo. Alternativamente essas ferramentas permitem que o usuário faça 

as correções necessárias manualmente. Em outros casos, as correções são apenas 

possíveis retornando-se ao software de modelagem, o que requer retrabalho. 

As causas de problemas no modelo virtual surgem quando os projetistas de 

CAD não entendem a aplicação dos requisitos geométricos e não têm uma maneira 

eficiente de validar os requisitos de modelagem, para identificar problemas 

potenciais. Nesse contexto, outra questão pode ser abordada, no que diz respeito à 

perda da intenção do projeto original na tentativa de efetuar o conserto da geometria 

em uma cópia do mesmo. Isto ocorre, porque as mudanças não são comunicadas 

de volta ao modelo original e características importantes do modelo são tratadas 

com correções equivocadas, muitas vezes simplificando a versão de cópia do 

modelo (McKENNEY, 1998, p.3). 
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Esses arquivos CAD com defeito podem causar ineficiência devida à perda 

de tempo e de produtividade, à perda da intenção do projeto e pela qualidade do 

produto final inferior ao projetado. Isto pôde ser constatado, no final da década de 

1990, pela empresa americana ITI (International TechneGroup Incorporated) que 

verificou que até 70% dos homem/hora trabalhados foram desperdiçadas em 

correções de problemas de geometria no processo de prototipagem rápida (Ibid., p. 

4). 

 
Quadro 1 - Resumo esquemático da problemática 

 
Fonte: Autoria nossa 

 

O Quadro 1, acima, descreve de maneira esquemática o problema quando o 

arquiteto obtém o protótipo rápido de maneira diferente da representação formal 

comparada com a representação do modelo virtual original.  

Portanto é necessário avaliar como ocorre a transferência de dados do 

modelo exportado pelo sistema CAD, para ser importado no sistema de 

prototipagem rápida, de forma que não venha ocorrer falhas na fabricação e 

consequentemente retrabalho do modelo. 

Considerando-se a revisão bibliográfica e o contexto atual do processo de 

projetação, utilizando modelagem virtual e prototipagem rápida em arquitetura, as 

questões específicas da presente pesquisa foram assim definidas: 

Como é feita a exportação dos modelos virtuais para os softwares de 

prototipagem rápida? 



 20 

Quais os problemas que podem ser identificados no momento da fabricação 

de um modelo virtual, por meio do uso de sistemas de prototipagem rápida? Qual a 

origem destes problemas? 

Como os problemas, detectados no momento em que o modelo é importado 

pelo sistema de prototipagem rápida, podem ser resolvidos? 

Quais os tipos de retrabalho no modelo virtual, necessários para a efetivação 

do protótipo rápido? 

Todas as informações necessárias do modelo virtual são exportadas para 

resultar em modelos físicos gerados digitalmente com fidedignidade? 

 
 
 
1.2 Hipótese 

 

Algumas considerações devem ser feitas, como apresentam os exemplos 

anteriores das Figuras 1 e 2, para que se possa estabelecer a hipótese desta 

Dissertação, as quais sugerem a existência de problemas sistêmicos de 

interoperabilidade no uso das ferramentas de prototipagem rápida, para a fabricação 

do modelo do projeto arquitetônico.  

Neste contexto, os recursos oferecidos pelos softwares de sistemas CAD de 

modelagem parecem não oferecer capacidade de transferência de informações da 

geometria do modelo de maneira adequada, ou ainda, os softwares de sistemas de 

prototipagem não conseguem importar todas as informações para representar o 

modelo virtual original.  

Portanto, a interoperabilidade entre os softwares de modelagem virtual e os 

de prototipagem rápida, quando realizada de forma integral, contribui positivamente 

para a rapidez e o aumento da qualidade da fabricação do modelo físico, além de 

possibilitar uma melhor tomada de decisão, desde o início do processo de 

projetação arquitetônica.  Assim, o presente trabalho de dissertação baseia-se na 

seguinte hipótese: 

 

 O uso de diferentes tipos de sistemas CAD e de prototipagem rápida resulta 

em diferentes níveis de sucesso na transferência de informações entre os 

mesmos, devido ao grau de precisão de cada sistema. Apesar do variado 

grau de precisão, estes sistemas produzem modelos físicos digitais com a 
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representação satisfatória em relação ao modelo virtual original, portanto 

sem necessidade de retrabalho. 

 

 

1.3 Objetivos 

 

Este trabalho tem como proposta estudar a aplicação da modelagem virtual 

e prototipagem rápida, durante o processo de projetação da arquitetura, e os seus 

respectivos resultados. Nesta pesquisa, tais recursos são considerados centrais no 

desenvolvimento desse processo, ao invés de serem usados apenas para a 

representação final do projeto de arquitetura. 

O objetivo específico é o de avaliar a capacidade de interoperabilidade 

integral entre diferentes sistemas CAD e sistemas de prototipagem, e verificar se há 

necessidade de retrabalho, para obter o aspecto formal do protótipo rápido o mais 

próximo possível do modelo virtual original. 

A intenção é a de realizar, por meio de experimentos, um diagnóstico e 

produzir um conjunto de recomendações, de como pode funcionar a 

interoperabilidade entre diferentes sistemas CAD de modelagem virtual e diferentes 

sistemas de prototipagem rápida, de maneira a obter-se um resultado satisfatório 

com os recursos digitais atualmente existentes. 

 

 

1.4 Estrutura desta Dissertação 

 

Esta Dissertação está estruturada nos seguintes capítulos: o primeiro 

contém a introdução, que apresenta o tema desta pesquisa, e a problemática que 

trata das possíveis dificuldades de interoperabilidade entre os sistemas CAD e de 

prototipagem rápida. Em seguida, apresentamos a hipótese e os objetivos que 

norteiam esta pesquisa. 

O segundo capítulo compreende uma revisão bibliográfica. Em sua primeira 

parte apresenta a evolução do processo de projetação arquitetônica, desde a 

antiguidade até os dias atuais. O foco são os tipos de ferramentas utilizadas para 

representação, o papel do profissional da arquitetura e consequentemente o produto 

resultante. A segunda parte relata o processo digital de projetação arquitetônica, 
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destacando as ferramentas computacionais mais conhecidas na atualidade. Além 

disto, informa como ocorre o processo de projeto no contexto arquitetônico, 

destacando o diferencial decorrente do uso das ferramentas digitais. 

No terceiro capítulo descrevemos a título de estudo de precedente, o 

processo de desenvolvimento dos projetos da arquiteta Zaha Hadid e sua equipe e a 

incorporação das ferramentas digitais. 

No quarto capítulo apresentamos os conceitos dos sistemas CAD, 

observando a sua evolução histórica, suas características e vantagens como 

ferramentas de auxílio na projetação arquitetônica. 

No quinto capítulo descrevemos os sistemas CAM, a viabilização do seu uso 

na construção civil, os tipos de fabricação digital, os resultados decorrentes da 

mudança de paradigma da padronização para customização em massa. 

Ainda neste capítulo, relatamos a diferença entre os termos prototipagem 

rápida e fabricação digital, as diferenças entre o modelo físico e o protótipo rápido e 

as características dos diferentes tipos de equipamentos utilizados nestes processos. 

Em seguida, descrevemos como o processo de prototipagem rápida, dividido em 

fases distintas, pode ser utilizado como recurso de projeto na arquitetura. 

Apresentamos ainda exemplo de escritórios que utilizam essas ferramentas digitais 

no atelier de projeto. 

No sexto capítulo discorreremos sobre interoperabilidade, os tipos de 

formatos conhecidos para transferência de dados, particularmente o formato STL, 

que apresentamos com mais detalhes. Por fim, descrevemos como acontece a 

interoperabilidade entre os sistemas CAD/CAM e os tipos de problemas que podem 

ocorrer quando os utilizamos. 

No sétimo capítulo apresentamos o método de investigação elaborado para 

testar a hipótese desta Dissertação. A seguir elaboramos um roteiro de como deve 

ser conduzido o teste de nossa hipótese, o qual é dividido em quatro fases distintas: 

Fase 1 (modelagem no sistema CAD), Fase 2 (planejamento), Fase 3 (fabricação no 

sistema de prototipagem rápida) e Fase 4 (acabamento). No mesmo capítulo 

definimos a maneira pela qual devem ser avaliados os resultados de cada uma 

destas fases, em duas etapas. A primeira testa a integralidade da transferência das 

geometrias do modelo do sistema CAD para o sistema de prototipagem rápida, 

examinando os resultados obtidos e comparando-os entre a Fase 1 e a Fase 2. A 

segunda etapa testa a precisão, em termos de resolução, das geometrias do 
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modelo, comparando os resultados obtidos nas Fases 1, 2 e 4. Os equipamentos e 

softwares dos sistemas CAD e de prototipagem rápida adotados para realizar os 

experimentos são apresentados com suas especificações técnicas, características e 

o motivo de escolha dos mesmos.  

No oitavo capítulo, apresentamos os resultados da experimentação, 

realizada conforme o método de investigação proposto. Apresenta os seis 

experimentos, as especificações de cada uma das quatro fases citadas no capítulo 

anterior.  

No nono capítulo os resultados obtidos em cada experimento são 

organizados e apresentados em quadros para análise. 

No décimo capítulo, denominado conclusão, ressaltamos os resultados 

obtidos em resposta à nossa hipótese do trabalho. Tecemos considerações sobre a 

mudança de expectativa a respeito dos aparentes problemas de interoperabilidade 

sistêmica. Elaboramos, a partir da observação de nossos experimentos, uma lista de 

recomendações para o arquiteto utilizar as ferramentas CAD/CAM, no intuito de 

reduzir-se o retrabalho no modelo. 

O último capítulo, décimo primeiro, contém os desdobramentos futuros que 

sugerem a continuação desta pesquisa, no sentido de adotar o mesmo projeto 

arquitetônico utilizado no experimento desta Dissertação e desenvolver a etapa 

executiva final do mesmo. 

Nesta Dissertação, o apêndice A contém os desenhos técnicos do projeto 

arquitetônico elaborado na etapa inicial. O apêndice B apresenta as imagens das 

vistas externas dos modelos CAD. O apêndice C ilustra as imagens dos modelos 

importados nos softwares dos sistemas de prototipagem. O apêndice D contém as 

fotos dos protótipos rápidos. Por último, o apêndice E apresenta as imagens dos 

arquivos formato STL dos modelos CAD importados no software FormZ. 
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2 REVISÃO BIBLIOGRÁFICA 

 

2.1 A evolução do processo de projetação arquitetônica 

 

Ao longo do tempo, a evolução do processo de representação da arquitetura 

nos revela a busca de recursos apropriados, por parte dos arquitetos, para registrar 

e transmitir suas idéias a terceiros, de maneira mais próxima possível da sua 

intenção original. Dessa forma, a representação das idéias de projeto e a 

comunicação das mesmas encontram-se associadas aos esforços desses 

profissionais para a execução de suas propostas, marcando historicamente a 

profissão de arquiteto. 

Desde a antiguidade, o elaborador da obra arquitetônica usava os recursos 

da fala, da escrita e dos desenhos como formas de representação de suas idéias. 

Ao final da idade média, os serviços dos arquitetos eram solicitados pelo Estado, 

pela Igreja, classes mais ricas, órgãos administrativos, entre outros. Por isso, os 

arquitetos eram  associados com os ricos e poderosos, e as suas funções requeriam 

o conhecimento dos conceitos e a prática da construção. A maioria dos arquitetos 

eram administradores e responsáveis não apenas pela concepção, mas pela 

supervisão e apresentação de todos os grandes projetos públicos. Esses 

profissionais recebiam os  títulos de "mestre construtor" e "supervisor de obras" 

(KOSTOF, 1977, p.3-6). 

No Egito, a produção das edificações era baseada na combinação de 

desenhos e modelos físicos, feitos com cordas e estacas. Os restos de fragmentos 

de desenhos daquela época fornecem algumas informações sobre os usos dos 

mesmos na arquitetura, por meio de planos quadriculados, imagens pitorescas de 

edifício e até mesmo esboços de planos de apartamento. Esse material era utilizado 

como guia de trabalho pelos mestres de obras (ROBBINS, 1997, p. 10). 

Um caso famoso pode ser visto em um dos raros desenhos de papiro ainda 

existentes, Figura 3, oriundos do Egito e datados provavelmente da Dinastia XVIII, 

mostrando as elevações frontais e laterais de um santuário. As vistas em 

perspectivas, como nós as conhecemos na atualidade, ainda não existiam. A grade 

quadrada, sobreposta ao desenho, pode ter servido para controlar a proporção da 

estrutura interior do projeto (KOSTOF, 1977, p. 8-9). 



 25 

 

Figura 3 - Desenho em Papiro, Egito, Dinastia XVIII 
Fonte: Kostof, 1977, p. 8 

 

Na história, o desenho é citado como um dos recursos utilizados para 

registrar e auxiliar na execução dos trabalhos manuais mais elaborados, como 

aqueles relatados em textos bíblicos do Antigo Testamento, escritos por volta de 

1.500 A.C. Aquelas instruções foram transmitidas a Moisés no monte Sinai, com a 

finalidade de possibilitar a construção do Tabernáculo - uma estrutura que pudesse 

ser transportada com facilidade pela tribo dos Levitas, por quarenta anos de 

peregrinação no deserto: 

 

[...] e para elaborar desenhos e trabalhar em ouro, em prata, em bronze, e 
para lapidação de pedras de engaste, e para entalhe de madeira, e para 
toda a sorte de lavores. Também lhe dispôs o coração para ensinar a 
outrem, a ele e a Aoliabe, filho de Aisamaque, da tribo de Dã. Encheu-os de 
habilidade, para fazerem toda a obra de mestre, até a mais engenhosa, e a 
do bordador em estofo azul, em púrpura, em carmesim e em linho fino, e a 
do tecelão, sim, toda a sorte de obra, e a elaborar desenhos. (Êxodo, 35:32-
35, 2008, p. 128) 

 

Na passagem bíblica acima, observa-se que foi preciso ganhar habilidades 

intelectuais e manuais para elaborar desenhos, e para aplicá-las a materiais como o 

couro, prata, ouro, bronze, pedras, madeiras, etc. Estas habilidades, uma vez 

adquiridas, também eram ensinadas a outros. O desenho era necessário para 

realizar tanto os trabalhos manuais quanto a obra. 

Por sua vez, na arquitetura grega, o termo “architekton” significava mestre 

construtor, ao invés de mestre-projetista, e também era usado para se referir aos 
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carpinteiros e aos construtores de templos. O agente central da arte da arquitetura 

grega era o pedreiro, que trabalhava a partir de detalhadas descrições verbais 

estabelecidas pelo arquiteto, geralmente referidas como "syngraphai". Entretanto, 

Kostof argumenta que o desenho deve ter sido uma parte da prática da arquitetura 

grega, por ser extremamente difícil de conseguir o detalhamento de uma elevação, 

sem a existência de recursos de representação (KOSTOF, 1977, p. 11-12). 

Por outro lado, na arquitetura romana, o plano e a elevação, que Vitrúvio, 

chamava de perspectiva, foram amplamente utilizados pelos arquitetos e 

contratantes em suas interações (VITRÚVIO apud ROBBINS, 1997, p. 11). No 

entanto, independente do papel do desenho na arquitetura antiga, esse ainda não 

era um instrumento dominante de projeto, nem tinha libertado os arquitetos das suas 

responsabilidades de ofício, dentre outras, de estar presente na obra. O desenho 

nesta época foi uma entre outras técnicas que os arquitetos utilizaram, nas 

construções sob suas responsabilidades. 

Na Idade Média, os desenhos foram utilizados nos projetos góticos para 

levantar recursos financeiros, facilitar a escolha entre os vários modelos possíveis, 

viabilizar a construção de edificações ou mesmo para convencer o contratante e as 

autoridades a investirem nas mesmas. O mestre construtor, por assim dizer, ou o 

arquiteto daquela época, acumulava as atribuições dos atuais arquitetos, 

engenheiros, construtores e supervisores de obra da Idade Moderna. Entretanto, os 

seus desenhos ainda não eram instrumentos adequados para orientar os pedreiros 

nos processos técnicos de construção (ROBBINS, 1997, p. 12). 

Por volta de 1340, ainda no período Gótico, a fachada do palácio Sansedoni 

em Siena foi elaborada pelo arquiteto Giovanni di Agostino (Figura 4). Quando 

descoberto por Franklin Toker, aquele desenho também conhecido como Elevação 

de Sansedoni apresenta muito das características do desenho arquitetônico 

moderno. Segundo Robbins (Ibid., p. 13), a representação da fachada é ortogonal, 

desenhada em escala, fornece medições dimensionais e é acompanhada com 

descrições por escrito, para orientar a sua realização. 

Este novo tipo de representação, com mais informações, tornou-se um 

elemento crucial na definição de um novo estatuto para o arquiteto, como gerador do 

projeto, e para informar ao construtor as dimensões do edifício. 
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Figura 4 - Elevação do Palácio de Sansedoni, 1340, arquiteto Giovanni di Agostino 
Fonte: Robbins, 1997, p. 14 

 

No final da Idade Média foi desenvolvido o desenho de fachadas, plantas 

baixas e cortes, para transmitir instruções aos construtores. Este tipo de 

representação reunia basicamente as criações da imaginação ao material 

arquitetônico. 

Ainda segundo Robbins (Ibid., p.10-14), a combinação dos desenhos do 

mesmo padrão da Elevação Sansedoni, incluindo o contrato escrito, proporcionou 

uma nova relação com os projetos. Permitiu aos arquitetos trabalharem fora do local 

da obra e desenvolverem mais de um projeto ao mesmo tempo. 

O desenho seria utilizado, então, para separar o arquiteto daqueles que 

executavam o projeto no canteiro de obras, de maneira a comunicar claramente o 

que os arquitetos queriam transmitir, sem a necessidade de permanência no local da 

obra. 

 
Esta última transformação do arquiteto, de artesão em artista, foi 
acompanhada e, sem dúvida, tornada possível pela nova centralidade e 
importância do desenho como um instrumento crítico da criação de 
arquitetura e de produção. (Ibid., p. 10, tradução nossa). 
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Desde o Renascimento, o desenho tem sido utilizado como um instrumento 

que permite testar ideias, sem a necessidade de colocá-las em prática in loco. A 

partir daquele período, o desenho seria usado como uma forma de memória 

arquitetônica, uma maneira de comunicá-la e reproduzi-la em textos impressos, 

ressaltando dessa forma a importância de utilização de modelo. 

O desenho, na Renascença, permitiu que os arquitetos fossem mais 

artísticos, para expressar o tom, o estilo e os materiais, bem como a medida de um 

edifício em um meio de representação em que ambos, arquitetos e leigos, poderiam 

se comunicar. As novas maneiras de representação gráfica, como a perspectiva e 

seções analíticas e elevações, somaram significativamente ao método pelo qual o 

desenho era entendido, e ao modo por meio do qual o projeto era criado (Ibid., p.13-

19). 

 

O desenho também estava começando, por meio da elevação Sansedoni, a 
assumir uma nova importância como um instrumento aparentemente 
autônomo no processo de concepção e projeto arquitetônico. Esta 
separação de concepção entre a realização e cada um dos atores 
associados, no seu tempo, tornaria possível - com a invenção dos tipos de 
desenhos ainda mais precisos – um novo discurso arquitetônico. (Ibid., p. 
16, tradução nossa). 

 

Robbins escolheu o tema desenho como a questão central de sua 

abordagem, e relacionou a utilização dos mesmos com a transformação da prática 

da arquitetura ao longo da história. Descreveu como o aumento de técnicas de 

precisão dos desenhos, em relação à ideia original do arquiteto, constitui o elemento 

principal de evolução do processo de representação do projeto - ainda que de forma 

limitada, pois não representa o espaço a ser construído, mas apenas suas 

dimensões e parcialmente as formas de uma edificação. Nesse sentido, Zevi (2009, 

p. 18) pontua tal questão: 

 
Mas a arquitetura não provém de um conjunto de larguras, comprimentos e 
alturas dos elementos construtivos que encerram o espaço, mas 
precisamente do vazio, do espaço encerrado, do espaço interior em que os 
homens andam e vivem.  

 

As inovações na prática arquitetônica, realizadas a partir do Renascimento, 

período em que o desenho passou a ser o instrumento dominante do projeto, 

permitiram que o arquiteto se afastasse do local da obra, o que, por sua vez, não o 

isentou de problemas no momento da execução do projeto. 
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A dificuldade de entendimento do projeto bidimensional, constituído pelas 

plantas baixas, cortes e fachadas, por parte de quem o executa, assim como a 

maneira como deve ser construído, pode resultar em alterações no projeto original, 

geralmente acarretando em aumento de tempo e de custo para a sua execução.  

Deve-se adicionar a essas consequências negativas, decorrentes da 

dificuldade de entendimento do projeto arquitetônico, a frustração do arquiteto e do 

cliente sobre suas expectativas em relação ao produto final, semelhantemente ao 

que Manetti relata na biografia de Brunelleschi (apud ROBBINS, 1997, p. 17). 

Enquanto este último estava fora, as suas orientações gráficas foram 

deliberadamente ignoradas, não foram transmitidas aos trabalhadores da obra do 

hospital a ser construído em Florença, resultando em um edifício de qualidade 

arquitetônica inferior. Naquele episódio, constata-se que o papel do desenho, como 

instrumento de comando do arquiteto, ainda não tinha sido firmemente estabelecido. 

No que diz respeito à evolução da representação gráfica, a geometria 

descritiva (Figura 5), a partir do século XIX, era uma disciplina pragmática para o 

construtor, arquiteto e engenheiro. Permitiu pela primeira vez uma redução 

sistemática dos objetos tridimensionais a duas dimensões, tornando possível o 

controle e precisão exigidos pela Revolução Industrial (GÓMEZ; PELLETIER, 1992, 

p. 34). 

 

Figura 5 - Representação de sólido em épura 
Fonte: Wikipédia, 2011 

 

Na década de 1940, o arquiteto e crítico italiano Bruno Zevi conseguiu 

perceber com clareza as limitações das ferramentas gráficas, disponíveis em sua 
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época, para representar uma obra arquitetônica. Ele menciona a descoberta da 

quarta dimensão, representada na pintura cubista, necessária para responder 

satisfatoriamente à necessidade de compreensão do espaço do projeto de 

arquitetura. 

No sentido de serem compreendidas e vividas, todas as obras de arquitetura 

requerem o tempo de nossa caminhada em torno das mesmas, isto é, a quarta 

dimensão, que é conceituada como o deslocamento sucessivo do ângulo visual, o 

movimento (ZEVI, 2009, p.17-28). Entretanto, Zevi esclarece que a quarta dimensão 

pode ser suficiente para entender o volume, mas não o espaço arquitetônico, o qual 

transcende os limites de tempo e movimento. 

 
Se pensarmos um pouco a respeito, o fato do espaço, o vazio, ser o 
protagonista da arquitetura é, no fundo, natural, porque a arquitetura não é 
apenas arte nem só imagem de vida histórica ou de vida vivida por nós e 
pelos outros; é também, e sobretudo, o ambiente, a cena onde vivemos a 
nossa vida. (Ibid., p. 28). 

 

Esse conceito amplo de arquitetura, envolvendo o nível de complexidade 

apresentado na citação acima, e a capacidade de perceber os limites das formas de 

representá-la, criaram uma demanda constante para que os arquitetos busquem 

novos instrumentos e meios para satisfazer plenamente a condição de representar 

e, consequentemente, de realizar seus projetos. 

Existe uma relação direta entre os meios de representação e produção, 

observada por William Mitchell (apud KOLAREVIC, 2003, p. 32), segundo a qual “[...] 

os arquitetos desenharam o que podiam construir, e construíram o que eles podiam 

desenhar”. 

No contexto de inovação arquitetônica, pode-se depreender, ao longo da 

história, que a arquitetura tem estado associada à tecnologia disponível do 

momento. Nesse aspecto, a relação entre a nova tecnologia e a nova arquitetura 

ainda é um motivo dominante na configuração de arquiteturas de vanguarda. 

Na era industrial, constituem exemplos desta relação, entre outros, o edifício 

Cristal Palace (Figura 6), do arquiteto Joseph Paxton, construído em 1851 no Reino 

Unido; e a torre Eiffel, do arquiteto Gustavo Eiffel, erguida em Paris no ano de 1887. 

Essas obras anunciavam um futuro de edifícios altos, de aço e de vidro, que 

levariam cem anos para torná-los onipresentes no mundo todo (MORALES apud 

KOLAREVIC, 2003, p. 3). 
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Figura 6 - O Crystal Palace, Londres (1951), Joseph Paxton 
Fonte: Kolarevic, 2003, p. 3 

 
Na Idade Moderna, a aceitação das realidades do mundo industrial foi 

fundamental para a abordagem de Walter Gropius. O arquiteto alemão assumiu a 

direção da Staatliches Bauhaus em Wiemar, no ano de 1919, com a proposta de 

criar uma escola de projeto e trabalhos manuais, que seria uma resposta aos 

desafios e oportunidades do século XX. 

Gropius acabou tornando a escola um centro de experimentação, unindo a 

tecnologia da máquina com a teoria de projeto moderno. Enunciou sua teoria de 

formação de projeto unificado, segundo a qual a moderna arte arquitetônica incluía 

todas as atividades artísticas, bem como todos os problemas de projeto (apud 

KOSTOF, 1977, p. 320-321). 

 
As implicações espirituais da arte na sociedade devem ser redefinidas e, 
com a ajuda dos cientistas e usando seus métodos de precisão, os 
componentes sociais e psicológicos da arte – não somente os componentes 
técnicos - devem ser determinados por uma ordem distinta de valores e 
significados. (Ibid., p. 322, tradução nossa). 

 

Este pensamento representava uma parte essencial da teoria de Gropius, ou 

seja, a base racional de projeto. Havia a necessidade de encontrar uma linguagem 

científica de projeto, independentemente das subjetivas variáveis humanas. O 

exemplo desta arquitetura foi o próprio edifício da Escola Bauhaus, na Alemanha, 

um marco do século XX, que estabeleceu um novo princípio estético, com o uso de 

volumes limpos e definidos.  

http://www.lmc.ep.usp.br/people/hlinde/estruturas/images/Historia - rev_industrial/foto1
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Figura 7 - Escola Bauhaus, arquiteto Walter Gropius, Desseau, Alemanha, 1926 
Fonte: Archiplanet, 2011 
 

Conforme observado, até a década de 1940, muitas foram as formas 

encontradas para representar um projeto arquitetônico. Entretanto, o mundo estaria 

prestes a viver uma nova revolução, que marcaria profundamente a maneira como 

arquitetos poderiam pensar e produzir arquitetura. A chamada Revolução 

Computacional, segundo Mitchell e McCullough (1995), teve seu avanço estimulado 

pelas grandes guerras mundiais que, por sua vez, aceleraram velozmente o 

aparecimento de novas tecnologias, como os transistores, depois os circuitos 

integrados até chegar ao chip de silício.  

Por analogia, a Revolução Industrial utilizou a energia das máquinas para 

substituir a força muscular humana. De maneira similar, a atual revolução utiliza as 

máquinas de processamento de informação para executar os cálculos manuais 

repetitivos e complexos. Na era pós-industrial, a coleta, o processamento e a 

disseminação de informação têm poder cada vez maiores sobre a vida econômica 

(Ibid., p. 2-3). 

Sobre esse aspecto, o sociólogo italiano Domenico De Masi descreve uma 

sociedade pós-industrial que teria recuperado o gosto pela estética, não mais para 

uma pequena elite, mas para todos, nas diversas áreas, tais como vestuário, 

ornamento, ambiente de trabalho, etc. Ainda, o autor argumenta que tal sociedade 

reivindica a atuação fundamental do sujeito, relacionada à “desmassificação” (De 

MASI, 2000). Dessa forma, é necessária muita criatividade para satisfazer às 
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infinitas necessidades sofisticadas do mercado, através de inúmeros grupos 

criativos. Segundo Domenico (Ibid., p. 188), a criatividade não significa apenas ter 

ideias, mas saber executá-las, unindo fantasia e concretude. 

 
Com respeito à sociedade industrial, a pós-industrial privilegia a produção 
de idéias, o que por sua vez exige um corpo quieto e uma mente irrequieta. 
Exige aquilo que eu chamo de “ócio criativo”. As máquinas trabalharão num 
ritmo sempre mais acelerado, mas os seres humanos terão sempre mais 
tempo para refletir e para “bolar”, idear.  

 

O homem criou as ferramentas tecnológicas para auxiliarem no 

processamento das informações, mas compete ao homem a condição de definir 

como utilizá-las. Cada vez mais, o ser humano poderá usufruir desses recursos para 

otimizar sua capacidade criativa. No caso do processo de projetação arquitetônica, 

uma vez que a tecnologia permanece em contínuo desenvolvimento, o ritmo de seu 

uso continua acelerado no século XXI, e os modelos digitais tendem a desempenhar 

um papel central nos processos de execução de projetos. 

Dessa forma, segundo Mitchell e McCullough (1995, p. 464), os projetos 

serão tratados por softwares, com ferramentas de edição complexa, e por 

programas de gestão. Ainda, receberão insumos do trabalho conjunto de arquitetos 

e engenheiros, consultores e agentes de softwares inteligentes, cujas informações 

serão inseridas e extraídas do modelo único digital, produzindo a entrada para 

sistemas de visualização. Os modelos digitais servirão para gerar desenhos e 

relatórios, e permitirão o uso de ampla gama de software de análise e crítica, de 

sistemas de prototipagem rápida e de instalações de sistemas CAD/CAM.  

Neste contexto, Pentilla conclui que o profissional responsável pela 

arquitetura contemporânea precisa ser um excelente comunicador e coordenador, 

capaz de lidar com a infinidade de equipamentos e aplicativos de comunicação 

digital de que dispomos atualmente. Ao mesmo tempo, o profissional deve ser capaz 

de coordenar o fluxo de toda essa informação, que geralmente acontece 

simultaneamente e à distância (PENTILLA apud NARDELLI, 2007, p.35). 

A seguir, a figura 8 ilustra o papel integrador desempenhado pelo modelo 

digital. A coluna do lado esquerdo ilustra, de forma esquemática, os profissionais 

que podem inserir e alterar dados na elaboração do modelo digital. A coluna de 

retângulos da direita representa os diversos sistemas que podem utilizar as 
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informações do mesmo modelo. Por último, na coluna da extrema direita, observar-

se o que estes sistemas podem gerar de novas informações e produtos. 

Na Figura 8, os textos destacados com a moldura em negrito representam o 

recorte desta pesquisa. Conforme ilustrado nesta figura, seguindo o sentido das 

setas, o arquiteto como agente gerador do modelo digital, e o sistema de 

prototipagem rápida para obtenção do modelo físico, são centrais neste trabalho. 

 

 

Figura 8 - O papel integrador do modelo digital 
Fonte: Mitchell; McCullough, 1995, p. 465, (tradução nossa) 

 

 
2.2 O processo digital de projetação arquitetônica 

 

Desde a antiguidade, o profissional da arquitetura utilizava desenhos e 

modelos que, a partir do Renascimento, ganharam os recursos da escala e da 

perspectiva, e permanecem até os dias de hoje como sendo as ferramentas de 

trabalho de uso mais comumente utilizadas na área de projeto e construção, devido 

as suas características: 
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O uso de desenhos e modelos em escala serviu como meio mais usual para 
arquitetos se comunicarem com os construtores e clientes. Novas técnicas 
de desenho e a realização de maquetes possibilitaram aos arquitetos 
experimentar diferentes soluções de projeto e testar no papel aspectos de 
forma e função antes da construção do edifício. (KALAY, 2004, apud 
ANDRADE et al., 2011, p.83). 

 

De maneira simplificada e resumida, o quadro abaixo apresenta a evolução 

da definição do profissional da arquitetura, as ferramentas de trabalho utilizadas e o 

produto gerado, em relação ao respectivo período da história: 

 

Quadro 2 - Resumo esquemático da evolução das ferramentas de representação na arquitetura 

PERÍODO 
IDADE 

ANTIGA 

IDADE 

MÉDIA 

BAIXA IDADE MÉDIA / 

RENASCIMENTO 

IDADE 

MODERNA 

IDADE 

CONTEMPORÂNEA 

PROFISSÃO 
Mestre 

Construtor 

Mestre 

Construtor 
Arquiteto Arquiteto Arquiteto 

FERRAMENTAS 

DE TRABALHO 

Fala 

Escrita 

Desenho 

Modelo Físico 

 

Fala 

Escrita 

Desenho 

Modelo Físico 

Medidas 

 

Fala 

Escrita 

Dimensões 

Modelo Físico 

Desenho em 

Escala 

Perspectiva 

Fala 

Escrita 

Dimensões 

Modelo Físico 

Desenho em 

Escala 

Perspectiva 

Geom. Descritiva 

Fala 

Escrita 

Dimensões 

Modelo Físico 

Desenho em Escala 

Perspectiva 

Geom. Descritiva 

Ferram. Digitais 

PRODUTO 

Desenho 

Obra 

Desenho 

Obra 

Contrato 

Projeto 

(Obra?) 

Contrato 

Projeto 

(Obra?) 

Contrato 

Projeto 

Fabricação: 

Obra 

Tempo  Era Industrial Era Digital 

Fonte: Autoria nossa 

 

Atualmente, os desenhos podem ganhar o reforço das ferramentas digitais 

de modelagem virtual, que permitem simular a edificação em três dimensões, com 

movimento, de maneira muito próxima à realidade. Em complemento, o modelo 

físico antes produzido manualmente pode ser fabricado com o auxílio de 

equipamentos digitais, gerando os protótipos rápidos, como descrevem Kolarevic e 

Kvan (2002, p. 278, tradução nossa): 

 

Na forma digital, geometrias que desafiam os modos convencionais de 
descrição ou de comunicação podem ser criadas. As ferramentas de 
projetação digital permitem ao designer gerar e explorar formas difíceis de 
descrever por outros meios.  

 

Os arquitetos adotavam processos de projeto apoiados em regras, com a 

intenção de reduzir a probabilidade de erros na construção (ANDRADE et al., 2011, 
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p. 83). Uma vez que os desenhos bidimensionais de arquitetura obedeciam a leis 

diferentes da construção, o que se representava não era, necessariamente, o que 

poderia ser construído de forma tridimensional.  

O processo de projeto arquitetônico, para Andrade et al. (Ibid.), é dinâmico, 

composto por diversas fases intercaladas por ciclos de decisões e métodos 

diversificados, dos mais sistemáticos aos mais intuitivos. No sentido de buscar a 

solução desejada, é necessário que os projetistas realizem certas atividades e 

tenham habilidades específicas. Por outro lado, Lawson salienta, acima de tudo, que 

esse processo é ação para mudar o ambiente de alguma forma (2005 apud 

ANDRADE et al., 2011, p. 81).  

Um dos métodos de projeto que teve destaque na década de sessenta foi 

desenvolvido pelo engenheiro industrial Morris Asimow, baseado em pesquisas 

operacionais, e consiste em atividades gerais de resolução de problemas, por meio 

da aplicação de técnicas processuais. Embora seja um modelo genérico com pouca 

aplicabilidade em projetos de arquitetura, ele influenciou os métodos de projeto 

arquitetônico (ANDRADE et al., 2011, p. 84-85). 

De maneira mais simplificada, um mapeamento proposto por Lawson 

representa o ciclo de uma sequência composta por análise, síntese e avaliação de 

decisões de processo de projeto. Essa sequência deve ser compreendida como 

parte de um processo de projeto que seja flexível, articulado e com ciclos interativos, 

posto de forma conjunta (Ibid., p. 87), conforme ilustra Figura 9 abaixo: 

 

 

Figura 9 - Mapeamento proposto por Lawson 
Fonte: Lawson, 2011, p. 47 
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Ainda sobre o mapeamento proposto por Lawson, a análise é a fase de 

assimilação das condicionantes relacionadas ao projeto. A partir dela, a intenção é 

estabelecer uma lista detalhada de especificações, de maneira que se possa definir 

um programa arquitetônico com os principais critérios de desempenho que o edifício 

deve atender.  

Uma lista completa e detalhada de verificações, que pode servir para auxiliar 

na elaboração de um programa arquitetônico, de maneira a ser adaptável a qualquer 

tipo de edificação, é apresentada pela ISO 9699 (International Organization for 

Standardization, 2004, apud ANDRADE et al., 2011, p. 88-89). 

Sintetizando, os arquitetos utilizam suas capacidades criativas para elaborar 

possíveis soluções que atendam aos objetivos e às condicionantes observadas na 

etapa de análise. Por outro lado, a fase da avaliação é considerada um processo 

racional, vista como uma questão de experiência e julgamento, na qual a solução 

proposta é comparada com as metas, restrições e oportunidades que o projeto 

deveria atender (ANDRADE et al., 2011, p. 90).  

A comunicação consiste na troca de informações entre as fases da 

sequência de decisões (análise, síntese e avaliação), que por sua vez serve como 

meio de registro e estimula o processo de projeto. A representação é um dos 

instrumentos utilizados pela comunicação, para efetivar o funcionamento desse 

ciclo.  

Os projetistas utilizam abordagens variadas de métodos para encontrar as 

soluções de projeto; entre eles, cabe citar o método baseado em precedentes. Ao 

longo de toda a sua carreira, os projetistas tendem a coletar material de referência. 

O método baseado em precedentes de arquitetura tem a vantagem de acelerar em 

grande parte o pensamento, e de criar vínculos entre problemas e soluções de 

projeto. Isto se deve ao fato de que a maioria dos problemas de projeto apresenta 

similaridade com outros precedentes. Por sua vez, o projetista precisa ter 

capacidade de reconhecer características das situações que têm vínculo com ideias 

aparentemente distantes (LAWSON, 2011, p. 276-277). A aplicação de 

conhecimentos de precedentes deverá ocorrer de forma indireta, servindo de base 

para novas ideias (ANDRADE et al., 2011, p. 97).  

No quarto capítulo deste trabalho - Sistemas CAD, o assunto sobre os 

modelos CAD, adotados para efeito de recorte desta pesquisa, é abordado de 

maneira mais detalhada.  
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3 ESTUDO DE PRECEDENTE ZAHA HADID ARQUITETOS  

 

No presente trabalho, como estudo de precedentes, decidimos investigar o 

processo de projetação desenvolvido pelo escritório da arquiteta Zaha Hadid, devido 

ao seu notório uso de ferramentas digitais e aos resultados inovadores de sua 

produção arquitetônica. 

Zaha Hadid formou-se em arquitetura na Architectural Association, em 1977, 

e estabeleceu seu escritório Zaha Hadid Arquitetos na capital Londrina. A arquitetura 

de Hadid é contemporânea e de vanguarda - em 2004 foi a primeira mulher a 

receber o prêmio Pritzker de Arquitetura. Os seus projetos construídos, além de seu 

trabalho teórico e acadêmico, são internacionalmente conhecidos pela dinâmica e 

inovação, em domínios inter-relacionados de arquitetura, urbanismo e design. As 

suas preocupações centrais envolvem simultaneamente a prática de ensino e 

pesquisa nesta área (HADID, 2012). 

Segundo Ribeiro, a experimentação é parte integral do processo criativo de 

Hadid, e a construção implica em experimentação técnica e social. Entende-se como 

construção a expressão de um processo intelectual de uma criação estudada, que 

evolui a partir de uma interação definida e compreensível de suas partes. Zaha 

Hadid tem liberado a arquitetura do domínio da planta baixa, e introduzido uma 

espacialização global do mundo construído, entrelaçando a circulação com o 

entorno urbano (RIBEIRO, 2006). 

Em muitos projetos da arquiteta, pode-se apreciar uma transição de um 

mundo orgânico para outro geométrico e racional. Em toda sua obra existem 

complexas tramas de decisões arquitetônicas inter-relacionadas, ao invés de uma 

explosão de criações espontâneas (Ibid., p. 66-68). 

Muitas seriam as definições para tentar enquadrar a arquitetura de Hadid, 

que variam de modernista, cubista ou desconstrutivista, até o conceito mais amplo 

de arquitetura da Era Digital. Oxman (2006) entende que a arquitetura 

contemporânea digital é o resultado do uso das tecnologias digitais, incluindo a 

tecnologia de informação e comunicação, para necessariamente as tornarem 

viáveis. Estas tecnologias permitiram introduzir novos conceitos de espaço e formas 

dinâmicas e interativas (OXMAN, 2006, apud NARDELLI, 2007, p. 31).  
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3.1 O processo de projeto 

 

O processo de desenvolvimento do projeto das obras de Hadid é esclarecido 

por Schumacher (2004), que o classifica em duas fases: a pré-digital e a pós-digital. 

A primeira fase, no final dos anos 1980, compreende a introdução do computador, 

tendo início à modelagem tridimensional de formas simples. Este processo conviveu 

em paralelo com o desenho manual e a pintura, com esboços tridimensionais 

rápidos. O computador era útil para trabalhar com uma linguagem arquitetônica 

estabelecida (Ibid., p. 6). Na Figura 10 abaixo, pinturas de dois projetos do início da 

década de 1980 representam a fase pré-digital de Hadid. 

 

                             

Figura 10 - À esquerda projeto urbano, The pick, Hong Kong, 1982; à direita Estádio Al Whada, em 
Abu Dhabi, 1988, Zaha Hadid 

Fonte: Schumacher, 2004, p. 13 e 24 

 

Na segunda metade dos anos 1990, foram introduzidos os programas de 

computador que trabalham com splines e malhas suavemente deformáveis. Na 

mesma época foram introduzidos no escritório de Hadid os desenhos bidimensionais 

assistidos por computador, para a elaboração de plantas baixas, cortes e seções. 

Na fase pós-digital, a grande mudança surge com o trabalho simultâneo em 

todos os planos, e a última mudança foi a introdução da modelagem tridimensional, 

com curvas complexas. Isto tornou possível a elaboração de composições 

igualmente mais complexas, com base nas inovações formais e conceituais 

http://www.zcorp.com/
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alcançadas anteriormente. As ferramentas computacionais foram usadas para apoiar 

as manobras ambiciosas dos projetos em curso. Esse processo foi uma evolução de 

muitos pequenos passos, ao invés de algumas rupturas singulares (Ibid., p. 7). 

Hadid utilizava técnicas para elaboração de distorção projetiva, para reunir 

uma multiplicidade de elementos em um campo de força geométrico. Naquele 

momento estavam sendo definidas as técnicas atuais, baseadas em deformação por 

computador, e os campos modelados por meio de forças pseudogravitacionais. 

A arquiteta utilizou, como simulação de representações tridimensionais, os 

diferentes tipos de perspectivas, como uma nova maneira para dinamizar o espaço 

implícito. No início, essas projeções foram implantadas de acordo com a sua devida 

função, como meio de representação. Ela construiu espaços pictóricos, nos quais 

múltiplas perspectivas de construções foram fundidas, sem costura, em uma textura 

dinâmica. Uma maneira de entender estas imagens é tentar emular a experiência de 

passar por uma composição arquitetônica, revelando uma sucessão de diferentes 

pontos de vista (Ibid., p. 8-9). 

Uma segunda característica predominante das grandes pinturas de Hadid é 

a técnica de estratificação e, concomitantemente, de interpretação de elementos 

com transparência, para revelar a profundidade da composição. Essa sobreposição 

transparente dos elementos de um desenho antecipa a interpenetração espacial 

literal, de figuras geométricas em ordem, para criar organizações mais complexas. 

A terceira característica do trabalho inicial de Hadid é a idéia de manipular o 

plano de apoio, por meio de corte e deformação. Essa elaboração do solo, como 

superfície manipulada e moldada, antecipa o uso atual de modeladores digitais de 

superfície, e a ideia de articulação arquitetônica, através de dobraduras de superfície 

- “folding”, implica em conceito do edifício como uma superfície única e contínua 

(Ibid., p. 8-10). 

Para Iwamoto (2009), na fabricação digital, Folding é uma técnica de dobra 

de material que produz naturalmente deformação e inflexão, atribuindo rigidez 

estrutural, em uma ampla gama de formas. Também pode ser considerado como um 

método que transforma duas dimensões em três dimensões, com auxilio de 

softwares, permitindo produzir e construir uma superfície espacial tridimensional 

modulada. Os materiais de construção são trabalhados, dobrados, no próprio local 

da obra. Por estas características, Folding é considerado um instrumento 
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arquitetônico conceitual que possibilita criar fluidez e multifuncionalidade, por meio 

de superfícies contínuas (IWAMOTO, 2009, p. 62-64). 

Em entrevista com Mohsen Mostafavi, Zaha Hadid descreve a relação entre 

seus próprios desenhos e conceituações, com o uso dos computadores em seu 

escritório. Defende que os desenhos bidimensionais e as plantas ainda são 

seminais, e que o computador permite mostrar vários pontos de vista 3D e de 

movimento. Zaha prefere ver a imagem na tela do computador, devido a sua 

luminosidade, do que a imagem impressa. Entretanto, os modelos físicos e os 

croquis são ferramentas de representação que também contribuem no seu processo 

de projeto (SCHUMACHER, 2004, p.10-11). 

Zaha explica que uma certa distorção em seus desenhos permite ver o 

projeto em todas as possíveis perspectivas. O longo tempo para construir o desenho 

elaborado possibilita adicionar diversas camadas, enquanto que o modelo físico 

oferece oportunidades de projeto pela natureza peculiar do material. 

Por meio da observação do modelo é possível começar a ver as coisas de 

diferentes maneiras, então, a representação começa a informar o trabalho e isto lhe 

fornece ideias. No sentido de permitir que se veja de forma transparente através de 

um edifício, utiliza diferentes planos sobrepostos uns com os outros, para construir 

uma nova maneira de conectar os níveis como um caminho vertical, sem utilizar a 

circulação vertical de forma extrudada ou como um núcleo vertical (Ibid., p. 11-14). 

 
[...] portanto, eu diria que o repertório formal que surgiu não foi 
completamente acidental, talvez um pouco de acidente no início, antes do 
desenvolvimento do projeto. Mas, então, essas descobertas acidentais 
foram trabalhadas através de desenhos muito precisos. (HADID apud 
SCHUMACHER, 2004, p. 15, tradução nossa). 
 
 

Na Figura 11 abaixo, o conjunto de imagens do projeto da Estação de Trem 

e Estacionamento, no centro da cidade de Strasbourg, França (2001), primeiro os 

croquis, depois as pinturas representando o projeto, e finalmente o resultado final da 

obra construída. O conceito geral para o planejamento do projeto da Estação de 

Trem e Estacionamento foi estabelecido pela sobreposição de campos de linhas, 

que representam os padrões de movimentos gerados pelos carros, trens, bicicletas e 

pedestres. Para cada um desses elementos existe uma trajetória representada pelo 

traço, um dispositivo estático.  
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(a)      (b)    

(c)  

(d)  

(e)  

Figura 11 - (a) Croquis; (b) e (c) Pinturas; (d) e (e) Fotos da obra da estação de trem, em Strasbourg, 
França (2001), Zaha Hadid 

Fonte (a) e (b): Hadid, 2012c  
Fonte (c), (d) e (e): Phaidon, 2004, p. 380 

 

http://www.zcorp.com/
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A natureza tridimensional é enfatizada na arquitetura pelo jogo de linhas 

como um equipamento linear, percebido tanto no teto como no chão em tiras 

lineares.  O traçado do projeto, que acompanha o limite do entorno local, e a 

trajetória dos trens e dos carros, cria uma nova noção de natureza artificial, que 

confunde o limite entre o ambiente natural e o artificial (PHAIDON, 2004, p. 380). 

Um dos movimentos mais audaciosos de Hadid consiste em traduzir o 

dinamismo e a fluidez de sua caligrafia diretamente em sistemas arquitetônicos. 

Esses movimentos são obtidos, como uma explosão do espaço em fragmentos, por 

meio da superposição de diferentes perspectivas. As distorções das perspectivas 

permitem a orientação de elementos em diversos pontos funcionais focais.  

A contribuição do seu trabalho envolve desde os dispositivos de 

representação, às manipulações gráficas, às manobras de composição, aos 

conceitos espaciais, às invenções tipológicas e até à sugestão de novos modos de 

habitação. Resumindo, os métodos e mecanismos de invenção que predominam no 

trabalho de Hadid são a recombinação por meio da colagem e hibridação; a 

abstração; a analogia, pois qualquer coisa pode servir como inspiração analógica, 

como ultimamente os sistemas orgânicos e os mecanismos surrealistas, através do 

uso da representação distorcida do espaço (SCHUMACHER, 2004, p. 17-29). 

 

 

3.2 O uso de ferramentas digitais 

 

O escritório Zaha Hadid continua a ser pioneiro em pesquisa e investigação 

em projeto. As colaborações com artistas, designers, engenheiros e clientes têm 

avançado na diversidade da prática e do conhecimento, enquanto a implementação 

de tecnologias de estado da arte tem ajudado na realização de estruturas 

arquitetônicas fluidas, dinâmicas e, portanto, complexas. Entre suas obras 

construídas, que são excelentes demonstrações de busca da prática do espaço 

complexo e dinâmico, podemos citar, por exemplo: o Edifício Central da BMW, em 

Leipzig, 2005; o Centro de Ciência Phaeno, em Wolfsburg, 2005 e o MAXXI, Museu 

Nacional de Arte do Século 21, em Roma, 2009. A Figura 12, a seguir à esquerda, 

apresenta o modelo digital inserido na malha urbana e, à direta, a foto com vista 

externa de uma das entradas do Museu. 

 

http://www.zcorp.com/
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Figura 12 - Museu Nacional de Arte do Século 21, Roma, Zaha Hadid, 2009 
Fonte: Hadid, 2011b 

 

      

Figura 13 - Pavilhão Chanel Mobile Art, Hong Kong, Tóquio, Nova York, Zaha Hadid, 2010 
Fonte: Hadid, 2011a 

 

A Figura 13 acima apresenta, à esquerda, a planta baixa do projeto e, à 

direita, a imagem externa do modelo digital renderizado, do pavilhão itinerário da 

Chanel. 

Também saudadas como a arquitetura que transforma a nossa visão do 

futuro, com novos conceitos espaciais e formas ousadas, destacam-se as seguintes 

obras: Estação Terminal Hoenheim-Nord, em Estrasburgo, 2001, e o Centro 

Rosenthal de Arte Contemporânea, em Cincinnati, 2003. Os projetos recentemente 

concluídos incluem: as estações ferroviárias Nordpark, Áustria, 2007; o Pavilhão 

Ponte Zaragoza, Espanha, 2008; o Pavilhão Burnham, Chicago, 2009; e a Chanel 

Mobile Art em Hong Kong, Tóquio e Nova York, 2010 (HADID, 2011a).  

Um dos projetos de Zaha Hadid que utilizou as tecnologias digitais, tanto de 

modelagem como de prototipagem rápida para o seu desenvolvimento e 

apresentação, foi o Museu de Guggenheim em Taichung, Taiwan, 2006. O projeto 

possui uma área de 28.000 m² para acomodar o museu, instalações para educação, 

restaurante, café e loja. A proposta foi baseada no conceito do museu como um 

espaço para eventos em constante mudança. Uma série de grandes elementos 

cinéticos foram planejados para oferecer a opção de transformar, radicalmente, o 
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arranjo dos espaços da galeria. Assim, a reconfiguração interna dos espaços de 

exposição pública torna-se visível mesmo na aparência externa do edifício, o qual 

surge gradualmente de uma formação suave da paisagem. 

A Figura 14 apresenta, à esquerda, uma vista superior externa e, à direita, 

uma vista interna do modelo digital do Museu. A Figura 15 mostra, à esquerda, uma 

vista superior externa e, à direita, uma vista da lateral externa do protótipo rápido do 

modelo digital do Museu. 

 

            
 
Figura 14 - Imagens do modelo virtual, Museu de Guggenheim em Taichung, Zaha Hadid, 2006 
Fonte: Hadid, 2011a 

 

          
Figura 15 - Fotos do Modelo Prototipado, Museu de Guggenheim em Taichung, Zaha Hadid, 2006 
Fonte: Hadid, 2011a 

 

No Museu de Guggenheim, a linguagem formal e a articulação de arquitetura 

têm como premissa a idéia de que a construção é drenada para o espaço público 

aberto do eixo urbano. Tanto o fluxo do público, através da construção, como a 

circulação interna, através dos espaços de exposição, são expressos por meio de 

rampas arrebatadoras. O dinamismo global e a fluidez da forma alongada sugerem 

uma ênfase do movimento, através e ao redor do edifício (SCHUMACHER, 2004, p. 

83-88). 
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No sentido de representar e permitir criar um impacto visual do Museu 

Guggenheim em Taichung, um modelo tridimensional com dois metros de 

comprimento foi produzido, utilizando-se prototipagem rápida (Figura 15). O modelo 

permitiu ao cliente visualizar, tocar e sentir uma versão materializada e tátil, em 

escala, da proposta do projeto.  

A tecnologia utilizada foi a Sinterização Seletiva a Laser (SLS), juntamente 

com o corte em Controle  Numérico Computadorizado (CNC). A SLS é considerada 

econômica, rápida e extremamente precisa, aplicada a formas complexas, quando 

comparada ao modelo mais tradicional para tomada de decisões técnicas. Ainda, 

permite construir componentes maiores, juntando e montando várias partes, sem 

afetar a forma e funcionalidade do modelo do projeto (3T RPD, 2011). 

Ao observarmos o processo de projetação de Hadid, destaca-se a 

capacidade da arquiteta em apropriar-se das ferramentas digitais para obter, com 

muita criatividade e controle, o resultado desejado. Seu processo considera o uso de 

diversas tecnologias, no sentido de não restringir as suas propostas de formas e 

funções, geralmente complexas. Ao longo do tempo, permitiu que as ferramentas 

digitais ganhassem a devida importância e espaço central no processo de 

projetação, de maneira a viabilizar a produção de sua obra arquitetônica. 
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4 SISTEMAS CAD 

 

Os primeiros sistemas computacionais gráficos surgiram na década de 1960, 

com um custo extremamente elevado e de uso restrito. A partir daquela época, as 

aplicações computacionais na área de arquitetura e construção civil proporcionaram 

maior automatização, aumentaram a capacidade para gerir geometrias complexas, 

com maior precisão, assim como aumentaram a velocidade na execução de 

projetos. Os sistemas de projeto assistidos por computador (CAD) foram inicialmente 

usados para traduzir esboços e modelos feitos à mão, em modelos digitais 

bidimensionais e modelos de superfícies tridimensionais (SCHODEK, et al., 2005, p. 

29). 

Segundo Bozdoc, existem várias razões para o uso do CAD. A principal é o 

aumento da competitividade, para produzir melhores projetos, de maneira mais 

rápida e com menor custo em relação às empresas concorrentes. No sistema CAD 

as informações de desenho são armazenadas em formato digital, e os componentes 

que são utilizados em desenhos repetidamente podem ser representados em 

tamanhos diferentes e com precisão (BOZDOC, 2003, p. 1). 

As limitações apresentadas por desenhos, por serem representações 

bidimensionais, ficam evidenciadas pela necessidade de obter inúmeras vistas para 

representar um objeto tridimensional, com grau de detalhamento adequado para a 

construção. Por outro lado, numa tentativa de obter precisão, essa representação 

bidimensional detalhada poderia correr riscos de gerar erros.  

Outra limitação dos desenhos é a condição de não poderem ser 

interpretados por computadores, uma vez que são armazenados como linhas, arcos 

e anotações de texto, os quais somente são interpretáveis por algumas pessoas. Por 

outro lado, segundo Eastman, os objetos representados tridimensionalmente são 

legíveis para as máquinas, e permitem que os conflitos espaciais em um modelo de 

construção possam ser verificados automaticamente antes de sua execução 

(EASTMAN, 2007, p. 1-2). 

Nesse aspecto, os sistemas de desenho e os sistemas de modelagem - 

chamados wireframe, fornecem recursos para inserir vários tipos de linhas. Os 

sistemas de modelagem de superfície fornecem operações para inserir vários tipos 

de superfícies. Por sua vez, os sistemas de modelagem de sólidos fornecem 
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operações para inserir vários tipos de sólidos fechados. Na maioria dos contextos de 

projeto é necessário alargar o repertório de possibilidades, apropriando-se de 

operações para a construção de sólidos a partir de pontos, arestas e superfícies, 

além da combinação de sólidos simples para a obtenção de sólidos mais complexos 

(MITCHELL; McCULLOUGH, 1995, p. 240). 

Quanto às formas tridimensionais sólidas, suas capacidades de criação e 

edição foram desenvolvidas de maneira fácil e arbitrária, em 1973, e são atualmente 

conhecidas como modelagem de sólidos. Estes esforços produziram a primeira 

geração de ferramentas de projeto tridimensional na prática de modelagem, 

representadas sob duas formas: a Boundary Representation (B-Rep) e a Construtive 

Solid Geometry (CSG).  

A figura abaixo representa, à esquerda, o resultado avaliado de um modelo 

em B-Rep e, à direita, o resultado não avaliado do modelo CSG. Mais abaixo, ainda 

nesta mesma Figura 16, são apresentadas as formas primitivas que compõem a 

árvore da construção do modelo. 

 

                                

                         

Figura 16 - Modelagem B-Rep e Modelagem CSG 
Fonte: Eastman et al., 2008, p. 28 (tradução nossa) 
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A primeira (B-Rep) define formas usando operações por meio de união, 

interseção e subtração, também chamadas operações booleanas. Estas operações 

são utilizadas para refinar a geometria do modelo, como chanfros ou cortes, ou para 

mover um buraco dentro de uma única forma. A segunda (CSG), é representada por 

uma árvore de operações, e conta com diversos métodos para avaliar a forma final 

(EASTMAN et al., 2008, p. 26). 

A fusão dos métodos B-Rep e CSG permitiu que objetos fossem editados e 

gerados sob demanda, constituindo-se em um importante aspecto precursor para a 

modelagem paramétrica moderna (Ibid., p. 26-27). 

Esses tipos de estruturas de dados, de modelagem de sólidos, necessitam 

de equipamentos mais potentes, com mais memória, quando comparados com a 

manipulção de dados de uma estrutura em wireframe ou de algumas formas de 

modelos de superfície. Isto se deve à necessidade de manter uma rica rede de 

associações entre os elementos, e impedir a produção de sólidos inválidos, durante 

as operações associadas de transformação e combinação (MITCHELL; 

McCULLOUGH, 1995, p. 238). 

Os primeiros sistemas CAD, desenvolvidos entre a década de 1960 até a 

década de 1990, foram adaptados por meio de transferência de tecnologia, para os 

sistemas específicos de projeto arquitetônico assistido por computador. Estes 

sistemas foram utilizados com a intenção de permitir a solução completa para a 

informatização da arquitetura. Justamente por sua característica de uso geral, 

apresentaram um alcance limitado, na distinção entre projeto e desenho. Devido a 

isso, a sua aplicação acabou restrita a tarefas de implementação, como para 

representação de desenhos de apresentação e execução final (KOUTAMANIS, 

2005, p. 631). 

Na segunda metade da década de 1990, com a redução dos custos, as 

tecnologias de informática começam a ser amplamente aceitas na educação e na 

prática da arquitetura. Os sistemas CAD de uso específico na arquitetura seguem 

duas tendências de evolução. A primeira é caracterizada por uma preocupação com 

transferência de tecnologia, e leva à adoção antecipada de novos desenvolvimentos 

promissores. A segunda, tenta manter o caráter holístico da área, por demarcações 

mais claras e aumento da coerência entre a teoria, níveis de algoritmos e 

implementação. Existe, também, uma migração limitada desse sistema em 
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disciplinas altamente especializadas, com a informatização fornecendo soluções 

diretas a perguntas de desempenho, produtividade e eficiência (Ibid., p. 634-636). 

A primeira geração de sistemas CAD tinha como objetivo apoiar o processo 

de projeto e não o de prever soluções pré-definidas ou prontas. Neste sistema, os 

projetistas podem explorar com bastante flexibilidade as formas geométricas. A outra 

geração de ferramentas CAD surgiu com a intenção de automatizar o projeto e a 

documentação, utilizando elementos de construção geralmente reconhecidos, como 

por exemplo, tipos de paredes, tipos de janelas, entre outros elementos. É difícil 

encontrar em um mesmo software as vantagens destas diferentes abordagens, 

como a flexibilidade de modelar geometrias complexas, associada à automatização 

de padrões de objetos arquitetônicos (MARK et al., 2008, p.170-171).  

Segundo Mark et al. (Ibid., p. 174), algumas observações em comum podem 

ser consideradas a respeito da abordagem sobre o projeto assistido por computador. 

A primeira é que o processo de projeto em arquitetura está diretamente associado à 

modelagem geométrica. Os modelos geométricos devem ser mutáveis e com menos 

representações pré-definidas.  

As variações da geometria do modelo não devem apenas ser um desejo do 

projetista, mas um conjunto de relações que se estabelecem entre objetos e regras 

definidas e controladas pelo próprio projetista. Por último, um projeto provém de 

relações ambíguas e vagamente definidas entre os objetos, para depois partir para 

relações deliberadamente associadas. 

Baseados nestas observações, os mesmo autores propõem que a próxima 

geração de ferramentas de projeto enfatize a diversidade de abordagens 

especializadas, ao invés de soluções tecnológicas abrangentes. Isto poderá ocorrer, 

às vezes, no processo de modelagem geométrica, reengajando as histórias de como 

os objetos individuais são criados. Os sistemas baseados no conhecimento, 

abordagens e regras não deverão ser totalmente deterministas. Finalmente, o 

desenvolvimento de ferramentas de projeto mais inteligentes continuará acenando a 

pesquisa e a teoria do futuro, de maneira que cada geração descubra novos 

paradigmas para fazer e construir o projeto (Ibid., p. 174).  

Como contribuição mais significativa, a primeira geração de sistemas CAD 

permitiu incorporar a geometria com a razão, e possibilitou articular o raciocínio do 

projetista para construir um modelo geométrico. Isto pode ocorrer, por exemplo, com 

a crescente integração entre os sistemas CAD e a fabricação digital, aumentando a 
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capacidade do usuário final de construir um modelo de projeto de maneira 

independente (Ibid., p. 175). 

 

 

4.1  Modelos CAD 

 

Os sistemas CAD tridimensionais dispõem de recursos, tais como comandos 

de construção e edição de elementos geométricos para produzir modelos 

tridimensionais digitais, dentro do ambiente gráfico computacional. Estes são 

denominados modelos digitais ou modelos virtuais. O mercado oferece diversos 

tipos desses sistemas, que variam de acordo com a capacidade e maneira como as 

ferramentas permitem gerar geometrias tridimensionais diversas, em formas e 

complexidade. 

O modelo CAD elaborado no sistema CAD genérico (ou tradicional) de 

projeto auxiliado por computador, por meio da interação da representação formal do 

bidimensional e tridimensional, automatiza os projetos de modelos tanto visualmente 

como na representação de desenhos bidimensionais (plantas, cortes e fachadas). As 

primeiras gerações de sistemas CAD (Computer Aided Design) foram caracterizadas 

pelo emprego de diversos softwares de modelagem geométrica e renderização, para 

manipular representações geométricas de objetos digitais (OXMAN, 2006, p. 246). 

Dessa maneira, o arquiteto pode obter o modelo virtual, em sistema CAD 

tridimensional genérico, utilizando-se de ferramentas de construção de objetos 

digitais. Entre os sistemas disponíveis no mercado, atualmente pode-se citar: 

AutoCAD (Autodesk), FormZ (AutoDesSys), Maya (Autodesk), Microstation 

(Bentley), Rhinoceros 3D (Robert McNeel & Associates), Sketchup e Sketchup Pro 

(Google) (NARDELLI; VICENT, 2009).  

O modelo CAD obtido por meio de sistemas CAD específicos, além dos 

recursos do sistema CAD tradicional como elaboração, modelagem e renderização 

de objetos, vincula a geometria dos objetos obtidos parametricamente a dados 

específicos. Ainda, acrescenta os processos analíticos de avaliação, que são 

normalmente associados com estimativas de custos, comportamentos estruturais e 

de desempenho ambiental, entre outros recursos que ampliam ainda mais a 

estrutura de dados do modelo (OXMAN, 2006, p. 246-247).  
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Esta geração de sistemas CAD, também descrita como modelagem da 

informação da edificação, é conhecida como sistemas BIM (Building Information 

Modeling). Nesse sentido, os principais sistemas disponíveis no mercado atualmente 

são: Archicad (Graphisoft), Bentley Architecture (Bentley) e Revit Architecture 

(Autodesk) (NARDELLI; VICENT, 2009). 

Cabe ainda mencionar o processo utilizado para obtenção de modelos 

virtuais, por meio do qual as tecnologias digitais são utilizadas para traduzir o 

modelo físico para o ambiente digital, de maneria inversa ao processo normal de 

manufatura assistida por computador. Este processo utiliza várias técnicas de 

digitalização tridimensional, sendo a mais comum a que envolve o uso de uma 

sonda digitalizadora, para traçar características da superfície do modelo físico. O 

scanner a laser tridimensional, “scanned point cloud”, é uma alternativa de método 

de digitalização sem contato físico.  

Sobre o uso dessa ferramenta, Kolarevic (2003, p. 31) defende que as 

tecnologias de digitalização a laser podem criar modelos tridimensionais precisos a 

partir de objetos reais, e que, apesar de mais caras, apresentam maior rapidez e 

precisão, facilidade de manuseio e eficiência, quando digitalizados objetos de menor 

escala.  

Segundo Oxman (2006, p. 246-247), o modelo CAD obtido com a evolução 

das novas técnicas permite um processo de materialização do modelo virtual, por 

meio da fabricação digital. Permite também a realização do processo inverso de 

digitalização do modelo físico em modelo virtual, por meio do uso de equipamentos 

de digitalização tridimensional. Este processo é cada vez mais bem integrado com 

os processos de manufatura e lógica de fabricação, e evoluiu para uma integração 

perfeita de virtual com material e vice-versa. 

 

    

Figura 17 - O processo de digitalização do modelo físico, no escritório de Frank Gehry 
Fonte: Kolarevic, 2003, p. 31 
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O arquiteto Frank Gehry utiliza essa tecnologia durante o seu processo de 

criação, ao projetar modelos físicos feitos manualmente, digitalizando-os para 

usufruir dos recursos tecnológicos computacionais. A Figura 17 apresenta, da 

esquerda para a direita, a sequência do processo de digitalização, utilizando um 

scanner tridimensional sobre o modelo físico; a imagem com os pontos digitalizados 

e finalmente a reconstrução da superfície com o modelo digital. 

É importante salientar que a maioria dos sistemas CAD tridimensionais, 

genéricos ou específicos, permitem ao arquiteto gerar modelos virtuais, adequados 

para aplicações interativas onde o feedback visual é necessário. Ryder et al. (2002, 

p. 289) mencionam que as ferramentas digitais de projeto tridimensional permitem a 

visualização com deslocamento, no modelo em escala 1:1. 

Kalisperis (1996, p. 24) destaca, além das vantagens citadas acima, outras 

vantagens observadas no uso do modelo virtual, em sua experiência acadêmica no 

curso de arquitetura na Universidade da Pensilvânia. Ressalta, por exemplo, as 

técnicas de visualização tridimensionais que possibilitam aos alunos compreender o 

espaço e a forma, associados com a textura, contraste e cor, e a explorar o 

movimento espacial e temporal. Ainda, o modelo virtual é usado para estudar a luz e 

seus efeitos sobre o espaço arquitetônico e, por fim, o tempo e o movimento, que 

causam a mudança de luz, de tonalidade e de sombra, os quais podem ser 

analisados juntamente com os elementos estáticos do projeto. 

 

 

4.2 Modelos BIM 

 

Conforme mencionado anteriormente, o modelo virtual também pode ser 

obtido por meio de sistemas CAD específicos, o que aponta para a necessidade de 

entendimento sobre os sistemas BIM. Conforme Eastman et al. (2008, p. 13), os 

sistemas BIM podem ser conceituados como “uma tecnologia de modelagem e um 

conjunto associado de processos, para produzir, comunicar e analisar modelos de 

edificação”. Estes modelos de edificação são caracterizados por componentes 

representados por objetos digitais inteligentes que "sabem" o que são, e podem ser 

associados com atributos de dados e regras paramétricas. 

O mesmo autor complementa que o conceito de objetos paramétricos é 

central para o entendimento da modelagem de informação de edificação (BIM). 
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Estes consistem em definições geométricas associadas a dados e regras. A 

geometria é integrada de forma não redundante, o que permite que não haja 

inconsistências. As regras paramétricas para os objetos modificam automaticamente 

as geometrias associadas e aplicadas ao modelo único do edifício, permitindo 

atualização automática quando mudanças são feitas nos objetos associados. 

Cada objeto tem suas propriedades paramétricas, cujos valores podem ser 

modificados pelo usuário. Alguns têm fórmulas embutidas que remetem a um 

comportamento do objeto modelado, e agem em resposta ao que o usuário definiu 

em seus parâmetros (CRESPO; RUSCHEL, 2007, p. 6). 

Os recursos disponíveis nos sistemas BIM permitem que o projeto seja 

construído virtualmente, de maneira que o seu modelo único é tratado como objeto 

inteligente, e simula características físicas da edificação o mais próximo à realidade. 

Devido a estes recursos, Piñón (2008 apud ANDRADE; RUSCHEL, 2011, p. 437), 

afirma que a modelagem tridimensional pode ser considerada mais apropriada como 

recurso de projetação, em comparação ao sistema tradicional de representação 

abstrata, definido por plantas, cortes e fachadas. 

Nos sistemas BIM, os objetos podem ser definidos em níveis diferentes de 

aglomeração. Por exemplo, pode-se definir uma parede assim como os seus 

componentes relacionados. As regras definidas nos objetos permitem identificar 

quando uma mudança particular viola a viabilidade do componente, referente à 

fabricação, tamanho, etc. Os objetos têm a capacidade para junção ou recepção, 

transmissão de conjuntos de atributos - por exemplo, materiais estruturais, dados 

acústicos, dados de energia, etc. - para outras aplicações e modelos (EASTMAN et 

al., 2008, p.14). 

Dessa forma, a parede de um edifício não é representada somente por 

linhas, mas também pelas características físicas do seu material, como a unidade de 

energia com absorção e reflexão. 

O resultado do uso da ferramenta BIM é mais do que um modelo para 

visualização do espaço projetado; é um modelo digital composto por um banco de 

dados; que permite agregar informações para diversas finalidades, além de gerar 

aumento de produtividade e racionalização do processo (TSE; WONG, 2005, p. 1-2). 

Um processo com maior integração entre projeto e construção, quando 

implementado de forma adequada e utilizando-se sistemas BIM, resulta em edifícios 
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de melhor qualidade com menor custo, além de redução de tempo de projeto, 

quando comparado à utilização de outros sistemas (EASTMAN et al., 2008, p. 1). 

Os benefícios obtidos por projetos desenvolvidos em sistemas BIM podem 

ser destacados na visualização antecipada e precisa do projeto tridimensional; na 

correção automática de alterações feitas no projeto, na capacidade de extração de 

desenhos bidimensionais coerentes e precisos, em qualquer fase de projeto; na 

colaboração antecipada das múltiplas disciplinas de projeto; na fácil verificação da 

intenção do projeto, além da emissão de listagens de quantitativos de áreas e 

materiais, para realização de estimativa de custos mais próxima à realidade; na 

vinculação com ferramentas que permitem a avaliação e aprimoramento da 

eficiência energética e, por fim, na sustentabilidade no modelo de projeto (Ibid., p. 

17-18). 

No sentido de permitir que os arquitetos disponham de mais tempo para 

decidir as soluções e fazer testes de projeto, é possível antecipar as atividades de 

desenvolvimento para a etapa de concepção do projeto, por meio do uso de 

sistemas BIM (AMBROSE, 2006 apud ANDRADE; RUSCHEL, 2011, p. 436): 

 

O grande potencial do uso do BIM em projeto está na possibilidade de 
revigorar a prática contemporânea da arquitetura, pelo desenvolvimento e 
exploração do processo de projeto e de metodologias que voltem a priorizar 
formas de ver, pensar e criar durante o processo de projeto. Com isso, 
pode-se aumentar significativamente o espaço de soluções, vislumbrando-
se alternativas que dificilmente seriam pensadas na forma “analógica” de 
projetar. 

 

Dessa forma, observa-se a tendência da utilização de sistemas BIM desde o 

início do processo de projetação, momento crucial em que o arquiteto necessita de 

informação com qualidade, em termos de especificidade, precisão e coerência, para 

auxiliar na sua tomada de decisão, especialmente no que se refere aos custos da 

edificação. 
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5 SISTEMAS CAM 

 

A história da tecnologia CAD/CAM teve início no século XIX, com o tear de 

Jacquard. Este dispositivo, criado pelo mecânico francês Joseph-Marie Jacquard, 

era controlado digitalmente por meio de cartões perfurados e podia ser utilizado para 

produzir arbitrariamente complexos padrões de tecidos (MITCHELL; McCULLOUGH, 

1995, p. 418). 

 

 
Figura 18 - Mecanismo Jacquard de 1804, no Musée des arts et métiers, França 

Fonte: Wikipédia, 2012 

 

Na década de 1990 foi possível observar um grande avanço tecnológico, 

tanto nas máquinas quanto no uso das mesmas. O processo de escrever o código 

de controle numérico tornou-se consideravelmente mais fácil, possibilitando extrair 

informações geométricas diretamente a partir de um modelo digital, e usá-lo para 

orientar o funcionamento de uma máquina de Controle Numérico Computadorizado 

(CNC). Os sistemas conhecidos pela sigla CAM (Manufatura Assistida por 

Computador), usados para fabricar objetos ou partes da edificação facilitam, por 

meio do uso de softwares, a conexão direta com o meio ambiente CNC (SCHODEK 

et al., 2005, p. 25). 

Somente a partir da década de 1990, os avanços computacionais aplicados 

à arquitetura e construção, utilizando os recursos disponíveis de sistemas 

CAD/CAM, começaram a ter seus benefícios reconhecidos internacionalmente de 

forma clara, tanto no projeto de edificação quanto nas práticas de construção. Um 
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dos primeiros projetos desenvolvidos e realizados digitalmente foi a escultura do 

Peixe, projeto do arquiteto Frank Ghery, em Barcelona no ano de 1992. Na Figura 

19, observa-se à esquerda uma foto do projeto executado e, à direta, a imagem do 

modelo digital.  

 

 

Figura 19 - A Escultura do Peixe, Frank Gehry, Barcelona, 1992 
Fonte: Kolarevic, 2003, p. 107 

 

No referido trabalho de Barcelona, as restrições de prazo e de orçamento 

levaram a equipe de Frank Gehry e Jim Glymph a buscar um programa com 

ambiente digital, capaz de projetar e produzir a geometria complexa do projeto. A 

solução foi encontrada em um programa desenvolvido pela indústria aeroespacial 

francesa, chamado CATIA. Nesse software, os modelos tridimensionais digitais 

foram usados para o desenvolvimento do projeto, na análise e fabricação estrutural, 

e como fonte de informações de construção (KOLAREVIC, 2003, p. 31). 

 
Como no passado, as arquiteturas digitais contemporâneas encontraram 
sua legitimação na exploração dos últimos avanços tecnológicos, novos 
meios digitais de concepção e produção, e o correspondente estético de 
superfícies complexas e curvilíneas. Como uma manifestação de novos 
processos orientados por informações, que estão transformando as 
culturas, sociedades e economias em escala global, elas são vistas como 
um produto lógico e inevitável do espírito da época digital. (Ibid., p. 5, 
tradução nossa). 

 

Novos processos de projetação e fabricação conduzidos digitalmente re-

estabeleceram uma relação direta entre a arquitetura e os seus meios de produção. 

O processo de projetação representado e controlado digitalmente, por meio de 

modelos tridimensionais, origina novas possibilidades arquitetônicas. 

Assim, a fabricação digital é usada conjuntamente com as tecnologias de 

Controle Numérico Computadorizado (CNC), que permitem a transferência de dados 
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de um programa de modelagem tridimensional CAD para uma máquina CNC 

(SCHODEK et al., 2005). 

As tecnologias CNC compartilham algumas características básicas, como as 

instruções que descrevem que o trabalho a ser realizado deve ser num formato 

digital. A seguir, as instruções são lidas digitalmente por um controlador, que as 

codifica e as converte para serem conduzidas por impulsos elétricos. Os 

equipamentos são as próprias ferramentas usadas para produzir o produto final 

(Ibid., p. 238).  

Este processo de produção e fabricação, implementado por meio de 

maquinários CNC, pode ser baseado em conformação, corte, subtração e adição do 

material. 

Na fabricação por conformação são aplicadas aos materiais forças 

mecânicas, calor ou vapor, até que os mesmos sejam deformados ou remodelados 

conforme desejado, Figura 20 (a). Os materiais como vidro, metal e madeira podem 

sofrer este processo. No caso do metal, esta deformação pode ser permanente. Ao 

final, o processo permite obter superfícies compostas com dupla curvatura 

(KOLAREVIC, 2003, p. 38). 

Segundo Schodek et al. (2005, p.269), no processo de conformação os 

materiais podem ser deformados e moldados com o uso simples, repetido ou até 

mesmo contínuo da força. Os processos geralmente referem-se ao tipo de estresse 

pelo qual a peça trabalhada é submetida. Existem vários métodos, que variam da 

flexão manual individual para realizar a estampagem, até o método de forjamento 

em maiores quantidades de peças. 

 

       

Figura 20 - Processos de fabricação digital: (a) Conformação e (b) Corte 
Fonte (a): Kolarevic, 2003, p. 38 
Fonte (b): Kolarevic, 2003, p. 34 

 (a)  (b) 
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Apesar das vantagens apresentadas pela técnica anterior, a técnica de 

fabricação mais usada é o corte CNC ou fabricação bidimensional, Figura 20 (b). O 

arco-plasma, raio-laser e jato d água são tecnologias que funcionam com o 

movimento de dois eixos, que podem ser da mesa de apoio com a chapa do 

material, do movimento da cabeça de corte, ou da combinação do movimento de um 

em relação ao outro. Existem grandes diferenças entre essas tecnologias, no que diz 

respeito aos tipos de materiais e capacidade máxima de espessura para corte 

(KOLAREVIC, 2003, p. 34). 

Por sua vez, a terceira técnica de fabricação por CNC, a subtração, Figura 

21 (c), envolve a remoção de determinado volume de material, utilizando os 

processos elétrico, químico ou mecânico de redução por fresa multieixo (de 

diferentes diâmetros e comprimentos). Inicialmente, a fresa de topo maior retira o 

material e a menor encarrega-se do acabamento. A velocidade de rotação da fresa é 

definida em função da densidade do material. Na fresa CNC, um sistema de 

computador dedicado executa as funções básicas de controle do movimento de uma 

ferramenta de máquina, utilizando um conjunto de instruções codificadas (Ibid., p. 

34-36). 

 

   

Figura 21 - Processos de fabricação digital: (c) Subtração e (d) Adição 
Fonte (c): Kolarevic, 2003, p. 35 
Fonte (d): Kolarevic, 2003, p. 37 

 

Por fim, a fabricação por adição, Figura 21 (d), consiste na formação por 

meio de adição incremental de camadas de material de impressão. A técnica parte 

da divisão do modelo sólido virtual em camadas de espessura milimétrica. Em 

seguida, a informação é transferida para a máquina que amolda camada por 

 (c)  (d) 
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camada, gerando o modelo físico. Este processo de fabricação possui aplicações 

restritas na construção de edificações, devido ao tamanho limitado dos modelos 

produzidos, sendo muitas vezes referido como fabricação por camadas, de forma 

livre, sólida, de prototipagem rápida, ou de fabricação “desktop”. No processo de 

projeto, esta tecnologia é mais usada na fabricação de modelos com geometrias 

curvilíneas complexas (Ibid., p. 34-38). 

Schodek et al. (2005, p. 290), complementa a descrição sobre o processo de 

fabricação por adição de camadas, no qual um elemento sólido deve ser dividido em 

partes menores seguindo uma ordem, para que possam ser reagrupados. Isto ocorre 

de maneira que uma parte sólida é decomposta em camadas que representam 

secções transversais iguais em altura, conforme especificação de cada 

equipamento, que por sua vez é guiado para depositar o material camada por 

camada até a reprodução por completo do objeto. 

A tecnologia da fabricação digital permite a produção em massa de 

componentes de construção altamente diferenciados, com a mesma facilidade das 

peças padronizadas, introduzindo o conceito de "customização em massa" no 

projeto da edificação e em sua produção. A customização em massa, conceituada 

por Joseph Pine “é a produção em massa de bens e serviços individualmente 

personalizados, oferecendo assim um enorme aumento na variedade e 

personalização, sem o correspondente aumento dos custos” (PINE apud 

KOLAREVIC, 2003, p. 52, tradução nossa).  

Segundo Kolarevic, os processos de produção conduzidos digitalmente 

introduzirão uma lógica diferente na produção em série da arquitetura, que se baseia 

na variação local e diferenciação em série. Este novo paradigma de produção é 

particularmente apropriado para a indústria da construção, uma vez que os edifícios 

são na sua maioria projetados para situações únicas.  

Os componentes individuais dos edifícios podem ser personalizados e 

produzidos para uma grande quantidade de usuários, de forma a permitir a variação 

ideal, em resposta às diferentes condições locais da edificação. Assim, 

componentes como janelas de formas e tamanhos exclusivos satisfazem às 

condicionantes de diferentes cargas estruturais, de diferentes vistas e orientações 

solares (KOLAREVIC, 2003, p. 52-53). 

Segundo os autores Kieran e Timberlake (2004, p. 129), a customização em 

massa oferece uma verdadeira mudança para a arquitetura e construção. Os 
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maquinários existentes, para a produção da arquitetura feita fora do local da obra, 

permitem substituir o agendamento simultâneo da fabricação em série, por um 

sistema personalizado. Resultam na melhoria da eficiência e da produtividade do 

ambiente dos edifícios produzidos, assim como na redução de custos. 

Um bom exemplo de arquitetura projetada e produzida por computador, que 

apresentou grande eficiência em custos, foi o pavilhão “Dynaform” em Frankfurt, do 

arquiteto Bernhard Franken, 2001. O pavilhão MINI, construído tradicionalmente com 

estrutura ortogonal e vidro, ao lado do “Dynaform” e para o mesmo cliente, custou 

um terço a mais por metro quadrado por espaço de exposição (KOLAREVIC, 2003, 

p. 138). A Figura 22, a seguir, apresenta o pavilhão “Dynaform” com volumetria 

maior e forma orgânica, e ao lado o pavilhão MINI. 

 

 
Figura 22 - Pavilhão "Dynaform" da BMW, Bernhard Franken, Frankfurt, 2001 

Fonte: Kolarevic, 2003, p. 136 

 

Os sistemas CAD/CAM não somente podem reduzir os custos e encurtar 
etapas, reduzindo também a sobrecarga de comunicação, diminuem a 
dependência dos projetistas em usar componentes da construção 
padronizados pela produção em massa. Este sistema permite a fabricação 
de formas complexas que seriam muito difíceis ou mesmo impossíveis de 
descrever e produzir nos meios tradicionais. (MITCHELL; McCULLOUGH, 
1995, p. 418). 

 
Em suma, além de eliminar o passo intermediário na produção de desenhos, 

o uso do computador pode integrar a modelagem e fabricação de elementos 
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arquitetônicos, reduzindo tempo e custos. Ainda, segundo Kolarevic (2003), nesse 

processo os sistemas CAD/CAM podem encurtar substancialmente o ciclo de 

produção, permitindo aos projetistas a elaboração de protótipos experimentais com 

formas, materiais e processos distintos, antes de comprometerem-se com as 

decisões finais. Isto, basicamente, redefine as relações entre projeto e produção. 

É necessário que o arquiteto conheça as possibilidades de produção, tanto 

dos usos relacionados aos pré-moldados e pré-fabricados, como também agora as 

possibilidades da fabricação digital. Segundo os autores Orciuoli e Celani (2010, p. 

71), esta questão justifica-se pelos seguintes fatores: 

 

[...] a fabricação digital não substitui os elementos produzidos em série, nem 
os elementos artesanais. Ela ocupa um nicho de produtos com geometrias 
complexas, que precisam ter excelente acabamento e constituem-se em 
peças únicas ou séries muito pequenas, cuja industrialização por métodos 
mecânicos não se justifica.  

 
 

A fabricação digital possibilita solucionar os casos de produção que a 

indústria e o artesanato não conseguem resolver. Sendo assim, todos os meios de 

produção artesanal, industrial e de fabricação digital devem ser pensados e 

considerados pelos arquitetos como possibilidades existentes, de maneira a oferecer 

solução para a fabricação de produtos conforme suas diferenças e 

complementaridades.   

 

 

5.1 A prototipagem rápida 

 

A prototipagem rápida é conhecida como um dos processos que utiliza a 

tecnologia CAD/CAM, na produção de modelos físicos em escala reduzida, em 

diferentes tipos de materiais, antes que o artefato seja finalizado. Algumas técnicas 

de prototipagem rápida podem ser usadas para fabricação de componentes 

utilizando materiais de produtos acabados. Em escala de produção, os 

equipamentos CAD/CAM podem produzir componentes de construção em tamanho 

real. Estes podem, ainda, ser precisamente posicionados e montados no local da 

obra pelos projetistas de modelos digitais, com o auxílio de dispositivos eletrônicos e 

de levantamento (MITCHELL; McCULLOUGH, 1995, p. 417). 
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A prototipagem rápida e a fabricação digital são distinguidas e definidas, 

pelas autoras Pupo e Celani (2011), como os termos mais empregados 

recentemente na literatura, entre as diversas formas e técnicas de produção 

automatizadas em uso na arquitetura e construção. Em virtude das variadas 

definições e enfoques existentes, seguem abaixo os campos relacionados à 

utilização de cada um dos termos: 

 

Quadro 3 - Campos de utilização de prototipagem rápida e fabricação digital 
 

 

 

 

     Prototipagem Rápida:   File-to-factory  

    (sobreposição de camadas)   (do arquivo direto para a fábrica) 

 Sólido      

 Líquido    Metal Bending  

 Pó      

 Lâmina    Tube Bending 

Corte a Laser     

Milling (Fresagem)    CNC 

Corte em Vinil 

 

 

Maquetes / Modelos Físicos  Fôrmas 

Protótipos 1:1    Peças Finais 

 
Fonte: Pupo; Celani, 2011, p. 471 

 
O termo prototipagem rápida inclui todas as técnicas de sobreposição de 

camadas, corte a laser, fresas e corte com vinil, para produzir maquetes em escalas 

reduzidas e protótipos em escala (1:1). Por sua vez, o termo fabricação digital 

consiste em técnicas para produzir fôrmas ou peças finais de edifícios, com 

equipamentos CNC (PUPO; CELANI, 2011, p. 471). 

Autores como Mitchell e McCullough (1995) definem o termo mais 

abrangente de prototipagem rápida, como sendo um método de tradução de 

modelos digitais tridimensionais do CAD, para processo de fabricação CNC de 

edificações. 

PROTOTIPAGEM 

DIGITAL 

FABRICAÇÃO 

DIGITAL 

PRODUTOS 
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Segundo alguns autores como Buswell et al. (apud PUPO; CELANI, 2011, p. 

472), o termo prototipagem rápida refere-se somente ao processo de produção do 

protótipo por adição de material camada por camada, a partir de modelos gerados 

em sistemas CAD. Por fim, Ryder et al. (2002, p. 279-285) definem especificamente 

o termo como ferramenta de projeto e manufatura rápida, que serve para construir e 

testar fisicamente ideias de projeto, utilizando diferentes dispositivos de manufatura 

por adição de camadas, da Estereolitografia à Sinterização Seletiva a Laser (SLS) a 

impressões tridimensionais (3DP). 

 

 

5.2 O modelo físico 

 

No contexto arquitetônico, o modelo físico é tradicionalmente chamado de 

maquete. Por sua vez, a maquete enquanto modelo físico representado em escala 

reduzida de um projeto, em relação ao croqui, inclui a vantagem da 

tridimensionalidade (PINA et al., 2011, p. 109).  

O modelo físico, quando representado em escala real (1:1), é chamado de 

Mock-up, ou ainda, de protótipo. Os protótipos físicos de projeto, na etapa inicial, 

incorporam as características essenciais do objeto final, que são as características 

formais e funcionais para serem avaliadas. Muitas vezes são incompletos ou 

minimamente definidos, utilizando-se materiais de baixo custo, com mínimo de 

tempo e esforço para atingir essas caracterísitcas (SCHODEK et al., 2005, p. 298). 

As primeiras representações arquitetônicas de modelos em miniaturas foram 

produzidas pelas culturas neolíticas, com indícios arqueológicos datados por volta 

de 6.000 a.C. na Grécia, exemplo conhecido pelo modelo de Krannon. A partir 

daquele momento, com o modelo reduzido, o ser humano passou a ter a satisfação 

de sentir e pensar um mundo modelado nos limites de suas mãos (PINA et al., 2011, 

p. 110-111). 

Tanto na arquitetura como no urbanismo a maquete é um meio muito 

utilizado pelos profissionais para elaborar e verificar uma ideia, conforme afirmam os 

autores: 
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A maquete estabeleceu novos conceitos com os avanços e complexidades 

programáticos, e é um caminho para configurar e dar forma a uma ideia, 

pois se pode criar e desenhar conjuntamente, registrar a imagem mental e 

iluminar o caminho.  (PINA et al., apud KOWALTOWSKI et al., 2011, p. 115) 

 

Em pesquisa realizada em 2008 por Kim e Maher, concluem que a interação 

direta com o uso das mãos promove a imersão do arquiteto no projeto, auxilia na 

cognição espacial, consequentemente possibilita o raciocínio lógico mais eficiente. A 

dinâmica do processo de fazer pensando e pensar fazendo, ou seja, a interação com 

a representação e o auxílio de artefatos é que faz o desenvolvimento do projeto 

evoluir e ser gradualmente compreendido (apud FLORIO et al., 2008, p. 7). 

Além de auxiliar na visualização, os modelos físicos podem aprofundar a 

compreensão dos espaços, formas e sistemas construtivos projetados durante o 

processo criativo, por permitirem ser manuseados e até desmontados para revelar 

seu interior e seus componentes (FLORIO et al., 2008, p. 1). 

Os modelos físicos possuem um papel importante para que o arquiteto 

apresente ao cliente o feedback do projeto, onde o produto é uma edificação. Os 

modelos permitem que a intenção do projeto seja adequadamente entendida, 

superando as limitações apresentadas pela transmissão de informações em 

desenhos técnicos bidimensionais (RYDER et al., 2002, p. 279). 

Mills também aborda o uso do modelo físico manual, ou maquete de 

arquitetura, como parte essencial do processo de projeto. As maquetes são obtidas 

manualmente e com auxílio de instrumentos mecânicos. A sua função é gerar ideias 

de projeto e servir como veículo de aperfeiçoamento. Em sua obra, o autor não 

enfatiza o uso das maquetes de apresentação final, mas das maquetes com 

acabamentos simples e que materializam os esboços dos projetos (MILLS, 2007, p. 

21-140). 

Ainda, Mills classificou em dois grupos as maquetes, divididas e definidas 

conforme a necessidade e tipo de projeto: as maquetes primárias (preliminar, 

diagrama, conceito, volumes, cheios e vazios, desenvolvimento, apresentação ou 

maquete com acabamento) e as maquetes secundárias (sítio, urbanismo, 

paisagismo, interiores, seções, fachadas, estrutura, detalhe ou conexão). O uso da 

maquete no processo de projeto pode ser definido pelas seguintes funções (Ibid., p. 

21-202): 
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 a possibilidade de observar concretamente a forma e o espaço físico 

tridimensional, pela sensação tátil, permitindo uma interação direta e a 

obtenção de um feedback imediato; 

 a materialização, o que as condiciona às forças dinâmicas, condição 

inexistente nos desenhos bidimensionais; 

 a previsão de comportamentos estruturais, para aperfeiçoamento do projeto 

e teste de sua integridade estrutural; e 

 uma forma de comunicação precisa e poderosa junto aos clientes. 

 

 

5.3 O protótipo rápido 

 

As funções descritas anteriormente são inerentes às qualidades do modelo 

físico, gerado tanto manualmente quanto por meio da prototipagem rápida. Porém, 

produzindo-se o modelo com auxílio de recursos digitais, podem-se agregar outros 

importantes valores como a redução de tempo e maior precisão. Assim, a 

prototipagem rápida, em relação ao protótipo físico gerado manualmente, apresenta 

a vantagem de redução de tempo e da ausência da imprecisão gerada pela mão de 

obra humana, ou pelo uso de ferramentas manuais (BUSWELL et al., 2007, p. 224-

231). O uso da prototipagem rápida pode também ser justificado pela complexidade 

formal arquitetônica (OLIVEIRA; FABRÍCIO, 2011, p. 456). 

De maneira sintetizada, segundo Chua (apud FLORIO et al., 2008, p. 2), os 

protótipos rápidos podem desempenhar as seguintes funções durante o 

desenvolvimento do projeto: na fase de concepção do projeto, o protótipo rápido 

permite testar e provar as opções e ideias de projeto. Amplia os recursos de 

comunicação e interação, por meio da compreensão tátil entre os colaboradores, 

cliente e o próprio arquiteto. Permite, ainda, a experimentação e o aprendizado de 

soluções de problemas. Na fase mais adiantada de projeto, o protótipo rápido 

oferece recursos com maior precisão, para síntese e integração por meio da 

montagem de componentes. Por fim, por meio de planejamento e de execução, 

permite programar e produzir o projeto. 

Schodek et al. (2005, p. 297-298) afirmam que não há uma mesma 

terminologia usada por todas as indústrias, mas os protótipos rápidos podem ser 

descritos pela maneira como eles são produzidos e como podem ser usados. Dessa 
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forma, eles podem ser definidos como protótipos experimentais e protótipos pré-

produção. 

Os protótipos experimentais são produzidos para testar uma ideia, durante o 

início ou no desenvolvimento do processo de projeto, e geralmente produzidos num 

processo mais rápido. Por outro lado, os protótipos pré-produção são produzidos 

para testar o projeto na etapa anterior à produção final, incorporando mais das 

qualidades “reais” necessárias para informar a equipe de engenharia e de produção. 

Por isso levam um tempo maior em relação aos protótipos experimentais, para 

serem elaborados. Geralmente, utilizam o mesmo processo de fabricação proposto, 

para alcançar a realidade mais próxima possível dos materiais e formas das partes 

finais do projeto. 

No início do processo de projeto arquitetônico, a produção do protótipo 

experimental, que Ryder et al. (2002, p. 281-283) definem como modelo conceitual 

de protótipo, é um importante recurso para avaliar a forma estética do projeto. 

Quando feito para explorar o contorno e cuidados com a aparência formal, o 

protótipo pode, ainda, ser útil para explorar as questões ergonômicas do modelo. 

Alguns protótipos também podem servir como inspiração visual, durante o 

desenvolvimento de ideias e produtos (SCHODEK et al., 2005, p. 298). 

Na figura abaixo, diferentes tipos de impressoras 3D, utilizadas para a 

produção de modelos pelo processo de adição: 

 

(a)              (b)  

Figura 23 - (a) Impressora 3D, modelo ZPrinter 310 Plus, da Z Corporation; (b) Impressora 3D 
RapMan 3.1 Ultimate, da 3D Systems 

Fonte (a): ZCorp, 2011 
Fonte (b): TurboCAD, 2011 

http://www.zcorp.com/
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Nesta etapa inicial do processo de projeto, um modelo prototipado com 

menor precisão ou resistência atende aos requisitos. Os sistemas, por sua vez, 

devem oferecer rapidez e custo mais baixo na produção do modelo. Os exemplos de 

sistemas mais conhecidos para obter o modelo conceitual de protótipo rápido são os 

das empresas 3D System, Stratasys e ZCorporation, que trabalham com o processo 

por adição de camadas (RYDER et al., 2002, p. 281-283).  

Segundo Matias, as impressoras tridimensionais (3DP) são baseadas em 

tecnologia inkjet, similar às impressoras jato de tinta e, por sua adequação aos 

ambientes de escritório, também são conhecidas como prototipagem rápida desktop. 

Esse processo consiste na impressão de material aglutinante sobre uma 

camada uniforme de material em pó, promovendo a sua ligação e formando, após 

várias etapas de impressão, as diversas camadas que constituem o modelo. Cada 

gota de material aglutinante une o material em pó subjacente, criando um ponto de 

material unido. Estes pontos unem-se entre si por sobreposição. O material unido 

forma a peça, enquanto o restante do material cumpre a função de suporte. Após a 

construção do protótipo, este é retirado da máquina e pode receber a aplicação de 

um material adequado, com a finalidade de melhorar a sua resistência mecânica. 

O mesmo autor descreve ainda as principais vantagens do processo de 

impressão tridimensional, como o pouco tempo para construção do protótipo, os 

materiais utilizados com baixo custo e atóxicos e, ainda, a praticidade para utilizar o 

equipamento dentro do ambiente de escritório. Cita como desvantagens o pouco 

acabamento superficial do modelo, as propriedades mecânicas inferiores em relação 

a outros processos e, por último, as pequenas dimensões para prototipagem 

(MATIAS, 2007, p. 11-13). 

Os autores Oliveira e Fabricio (2011, p. 462) complementam as vantagens e 

desvantagens desse processo. Mencionam que no caso das impressoras 

tridimensionais, além do fato dos protótipos produzidos apresentarem relativa 

fragilidade, precisam de um dimensionamento mínimo e pós-processamento com a 

peça. Porém, salientam que o modelo produzido pode ser exatamente igual ao 

arquivo digital enviado à impressão, o que gera liberdade de criação formal. 

Wohlers também classifica os modeladores conceituais de protótipo rápido 

(concept modeler) como aqueles que devem ser usados nas fases iniciais do 

projeto. As características físicas de um modelo definem sua qualidade e 

determinam o sucesso ou a limitação da tecnologia aplicada. Atualmente, muitas 
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dessas tecnologias são utilizadas apenas na visualização de peças e protótipos, ou 

seja, sem um compromisso funcional, por não terem a preocupação com a 

resistência e a precisão. Esses modeladores conceituais destinam-se a diversas 

análises, como túneis de vento, estudos de iluminação natural e identificação de 

erros de design, nas primeiras fases do projeto (WOHLERS, 2008 apud PUPO; 

CELANI, 2011, p. 473). 

Na etapa final do processo de projeto, o protótipo pré-produção, que Ryder 

et al. (2002, p. 282-283) definem como protótipo rápido, é usado para verificar 

encaixes e montagem. Quando utilizado como protótipo funcional, demonstra como 

algo pretende trabalhar, por exemplo, utilizando um modelo de um mecanismo 

(SCHODEK et al, 2005, p. 298). 

Segundo Ryder et al. (2002, p. 281-285), para obter o protótipo pré-

produção, na etapa final do projeto, um nível básico de precisão é necessário. 

Alguns dos sistemas usados para obter o modelo conceitual de protótipo ainda são 

capazes de produzir modelos precisos o suficiente para tal fim. Entretanto, os 

sistemas de prototipagem rápida mais usados para obter o padrão de precisão para 

encaixe são a Estereolitografia (SLA), a Sinterização Seletiva a Laser (SLS), a 

Modelagem de Objeto Laminado (LOM) e a Modelagem por Deposição e Fusão 

(FDM). Estas tecnologias oferecem maior precisão e uma gama mais ampla de 

materiais funcionais. 

A produção de um modelo de projeto depende do uso de equipamentos, que 

permitam gerar partes que possam ser agrupadas ou montadas com precisão e, se 

possível, integralmente utilizadas para testar o produto. Isto somente é alcançado se 

forem utilizados os sistemas de prototipagem rápida mais avançados, que 

apresentam maior precisão, acabamento e resistência. 

Todos esses processos de adição, incluindo a impressão tridimensional 

(3DP), Sinterização Seletiva a Laser (SLS), Modelagem por Deposição e Fusão 

(FDM), Estereolitografia (SLA) e Modelagem de Objeto Laminado (LOM), consistem 

em sobrepor sucessivas camadas de material, até que o objeto seja formado. Para 

que isso ocorra, o software do sistema de prototipagem “fatia” horizontalmente o 

modelo digital. Conforme o material de cada tipo de equipamento, cada camada é 

colada uma sobre a outra (PUPO, 2008, p. 9).  

A seguir, imagens de equipamentos de alta resolução para prototipagem 

rápida: 
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(a)          (b)   

(c)       (d)     

Figura 24 - (a) Equipamento de estereolitografia (SLA); (b) Sinterização seletiva a laser (SLS); (c) 
Equipamento de modelagem de objeto laminado (LOM); (d) Modelagem por deposição e fusão (FDM) 
Fonte (a): Arpiadesign, 2011 
Fonte (b): 3DSystems, 2011 
Fonte (c): Sisgraph, 2011 
Fonte (d): Stratasys, 2011 
 
 

A figura 25, a seguir representa todas as fases referentes ao processo de 

prototipagem rápida por adição de camadas: Inicia com o modelo virtual produzido 

por um sistema CAD, que por sua vez também permite gerar o arquivo STL 

correspondente. No software do equipamento de prototipagem, o arquivo STL é 

importado e preparado de maneira que planos fatiam o modelo. Na intersecção dos 

planos com o modelo, uma fatia contendo as medidas e coordenadas é gerada para 

o equipamento poder reconstruir o volume, sobrepondo camada por camada, até 

obter o modelo completo fisicamente.  
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       Modelo CAD    Modelo STL      Planos de fatiamento 

          

                   

Intersecção de um plano                        Fatia gerada                         Adição de camadas 

 

Figura 25 - Fases do processo de prototipagem rápida por adição de camadas 
Fonte: CIMJECT, 2012 

 

Em relação aos tipos de prototipagem digital, o protótipo experimental possui 

o foco na concepção e desenvolvimento de projeto, enquanto que o protótipo pré-

produção concentra-se na condição de execução final do trabalho. Isto implica 

diretamente no nível de precisão e tipo de material relacionado ao equipamento, a 

ser definido para produção do protótipo rápido. O projetista necessita conhecer as 

capacidades técnicas de cada equipamento, de maneira a obter o produto com as 

características desejadas, para evitar o aumento de custos e de tempo. 
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Para melhor entendimento sobre os dois diferentes protótipos rápidos, segue 

abaixo o quadro contendo de maneira esquemática as características, os diferentes 

tipos de uso na arquitetura e as respectivas tecnologias mais utilizadas. 

 

Quadro 4 - Comparações entre os tipos de prototipagem digital 

PROTOTIPAGEM DIGITAL 

 
TIPOS CARACTERÍSTICAS APLICAÇÃO PROCESSOS 

 

PROTÓTIPO 

EXPERIMENTAL  

(Etapa Inicial 

de Projeto) 

 

 Escala Reduzida 

 Menor Precisão 

 Menor Tempo  

 Menor Custo 

 

 Experimentação e 

aprendizado de soluções 

de problemas 

 Testar e provar ideias 

 Comunicar e interagir por 

compreensão tátil 

 Análises ambientais e 

formais 

 

Por Adição: 

3D Printer 

FDM 

Por Corte 2D: 

Corte a Laser 

Corte em Vinil 

Por Subtração: 

 Fresagem (pouco 

utilizada) 

 

PROTÓTIPO 

PRÉ-PRODUÇÃO 

(Etapa Final 

de Projeto) 

 

 Escala Reduzida e 

1:1 

 Maior Precisão 

 Maior Tempo  

 Maior Custo 

 

 Síntese e integração por 

montagem de 

componentes 

 Programar e planejar a 

produção 

 Produzir o projeto 

 

Por Adição: 

3DP 

FDM 

SLS 

SLA 

LOM 

Por Corte 2D: 

Corte a Laser 

Corte em Vinil 

Por Subtração: 

 Fresagem 

Fonte: Autoria nossa 

 

Para que o arquiteto possa comparar as informações referentes às 

diferenças de custo e tempo, para elaboração da modelagem convencional e a 

modelagem digital, os autores Ryder et al. (2002, p. 283-287) pontuam os principais 

parâmetros para definir o tipo de modelagem do projeto arquitetônico, que são: a 

escala, o tamanho, o custo, o tempo, os materiais, a complexidade e a precisão. O 

quadro abaixo descreve estes diferentes parâmetros, relacionados com os diferentes 

tipos de modelagem arquitetônica: 
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Quadro 5 - Comparações entre prototipagem rápida (PR), modelo virtual (MV) e às etapas de 
modelagem convencional 

  
Viabilidade 

 
Planejamento 

 
Final 

 
PR 

 
MV 

Escala 
1:200 
1:500 

1:200 
1:500 

1:200 
1:500 

1:200 
1:500 

1:1 

Tamanho 
250x 
250x 
250 

250x 
250x 
250 

250x 
250x 
250 

Depende 
da 

Tecnologia 

Como 
Modelado 

Custo £`s* £ 10`s* £ 1000`s 
£ 100`s/ 
1000`s 

£ 100`s/ 
1000`s 

Tempo Horas Dias Meses 
Horas/ 
Dias 

Horas/ 
Dias/ 

Semanas 

Materiais 
Papelão, 
Plástico 

Papelão, 
Madeira, 
Plástico 

Madeira, 
Plástico, 
Tecido 

Polímeros,
Papelão 

N/A 

Complexidade Baixa Média Alta Alta 
Como 

Renderizado 

Precisão Baixa Média Alta Alta 
Como 

Modelado 

Fonte: Ryder et al., 2002, p. 289 (tradução nossa) 

 

Os modelos virtuais e os protótipos rápidos, os quais Schodek et al. (2005, 

p. 298) definem como protótipos digitais e fisicos, juntos oferecem meios de 

compreensão para testar e analisar virtualmente todas as características da 

proposta de um projeto. Isto permite ao arquiteto considerar desde o início os 

métodos para a modelagem em um ambiente digital que, na etapa final, deverão ser 

usados para a sua fabricação. 

Em relação aos modelos virtuais, os modelos físicos possuem uma 

aplicação mais adequada quando há necessidade de uma percepção tátil. Eles são 

facilmente transportáveis e não são dependentes de hardware para apresentação. 

No entanto, no caso de alterações no projeto, precisam ser reconstruídos. 

Geralmente, os modelos construídos em uma escala menor que a real (1:1) resultam 

na perda de certos detalhes do projeto, e isto deve ser considerado, dependendo de 

qual for o objetivo de uso do modelo (RYDER et al., 2002, p. 289). 

 

A capacidade de „imprimir‟ modelos de projetos influenciará muito a forma 
como projetistas de todos os tipos, de designers de produto a projetistas de 
arquitetura, conduzem os seus processos de projetação. (Ibid., p. 290, 
tradução nossa) 

 

Segundo Schodek et al. (2005, p. 297), os protótipos rápidos e modelos 

digitais têm sido parte integrante do processo de projeto. Essas tecnologias digitais 

são utilizadas durante diferentes etapas do desenvolvimento do projeto, e os 
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processos de produção são considerados para desenvolver e testar ideias e 

métodos. Com o auxílio das ferramentas de manufatura digital, o modelo físico é 

produzido com precisão e no tempo conveniente, além de permitir ampliar a gama 

de técnicas disponíveis, para fazer os protótipos em uma variedade de materiais que 

atendam às diferentes necessidades de projeto. 

 

 

5.4 O processo de prototipagem rápida na arquitetura 

 

O processo de prototipagem rápida, para Pupo e Celani (2011), começa a 

partir de um arquivo de modelo digital gerado em qualquer sistema CAD 

tridimensional, ou por digitalização tridimensional do objeto a ser prototipado. Ainda 

dentro do sistema CAD, o arquivo do modelo virtual deve ser exportado para ser 

interpretado pelo sistema do equipamento de impressão 3D - o formato mais usual é 

o STL (stereolitography). 

Em sequência, o procedimento consiste em verificar a integridade do arquivo 

exportado do sistema CAD - por exemplo o formato STL; definir os suportes para o 

modelo, quando for o caso; definir parâmetros como escala, tempo de execução, 

posição e orientação do objeto e “fatiar” em camadas no sentido horizontal, para 

então ser encaminhada à etapa de fabricação. A produção de cada modelo depende 

da maneira específica que cada sistema sobrepõe camada por camada, 

solidificando o objeto produzido.  

A última etapa, o acabamento, consiste na pós-produção do modelo, que 

dependendo da tecnologia do equipamento, exige o lixamento, o polimento, a 

resinagem ou pintura da peça. As autoras Pupo e Celani (Ibid., p. 477) consideram 

ainda que, além do projeto de arquitetura, as tecnologias para fabricação digital de 

protótipo requerem um projeto exclusivo para produção do modelo, no qual todos os 

parâmetros e variáveis devem ser considerados para o resultado satisfatório do 

protótipo. 

O quadro a seguir apresenta as etapas gerais do processo de prototipagem 

rápida, por meio da técnica de adição. Neste caso, as etapas são sempre as 

mesmas, e o que pode variar são os materiais, o tempo de impressão e o tipo de 

acabamento: 
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Quadro 6 - Etapas gerais do processo de prototipagem rápida por adição de camadas 

 
 

 
Fonte: Volpato et al., 2007, apud Pupo; Celani, 2011, p. 473 

 

Nesse sentido, Mills (2007, p. 188) apresenta o exemplo do escritório 

americano Morphosis, fundado pelo arquiteto Thom Mayne, um dos pioneiros no uso 

de equipamentos de prototipagem rápida dentro do próprio atelier. Segundo o 

entendimento desses arquitetos, o processo se inicia com a criação de modelos 

virtuais volumétricos e de conceito, diretamente no computador, como a melhor 

forma de acelerar a exploração das opções de projeto. A paritr do modelo digital, 

vários pequenos protótipos rápidos são elaborados para estabelecer uma troca de 

informações, em processo de “vai e vem”, resultando em modificações a serem 

realizadas no modelo virtual. Dessa maneira, formas difícies de serem executadas 

manualmente, com curvas complexas e superfícies reversas, podem ser exploradas 

com confiança e controle. 

A Figura 26 apresenta fotos do Protótipo Rápido produzido a partir da 

impressora tridimensional da ZCorp modelo 310, pelo processo de adição por 

camadas de jato de pó, do projeto feito para o concurso do Instituto Politécnico de 

Rensselaer. 

 

 

Figura 26 - Protótipo rápido do projeto do Edifício de Artes Dramáticas e Mídia Eletrônica do Instituto 
Politécnico de Rensselaer, Morphosis, EUA 

Fonte: Mills, 2011, p. 189 

 

Conforme a experiência do escritório Morphosis nesse processo, a 

prototipagem rápida permite explorar com liberdade volumes que, na modelagem 

física manual, não seriam possíveis de serem representados. Outra opção 

importante em relação ao uso do protótipo digital é a produção de detalhes, de parte 

 

PLANEJAMENTO 

 

CAD 

 

FABRICAÇÃO 

 

ACABAMENTO 

http://www.zcorp.com/
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do projeto, em tamanho real para análise. O escritório também utiliza o protótipo 

como um poderoso instrumento de comunicação com os clientes, e ainda produz 

diferentes estudos em escala e em seções, em pouco tempo e custo adicional. O 

software adotado pela equipe para modelagem é o Triforma, que possui interface 

direta com o software Microstation (Mills, 2007, p. 188-189). 
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6 INTEROPERABILIDADE 

 

A interoperabilidade pode-se citar em contexto mais amplo como a 

“habilidade de dois ou mais sistemas de interagir e de intercambiar dados de acordo 

com um método definido, de forma a obter os resultados esperados” (ISO). Resulta 

em protocolos e padrões de comunicação que devem ser adotados para melhorar a 

comunicação entre estas partes. Kunze (2009, p. 39) esclarece ainda, de que 

maneira este processo pode acontecer:  

 

Os processos de interoperabilidade acontecem, principalmente, em 
ambientes controlados, onde existe a possibilidade de definir padrões ou 
linguagens comuns de troca de dados e informações. Esses padrões são 
definidos, num contexto nacional, pelo governo e entidades encarregadas 
dos processos de normatização. Normalmente esses padrões se baseiam 
em padrões internacionais e abertos. Tanto o governo, a iniciativa privada e 
o terceiro setor devem seguir esses padrões. (Ibid., p.40) 

 

Os benefícios da interoperabilidade são citados por Santos (apud KUNZE, 

2009, p. 51) como uma maior interconexão em vez de soluções isoladas, redução 

dos custos de transação, aumento da participação dos agentes envolvidos e melhor 

acesso a mais informações, possibilitando a resolução mais rápida dos problemas. 

O governo brasileiro, por meio da arquitetura ePING (Padrões de 

Interoperabilidade de Governo Eletrônico), definiu um conjunto mínimo de 

premissas, políticas e especificações técnicas que regulamentam a utilização da 

Tecnologia de Informação e Comunicação (TIC), na interoperabilidade de Serviços 

de Governo Eletrônico, estabelecendo as condições de interação com os demais 

Poderes e esferas de governo, e com a sociedade em geral (BRASIL, 2006, p. 4). 

A visão da arquitetura ePING é voltada para aspectos de Tecnologia da 

Informação, no qual o foco destes padrões de interoperabilidade está relacionado a 

aspectos de interoperação, basicamente entre equipamentos eletrônicos (ITS).  

Na área da arquitetura, engenharia e construção, o tema interoperabilidade 

ganhou relevância entre os profissionais da área de projeto, a partir do aumento do 

uso das ferramentas BIM (Building Information Modeling). Segundo Eastman et al. 

(2008), isso se deve ao fato da interoperabilidade, juntamente com a modelagem 

paramétrica, ser considerada um dos fundamentos para o uso de sistemas BIM. 

 

 



 78 

6.1 Tipos de formatos 

 

Entre as décadas de 1970 e 1980, tornava-se aparente a necessidade de 

transferência de informações entre softwares de projetos, de documentação e de 

análises. A Agência Espacial Americana - NASA, após constatar os elevados custos 

com tradutores entre todas as empresas que desenvolviam sistemas CAD, exigiu 

que as mesmas concordassem em criar um formato de transferência de dados, que 

fosse de domínio público. O resultado foi a criação do formato padrão IGES (Initial 

Graphics Exchange Specification). A princípio, este formato possibilita que cada 

empresa de software desenvolva apenas dois tradutores para a exportação e 

importação, a partir da sua aplicação, a invés de desenvolver um tradutor para cada 

par de matrizes do programa (Ibid., p. 66).  

Ainda segundo Eastman, a transferência de dados entre dois aplicativos 

pode ocorrer de quatro maneiras distintas:  

 de maneira direta, fornece uma conexão integrada entre os dois aplicativos. 

Existem todos os níveis de interface de programação, como as linguagens C 

e C++. As interfaces permitem que parte do aplicativo do modelo da 

edificação seja acessível, para operações como criação, exportação, 

modificação ou eliminação; 

 entre o formato de arquivo registrado de softwares específicos, com 

prioridade na troca de informações geométricas. O formato é desenvolvido 

por uma organização comercial, para fazer a interface aplicada à própria 

empresa. Os exemplos de formatos conhecidos são DXF (AutoCAD), STL 

(Estereolitografia), 3DS (3D Studio Max), entre outros. Cada um desses 

formatos aborda as capacidades funcionais específicas para seus próprios 

fins; 

 por meio de formato de exportação de domínio público, envolvendo o uso de 

modelos de construção em padrão aberto, representados pelos formatos IFC 

(Industry Foundation Classes) ou CIS/2 (CIMSteel Integration Standards) 

como as principais opções. Além da geometria, estes formatos transportam 

as propriedades e materiais do objeto, além das relações entre os mesmos;  

 entre formatos com padrão XML, que é uma extensão do HTML, a 

linguagem base da Web. Este formato permite definir a estrutura e 

significados de algumas informações de interesse. As diferentes estruturas, 



 79 

chamadas de “schema”, do padrão XML, suportam a transferência de muitos 

tipos de dados entre as aplicações. 

Na área de arquitetura e construção civil, os formatos de transferência de 

informação de superfícies e formas tridimensionais geralmente utilizadas são: 3DS, 

WRL, STL, IGS, SAT, DXF, DWG, OBJ, DGN, PDF (3D), XGL, DWF, U3D, IPT, 

PTS. Estes formatos variam conforme os tipos de superfícies e linhas representadas, 

de acordo com a necessidade ou não de representação de sólidos, segundo as 

propriedades dos materiais ou, ainda, segundo a necessidade de apresentação de 

informações, a partir de diferentes pontos de vista. 

Todos os métodos de interoperabilidade devem considerar a questão das 

versões de cada software. Quando o aplicativo é atualizado com novas operações, 

isso pode acarretar em defeito no mecanismo de transferência. Desta forma, caso 

não sejam mantidas as versões do padrão, estas não serão bem gerenciadas (Ibid., 

2008, p. 69-70). 

Em 1995, a indústria da construção passou a contar com a contribuição da 

IAI (International Alliance for Interoperability), atualmente conhecida como 

BuildingSMART – International home of openBIM, para o desenvolvimento de um 

modelo de objetos. O IAI foi o organismo responsável pela criação da extensão de 

arquivo IFC (Industry Foundation Classes), que possibilita o compartilhamento de 

informações de projeto, através do seu desenvolvimento e em aplicações técnicas. 

As extensões IFC são públicas, abertas para implementação e para o uso de 

qualquer membro, e ainda podem ser desenvolvidas a qualquer tempo (JACOSKI; 

LAMBERTS, 2012, p. 3).  

Este formato de extensão geralmente é utilizado para interação de 

informações geradas em softwares BIM com os softwares de simulação, 

possibilitando inúmeras vantagens, conforme citam Bazjanac e Crawley (1997 apud 

JACOSKI; LAMBERTS, 2012, p. 4) entre elas: interagir entre os arquivos 

diretamente e instantaneamente; distribuir e transferir informações de interesse 

comum; acesso sem custos para uso de dados geométricos e outros; redução no 

custo de projeto de simulação; e acréscimo e melhor uso dos resultados de 

simulação e análise. 

No sentido de que o modelo gerado com o uso dos sistemas BIM consiga 

integrar as etapas de projeto, é necessária a solução dos problemas de falta de 

interoperabilidade. Jacoski e Lamberts (2012) mencionam que, mesmo com a 
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significante contribuição no processo, as ferramentas computacionais ainda carecem 

de solução às repetidas interrupções e perdas de produtividade na elaboração de 

projetos.  

Até o momento, os motivos que tornam a interoperabilidade e a colaboração 

na indústria da Arquitetura, Engenharia, Construção e Operação (AECO) pouco 

bem-sucedidas são, por um lado, a falta de entendimento entre os profissionais 

(AECO) sobre os benefícios da interoperabilidade para o processo de projeto e 

construção. Por outro lado, observa-se o fato da viabilidade de transferência integral 

de dados entre os softwares resultar em desinteresse por parte das empresas 

desenvolvedoras, por não condicionar as empresas parceiras na utilização de 

pacotes de softwares de um mesmo desenvolvedor (ANDRADE; RUSCHEL, 2011, 

p. 431-432). 

Os autores Andrade e Ruschel (Ibid., p. 435) sugerem uma alternativa para 

aumentar a interoperabilidade dos aplicativos BIM, com o uso das tecnologias de 

portais web: 

 
O uso do portal BIM web como repositório central, baseado num padrão de 
informação global, aberto e interoperável, pode possibilitar a redução de 
perdas e sobreposições de dados gerados na indústria da AECO. Com isso, 
estimula-se um ambiente de colaboração internacional entre diferentes 
equipes de projeto, com alto nível de interoperabilidade e em tempo real.  

 

Os portais BIM web são tecnologias de suporte para uma prática de projeto 

integrado. O surgimento desses portais tem permitido a melhoria significativa da 

produtividade no processo de projeto, construção e gestão de edifícios. Eles têm 

sido usados por muitas organizações para conseguir ganho de desempenho nos 

seus processos de projeto e construção do edifício, com um maior envolvimento de 

pessoas no uso de ferramentas computacionais. Um exemplo de portal BIM web é o 

Onuma Planning System (OPS), desenvolvido pela empresa norte-americana 

Onuma Inc. (Ibid., p. 434-435). 

 

 

6.2 O formato STL 

 

Segundo Ryder et al. (2002, p. 280), em todos os setores das indústrias a 

interoperabilidade entre os sistemas digitais ocorre com uso do arquivo 
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tridimensional no formato padrão STL (estereolitografia), para obteção do prototipo 

rápido. Geralmente, os sistemas CAD tridimensionais incluem a opção de 

exportação no formato STL. A impressoras tridimensionais, por sua vez, geralmente 

importam os arquivos com extensão STL. Outra vantagem desse formato é o fato de 

ser um padrão não proprietário, ou seja, um padrão aberto, que não possui domínio 

de uma única empresa comercial. 

Em alguns poucos softwares CAD, além do formato STL, é possível exportar 

o arquivo do modelo direto para o formato padrão do sistema de prototipagem. No 

sentido de delimitar o objeto desta pesquisa, devido à exiguidade de tempo e 

recursos, o formato STL no padrão binário será o formato padrão adotado, para 

efeito de estudo de interoperabilidade entre diferentes tipos de sistemas CAD e as 

impressoras tridimensionais. A seguir, o formato STL será descrito com mais 

detalhes, para melhor compreensão do funcionamento deste formato padrão. 

O padrão STL é um formato de arquivo desenvolvido pela empresa 3D 

Systems, em 1987. Tornou-se amplamente utilizado nos processos de fabricação 

por adição, por ser considerado simples e suportado por vários pacotes de sistemas 

CAD (FRANCISCO, 2010, p. 9). 

Segundo Rypl e Bittnar (2005, p. 1), um arquivo STL é a representação de 

uma geometria de superfície tridimensional com base em faces triangulares. A 

superfície é tramada em um conjunto de triângulos facetados, e cada face é descrita 

pela unidade exterior dos três pontos que representam cada vértice do triângulo. O 

tamanho das faces é conduzido pela tolerância que controla a qualidade da 

representação da superfície, ou seja, a distância entre as faces dessa superfície. 

Cada arquivo STL é produzido com diferentes graus de tolerância, o que é definido 

pelo tipo de equipamento e por sua capacidade de resolução e precisão. 

Neste formato, segundo Matias (2007, p. 4), a geometria do modelo CAD é 

descrita através de uma malha envolvente de triângulos, que do ponto de vista 

matemático constitui a forma polinomial mais simples de descrição de uma 

superfície. O arquivo contém o sistema tridimensional de coordenadas cartesianas 

(x,y,z) dos nós de cada triângulo, bem como a respectiva normal exterior. As demais 

entidades que descrevem a representação de cor, textura ou outros atributos 

comuns ao modelo, são ignoradas na criação do arquivo STL. 

O formato STL especifica ambas as representações ASCII e binário. No 

caso do padrão ASCII, cada triângulo é identificado pelas coordenadas dos três 
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vértices, definidos no sentido anti-horário, e pela normal exterior a cada triângulo. No 

caso de não estar definido, o vetor unitário é gerado de forma automática pela 

maioria dos softwares existentes, conforme representação da figura abaixo: 

 

 

 
Figura 27 - Representação da normal e dos vértices de cada triângulo no arquivo STL em ASCII 

Fonte: Fabbers apud Francisco, 2010, p. 10 

 

O arquivo STL em ASCII é escrito começando pela palavra solid, seguida do 

nome do arquivo, e termina com a palavra endsolid. A definição de cada triângulo 

começa com a palavra chave facet e termina com a palavra endfacet. Cada vértice é 

descrito num registro vertex com suas coordenadas (x, y, z). A definição dos vértices 

de cada triângulo é feita por meio de um ciclo iniciado com a palavra chave outer 

loop e finaliza com a palavra endloop, como descrito na figura abaixo: 

 

solid nome (name) 

facet normal x y z 

      outer loop 

            vertex x y z 

            vertex x y z 

            vertex x y z 

endloop 

endfacet 

endsolid nome (name) 

                                                           
Figura 28 - Estrutura de um arquivo STL em ASCII 

Fonte: Fabbers apud Francisco, 2010, p.10 

 

O formato STL binário é menor que o arquivo correspondente em ASCII, e 

muitas vezes pode ser adotado como opção corrente (default) pelos sistemas CAD, 

para exportar o arquivo do modelo. O formato binário utiliza inteiros e vírgulas 

flutuantes, para a representação numérica da malha triangular. Os primeiros 84 

bytes são destinados ao cabeçalho e para cada triângulo existente são ocupados 
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mais 50 bytes com as coordenadas (x, y, z) do vetor da normal e dos três vértices, 

conforme representado na figura abaixo: 

 

Bytes    Descrição 

 
80   Cabeçalho (Ignorado) 

4   Número de triângulos 

 

Para cada triângulo 

 

4 Componente x da normal 

4 Componente y da normal 

4 Componente z da normal 

4 Coordenada x do vértice 1 

4 Coordenada y do vértice 1 

4 Coordenada z do vértice 1 

4 Coordenada x do vértice 2 

4 Coordenada y do vértice 2 

4 Coordenada z do vértice 2 

4 Coordenada x do vértice 3 

4 Coordenada y do vértice 3 

4 Coordenada z do vértice 3 

2 Bytes livres 

 

Figura 29 - Estrutura de um arquivo STL binário 
Fonte: Fabbers apud Francisco, 2010, p. 11 

 

Segundo Bártolo (apud FRANCISCO, 2010, p. 11), para uma definição 

correta de uma rede de elementos triangulares, é preciso seguir três regras. A regra 

de orientação dos triângulos, na qual a orientação dos vértices de cada triângulo 

deve seguir o sentido anti-horário. Na segunda regra, adjacência, cada triângulo 

deve partilhar dois vértices do triângulo adjacente. Por último, no caso de triângulos 

adjacentes, a direção de um lado de um triângulo é oposta à direção do mesmo lado 

no triângulo adjacente - regra de Mobius. Quando estas regras não são seguidas 

para gerar o formato padrão STL, problemas no momento da preparação do modelo 

para prototipagem podem ser detectados (RYPL; BITTNAR, 2005, p. 2). 

 

 

6.3 A interoperabilidade CAD/CAM 

 

No caso da interoperabilidade entre os sistemas CAD/CAM, por se tratar de 

sistemas distintos entre si, também precisam transferir as informações geradas de 

um software para outro, para tornar viáveis as operações entre os mesmos. É 

importante relembrar o conceito de interoperabilidade, como sendo a capacidade de 

comunicação de dados entre diferentes sistemas, que retrata a necessidade de 
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transmitir dados entre aplicativos, contribuindo para a redução do trabalho manual 

entre os vários tipos de especialidades (EASTMAN et al., 2008, p. 65).  

Muitos podem ser os problemas que impedem a interoperabilidade entre os 

sistemas CAD/CAM, desde o uso de diferentes sistemas de softwares, diferentes 

versões dos produtos ou comunicação inconsistente entre projeto e manufatura. No 

entanto, os problemas predominantes de interoperabilidade são devidos à falta de 

qualidade dos modelos CAD. Estes podem apresentar defeitos topológicos ou 

geométricos que não são visíveis ao usuário. Alguns desses defeitos podem ser 

provenientes dos próprios softwares de modelagem (McKENNEY, 1998, p. 2). 

 

 

6.4 A qualidade do modelo CAD  

 

Os problemas de qualidade do modelo, para McKenney (Ibid., p. 3-5) podem 

ser classificados em três áreas: precisão, estrutura e realismo. Os requisitos de 

precisão colocam limites para os tamanhos mínimos entre as entidades geométricas 

(arestas, vértices e faces). Os modelos extremamente precisos requerem estruturas 

de dados grandes e complexas. Para defini-los com as formas complexas, 

necessitam de espaçamento de arestas e faces menores. 

Os modeladores de sólidos usam tolerâncias diferentes para calcular o 

desvio máximo permitido entre as entidades topológicas, e as falhas na geometria 

podem ser difíceis de serem vistas em imagens sombreadas ou em linhas ocultas do 

modelo. Ainda, a tradução dos dados da geometria entre os softwares pode falhar - 

no caso, as tolerâncias máximas permitidas entre as superfícies e bordas na 

exportação apresentam-se maiores do que as dos softwares de importação. Ainda, 

problemas estruturais incluem inconsistências na orientação de loop, ausência de 

geometria e auto-intersecção de geometria. Estes erros podem determinar 

comportamentos imprevisíveis nos softwares, como a execução de tarefas 

equivocadas ou até mesmo a paralisação total do funcionamento do sistema. 

Por fim, os problemas de realismo da reprodução do modelo CAD em 

modelo físico acontecem quando as fendas definidas no modelo sólido, dependendo 

do seu tamanho mínimo, não podem ser estendidas completamente até o objeto. O 

sistema gera outras pequenas faces alongadas para corrigir o fechamento das 
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superfícies, com maior dimensão em um modelo, ou até com faces de ângulo muito 

agudo entre os cantos de um vértice (Ibid., p. 6-7). 

Em pesquisa sobre os erros mais comuns que surgem na malha de modelos 

CAD, Veleba e Felkel (2007, p. 1), descrevem algoritmos para detecção e correção 

dos erros, e apontam os problemas por meio de duas abordagens por 

processamento de malha direta e processamento de malha voxelized.  

Os erros de malha são definidos em: rachaduras (cracks), buracos, 

articulações em "T", sobreposições, paredes soltas, geometria duplicada, auto-

intersecção, orientação inconsistente da normal, polígonos invisíveis, faces 

degeneradas e erros de cavidades. As Figuras 30 a 33 apresentam algumas 

ilustrações com exemplos destas falhas, que podem ocorrer no modelo CAD. 

 

Figura 30 - Exemplo de rachadura (crack): (a) superfície lisa; (b) superfície representada por faces 
planas; (c) superfície com faces planas corrigidas 

Fonte: Veleba; Felkel, 2007, p. 2 

 

Para visualizar o problema de rachaduras no modelo, geralmente o usuário 

precisa acionar a opção de comando, dentro do software de sistema CAD, com alta 

resolução - por exemplo, o render. Para evitar o tipo de problema "crack", na 

construção de superfície do modelo, o usuário deve aumentar o número de faces 

para a divisão longitudinal e transversal.  

O problema de normais invertidas (Figura 31) pode ocorrer no momento da 

importação do arquivo do modelo para outro software. Por isso, os softwares de 

impressoras tridimensionais detectam as normais invertidas e fornecem o comando 

para ajustar as normais, ou ainda podem executar a tarefa automaticamente no 

momento da importação do arquivo. 
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Figura 31 - Exemplos de: a) Orientação inconsistente da normal; b) Objeto com normais trocadas;  
c) Objeto com normais apresentadas corretamente 

Fonte: Veleba; Felkel, 2007, p. 5 

 

A opção de unir os elementos que pertencem à mesma geometria, por meio 

de comandos dentro do ambiente de modelagem, pode evitar os problemas 

representados nas Figuras 31 e 32: 

 

     C)  

Figura 32 - Exemplos de geometria duplicada: a) Cubo com um lado triangulado e desviado; 
b) Vértices e arestas duplas ao longo da borda; c) polígonos invisíveis na junção das duas paredes 

Fonte: Veleba; Felkel, 2007, p. 4-6 
 

 

 

Figura 33 - Exemplo de Erros de Cavidade. a) Superfície original (traçado vermelho) 
Fonte: Veleba; Felkel, 2007, p. 7 
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Além dos procedimentos preventivos, descritos acima, a serem efetuados 

durante a construção da geometria do modelo, o usuário também tem outra opção. 

McKenney (1998, p. 10) sugere implementar um programa de qualidade contendo os 

seguintes itens: melhoria da técnica de modelagem, relatório de bugs de softwares e 

requisitos de usuários para melhor investigação neste campo. Estes procedimentos 

podem resultar na redução em até 80% nos problemas ocorridos durante o processo 

de prototipagem rápida. 

No sentido de automatizar o trabalho de controle de qualidade, um software 

pode efetuar a tarefa de analisar o modelo CAD, antes de exportá-lo para o software 

de impressão tridimensional. Uma vez identificado o problema, este pode ser 

ajustado, na etapa inicial de desenvolvimento, ocasião em que as alterações podem 

ser incorporadas de forma rápida e com menos custos, e com o pleno conhecimento 

da intenção do projetista.  

Um dos softwares disponível no mercado, utilizado com esta função e 

conhecido na área de engenharia, é o CADIQ da ITI. O software diagnostica os 

problemas de projeto e os registra no formato de relatório padrão PDF 3D, para que 

os profissionais da engenharia possam retornar ao modelo do projeto e corrigi-los 

(ITI, 2012). Alguns sistemas CAD genéricos também oferecem este recurso, como 

por exemplo, o software FormZ com a ferramenta Doctor Object Tools. 

Os fornecedores de equipamentos para prototipagem disponibilizam 

softwares para importar o arquivo de modelo CAD, que utilizam um ou variados tipos 

de padrão de extensão de arquivo como STL, VRML, PLY, 3DS, ZPR ou OBJ. Estes 

softwares oferecem comandos de edição simples, como a inversão de normais. 

Dependendo do caso, os sistemas de prototipagem podem oferecer softwares para 

verificar e editar a geometria do modelo, como por exemplo, o software ZEdit Pro da 

ZCorporation.  

Sendo assim, o software de cada fornecedor de impressora tridimensional, 

juntamente com os procedimentos preventivos descritos anteriormente, são os 

recursos adotados para o controle de qualidade do modelo CAD, para efeito do 

experimento realizado nesse trabalho de pesquisa. 
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7 MÉTODO DE INVESTIGAÇÃO 

 

A hipótese deste trabalho é de que o uso de diferentes tipos de sistemas 

CAD e de prototipagem rápida resulta em diferentes níveis de sucesso na 

transferência de informações entre os mesmos, devido ao grau de precisão de cada 

sistema. Apesar do variado grau de precisão, estes sistemas produzem modelos 

físicos digitais com a representação satisfatória em relação ao modelo virtual 

original, portanto sem necessidade de retrabalho. 

A verificação da hipótese acima apresentada será feita por meio de 

experimentos com modelos virtuais, elaborados em três diferentes tipos de sistemas 

CAD, para serem exportados e reproduzidos em dois diferentes tipos de sistemas de 

prototipagem rápida, conforme demonstra o quadro abaixo: 

 

Quadro 7 - Fases do método de investigação 
FASE FERRAMENTA DIGITAL ARQUITETO RESULTADO 

 
Fase 1 

(Modelagem no 
sistema CAD) 

Sistema CAD Específico: 
Revit Architecture 2012 
Sistemas CAD Genéricos: 
AutoCAD 2012 
FormZ 6.7.3 

 Definir Projeto  
 
 

 Verificar a qualidade do 
Modelo: União ou 
Fechamento das 
geometrias 

 Ajustes do Modelo: 
Quadrante (+) x, y, z 

 Modelar CAD A 
 Revit (rvt) 

 Modelar CAD B AutoCAD 
(dwg) 

 Modelar CAD C FormZ 
(fmz) 

 Projeto Conceitual: 
Etapa Inicial 

 
Modelo CAD A Revit (rvt) 

 Desenhos com Cotas: 
Plantas Baixas / Cortes / 
Fachadas 

 
Modelos CAD A/ B/ C 

 Vistas Axonométricas 
em (jpg) 

 
Modelos CAD A/ B/ C 

 Exportar em (STL) 

Especificações dos Equipamentos: 
Impressora 3DP ZCorp (Z) e 
Impressora FDM MakerBot (X) 

 Espessura mínima = 2 mm / 1 mm 

 Definição Escala = 1:100 / 1:200 

 Tamanho Máximo do modelo =  
203x203x254 mm 
100x100x150 mm 

 Formato: STL 

 
Fase 2 

(Planejamento) 

 
Software Impressora 3DP: 
ZPrint 7.10 (zbd) 
 
Software Impressora FDM: 
ReplicatorG 29 (gcode) 

Modelos CAD A/ B/ C 

 Importar em (STL) 

 Verificar a 
Interoperabilidade entre 
os sistemas 

 Configurações: 
Normais, escala, rotação, 
suporte, ponto de origem  

 Arquivos imp 3D (zbd) e 
(gcode) 

 Salvar Modelos CAD  
importados em (zbd) e 
(gcode):  
Modelo CAD AZ (zbd) 
Modelo CAD BZ (zbd) 
Modelo CAD CZ (zbd) 
Modelo CAD AX (gcode) 
Modelo CAD BX (gcode) 
Modelo CAD CX (gcode) 

 Salvar vistas em (prtscn) 

 
Fase 3 

(Fabricação no 
sistema de 

prototipagem rápida) 

 
Impressora 3DP ZCorp (Z) 
 
Impressora FDM MakerBot (X) 

 Abrir arquivos 
impressoras 3D 

 Observar o tempo de 
fabricação 

 Observar a quantidade 
de material utilizado 

 Ajustar impressoras 3D 

 Fabricação Protótipo 
Rápido: 
Protótipo Rápido (AZ) 
Protótipo Rápido (BZ) 
Protótipo Rápido (CZ) 
Protótipo Rápido (AX) 
Protótipo Rápido (BX) 
Protótipo Rápido (CX) 

 
Fase 4 

(Acabamento) 

 
Máquina Fotográfica Sony nex7 

 Limpeza 

 Lixamento ou Resinagem 
 

 Fotos dos Protótipos 
Rápidos: 
Imagens PR (AZ) 
Imagens PR (BZ) 
Imagens PR (CZ) 
Imagens PR (AX) 
Imagens PR (BX) 
Imagens PR (CX) 

Fonte: Autoria nossa 
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O método de investigação deste experimento adotou como base as fases 

gerais do processo de prototipagem rápida, por técnica de adição, a saber: CAD, 

Planejamento, Fabricação e Acabamento, conforme citado no capítulo 5 deste 

trabalho (Volpato et al., 2007 apud Pupo e Celani, 2011, p. 473).  

Os resultados obtidos em cada fase serão utilizados para verificar a hipótese 

em duas etapas distintas. A primeira etapa consiste em verificar se todos os 

elementos geométricos são exportados do sistema CAD para serem importados 

para o sistema de prototipagem rápida. A segunda etapa consiste em verificar se 

todos os elementos, importados pelo sistema de prototipagem rápida, produzem os 

modelos físicos digitais com a mesma representação geométrica formal do modelo 

CAD original. 

Na primeira etapa, cada arquivo dos três tipos de sistemas CAD é exportado 

no formato STL, para depois ser importado por cada um dos dois tipos de softwares 

de sistema de prototipagem rápida utilizados neste experimento. Nesse momento, é 

possível observar visualmente se todas as geometrias que compõem o modelo são 

importadas, integralmente, para dentro do ambiente gráfico do software do sistema 

de prototipagem. 

De maneira a registrar esse tipo de avaliação, as imagens dos resultados 

obtidos na Fase 1 são comparadas às imagens dos resultados obtidos na Fase 2, as 

quais consistem de vistas externas do modelo. As informações com as quantidades 

e os tipos de elementos geométricos que compõem o modelo são especificadas e 

associadas às imagens, como por exemplo: (01) um piso, (02) duas paredes, entre 

outros. 

A interoperabilidade, ou seja, a capacidade de transferência de dados entre 

os sistemas será avaliada em sentido único, que segue do sistema CAD para o 

sistema de prototipagem rápida, e não ao contrário. Quando houver necessidade de 

retrabalho na reconstrução da geometria do modelo, esta será feita no arquivo 

original do sistema CAD, para novamente ser exportado e depois importado no 

sistema de prototipagem. 

Na segunda etapa, os resultados obtidos na Fase 4 (acabamento) da 

experimentação permitem verificar a representação formal geométrica, em termos de 

precisão, em relação ao dimensionamento e à resolução da forma, comparados aos 

modelos CAD originais.  
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As medidas gerais são conferidas com base na largura, profundidade e 

altura (L x P x H) de cada elemento arquitetônico externo identificado, como por 

exemplo: parede externa, pilar externo, entre outros. As dimensões serão obtidas do 

modelo CAD, a partir de comandos específicos de cada software, conforme projeto 

no Apêndice A. Essas medidas serão registradas com as medidas obtidas 

diretamente do protótipo rápido, por meio do uso de escalímetro. 

Além das medidas gerais, o modelo é avaliado visualmente pelo aspecto 

formal, de maneira que a representação dos elementos geométricos ortogonais deve 

ser linear, constante e uniforme para aferir precisão. No caso das geometrias curvas 

e superfícies complexas, o grau de resolução é observado pela representação em 

maior ou menor número de faces em elementos planos, que por sua vez podem 

variar em seu tamanho. 

Uma curva com maior resolução geralmente representa, de forma menos 

perceptível, a divisão das faces da geometria. A superfície curva é dividida em 

maiores quantidades de faces, em tamanhos menores, gerando formatos de 

arquivos maiores. Assim, os tamanhos em bytes dos arquivos dos modelos CAD e 

os arquivos formato STL também serão comparados. 

As imagens dos resultados obtidos nas Fases 1, 2 e 4 serão registradas 

para efeito de comparação e avaliação, assim como as quantidades. Ainda, os tipos 

e as dimensões dos elementos geométricos que compõem cada modelo serão 

igualmente listados. 

As informações específicas são implementadas para o desenvolvimento de 

cada uma das fases: Fase 1 (modelagem no sistema CAD), Fase 2 (Planejamento), 

Fase 3 (Fabricação no sistema de prototipagem rápida) e Fase 4 (Acabamento), 

baseadas no material teórico desta pesquisa, e detalhadas no item Descrição do 

Método de Investigação. A seguir serão identificados os sistemas CAD e os 

sistemas de prototipagem rápida que serão utilizados no experimento. 

 

 

7.1 Equipamentos e softwares de sistemas CAD 

 

Para obtenção do modelo CAD, de maneira suficientemente abrangente, 

foram utilizados três tipos diferentes de software de sistemas CAD, que oferecem 

ferramentas apropriadas para modelagem e documentação, desde a etapa inicial de 
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projeto. Os dois softwares de sistema CAD genérico utilizados serão o AutoCAD 

2012 (Autodesk) e o FormZ 6.7.3 (AutoDesSys), e um software de sistema CAD 

específico (BIM) será é o Revit Architecture 2012 (Autodesk), os quais são descritos 

a seguir: 

a) o software AutoCAD 2012 da empresa Autodesk é utilizado por arquitetos, 

engenheiros e projetistas para elaborar e documentar os projetos. O sistema oferece 

ferramentas bidimensionais e tridimensionais como modelagem de superfícies, 

malhas e sólidos, ferramentas de documentação de modelos, recursos de desenho 

paramétrico, entre outras. O seu arquivo nativo é o formato DWG (AUTODESK, 

2012a). 

Pesquisas publicadas em 2009 concluem a opção do AutoCAD como o 

software com o maior índice de apropriação, quanto ao uso entre os arquitetos. Em 

resultado de pesquisa nacional, realizada em 2009 nos escritórios paulistanos, o 

AutoCAD impõe-se com a maioria das indicações (52,94%), na etapa inicial de 

concepção do produto, enquanto que o software Revit Architecture, mesmo com 

porcentagem de apenas 11,76%, é o sistema BIM mais utilizado entre os 

profissionais de arquitetura. (NARDELLI; VICENT, 2009). 

b) o FormZ 6.7.3 da empresa AutoDesSys é um software de modelagem 

tridimensional que combina superfícies e sólidos, com extenso conjunto de formas 

bidimensionais e tridimensionais. Oferece recursos de animação e módulo para 

renderização, com efeito de iluminação baseada em radiosidade. O sistema 

responde às necessidades das fases iniciais de concepção de projeto, até as fases 

finais de modelos tridimensionais com detalhes complexos. Por ser um modelador 

de uso geral, é utilizado em diferentes áreas de projeto e o seu arquivo nativo é o 

formato FMZ (AUTODESSYS, 2012).  

c) o Revit Architecture 2012 é um sistema da Autodesk que utiliza a 

tecnologia BIM. As informações são armazenadas em um banco de dados central, 

associadas ao modelo tridimensional, e a documentação bidimensional é 

consequência da modelagem. Oferece recursos especializados como a 

parametrização para o projeto conceitual, análise, processamento e documentação 

arquitetônica (AUTODESK, 2012b; JUSTI, 2010). 

No caso dos sistemas BIM, pesquisa realizada pela McGraw-Hill 

Construction em 2008 revela que o software Revit Architecture também é o mais 

utilizado pelos profissionais norte-americanos da Arquitetura, Engenharia e 
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Construção, com porcentagem maior (67%) que a do mercado brasileiro. Os 

argumentos mencionados para a escolha desse sistema BIM são a maior 

disponibilidade para formação de profissionais e menores custos em relação aos 

outros sistemas (CEFRIO, 2011, p. 34). 

O equipamento utilizado nesta pesquisa, para trabalhar com os softwares de 

sistemas CAD, é assim descrito: notebook Sony Vaio, processador Intel (R) Core 

(TM) i7, Q720, 1.60 GHz, memória RAM 6GB DDR3, monitor flat panel LCD 

(1920x1080 60 Hz) Full HD, placa de vídeo NVIDIA GeForce GT 330M e sistema 

operacional Windows 7 Home Premium 64 bits. 

 

 

7.2 Equipamentos e softwares de sistemas de prototipagem rápida 

 

Nesta pesquisa, um dos sistemas definidos para prototipagem rápida foi a 

tridimensional ZPrinter 310 plus, existente no Laboratório de Fabricação Digital e 

Customização em Massa (LFDC), da Pós-graduação do Curso de Arquitetura e 

Urbanismo da Universidade de Brasília. Esta impressora, fabricada pela 

ZCorporation, utiliza o método de adição de camadas, com material em pó "zp 150" 

e aglutinante "zb60 clear". Para o pós-processamento, o material comumente 

utilizado é a resina "Z-Bond 101". 

Como visto anteriormente no capítulo 5, esse equipamento também é 

apropriado para prototipagem de modelos CAD na etapa inicial de projeto, e permite 

a produção de modelo prototipado a nível experimental, atendendo aos requisitos 

necessários para a elaboração do experimento deste trabalho. 

Este mesmo equipamento pode ser encontrado em importantes laboratórios, 

nacionais e estrangeiros, que trabalham com as questões vinculadas à tecnologia de 

fabricação digital aplicada à arquitetura, como o Laboratório de Prototipagem e 

Automação para Arquitetura e Construção (LAPAC) da Universidade Estadual de 

Campinas (UNICAMP), no Brasil, e no exterior o laboratório de prototipagem digital 

da escola Architecture Association (AA) na Inglaterra.   

No portal do LAPAC (http://www.fec.unicamp.br/~lapac/) - opção de 

equipamentos, o usuário pode obter, entre outras informações, um roteiro de como 

utilizar essa impressora tridimensional. O site do Laboratório da AA School of 

Architecture (http://www.digitalfabrication.net/) também oferece informações sobre o 

http://www.fec.unicamp.br/~lapac/
http://www.digitalfabrication.net/
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procedimento adequado para impressão tridimensional do modelo digital, para a 

mesma impressora. 

A impressora ZPrinter 310 possui o software ZPrint, fornecido com o 

equipamento para viabilizar a impressão. O software ZPrint oferece recursos para o 

usuário preparar o arquivo CAD para a impressão no sistema tridimensional ZPrinter. 

Dentre os principais recursos oferecidos, destacam-se a possibilidade de importação 

e de exportação de arquivos STL, melhores funções de visualização e comandos de 

edição com escalonamento e rotação do objeto (ZCORP, 2011). 

A impressora tridimensional da ZCorporation apresenta as seguintes 

características, listadas no quadro abaixo: 

 

Quadro 8 - Especificações técnicas da impressora ZPrinter 310 plus monocromática 

MODELO ZPRINTER 310 PLUS MONOCROMÁTICA 

Resolução: 300 x 450 dpi  

Velocidade de Construção na vertical: 25 mm/ hour 
Tamanho Construção: 203 x 254 x 203 mm 
Opções de Material: Composto de Alto Desempenho, Fundição Direta, 

Elastomérico 
Espessura da Camada: 0,089 a 0,203 mm 
Número de Jato: 304 
Formatos de Arquivos para Impressão: STL, VRML, PLY, 3DS, ZPR 
Dimensões do Equipamento: 74 x 86 x 109 cm 
Peso do Equipamento: 115 kg 
Requisitos de Energia: 90-110V, 5.3A; 100-120V, 4.3A; 200-240V, 2.4A 
Sistemas Operacionais compatíveis: Windows®  
Conformidade e Regulamentação: CE, CSA 
Preço: U$ 32.000,00 + impostos (junho 2012 = ZPrinter 150) 

Softwares: ZPrint e ZEdit Pro 
Fonte: ZCorp, 2011 
  
 

A outra opção de equipamento para execução do modelo digital, conhecida 

como impressora tridimensional desktop, utiliza o método de adição de camadas de 

material sólido - plástico ABS e PLA, pelo processo de modelagem por deposição e 

fusão (FDM). O baixo custo do equipamento e do material, em relação às 

impressoras de alta resolução, atende a um mercado de escritórios médios, 

pequenos e Home Office, que até pouco tempo, por limitação financeira, 

consideravam apenas a terceirização de serviços de prototipagem rápida. Essas 

impressoras possuem, ainda, a condição de serem autocopiadoras, ou seja, podem 

reproduzir as peças para montagem de outras impressoras iguais à original. 

Dentre outras opções no mercado, pode ser citada a RepRap 1.0 "Darwin", 

que é uma impressora tridimensional desktop livre, Licença Pública Geral GNU, 
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autocopiadora (REPRAP, 2012). Há também a impressora RapMan 3.1 Universal 

(TURBOCAD, 2012) e a impressora Thing-O-Matic (MAKERBOT, 2012) - além das 

mesmas características de funcionamento e material, possuem custos similares aos 

da RepRap 1.0 "Darwin". 

Mesmo apresentando desvantagens de baixa resolução e tamanho pequeno 

para impressão, a impressora tridimensional desktop é indicada para protótipos 

experimentais, na etapa inicial de projeto, de forma que atende aos requisitos 

estabelecidos para a elaboração do experimento desse trabalho, como a escala 

reduzida, o menor tempo de fabricação, o menor custo e menor precisão. 

A segunda impressora utilizada no experimento, nesta Dissertação, foi a 

impressora tridimensional desktop da empresa MakerBot, que apresenta as 

seguintes características: 

 

Quadro 9 - Especificações técnicas da impressora Thing-O-Matic 

MODELO THING-O-MATIC 
  

Resolução: 2,5 microns no eixo Z e 11 microns nos eixos X, Y 

Velocidade de Construção na vertical: 40 mm/ min 
Tamanho Construção: 100 x 100 x 150 mm  
Opções de Material: Plástico ABS e PLA (Bio material a base de milho) 
Diâmetro do Material: 1,75 mm 

Espessura da Camada: 2 a 3 mm 
Taxa de Fluxo: 24 cc/ h 
Formatos de Arquivos para Impressão: STL, GCode, OBJ 
Dimensões do Equipamento: 320 x 467 x 381 mm 
Peso do Equipamento: 14,51 kg 
Requisitos de Energia: 100-240V, 50/60 Hz, 4.0 A 
Sistemas Operacionais compatíveis: Linux, Windows®  e OSX 
Preço: U$ 1,299,00 (março 2011) 

Softwares: ReplicatorG 
Fonte: Makerbot, 2012 

 
 

7.3 Descrição do método de investigação 

 

Para verificar a capacidade de interoperabilidade entre os sistemas CAD e 

os de prototipagem rápida, no início do processo de projetação arquitetônica, e 

avaliar a fidedignidade do aspecto formal do modelo físico produzido a partir do 

modelo CAD original, serão realizados seis tipos de experimentos, desenvolvidos em 

quatro fases descritas a seguir: 

 

http://www.reprap.org/wiki/main_page
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7.3.1 Fase 1 (Modelagem no sistema CAD) 

 

Na Fase 1 (modelagem no sistema CAD) o projeto arquitetônico será 

definido utilizando o sistema CAD específico (BIM) - o software REVIT 2012 

(Autodesk), de maneira que se possa obter o primeiro modelo CAD, nomeado como 

modelo CAD (A). O projeto arquitetônico a ser tratado é de uma edificação de 

pequeno porte, com área máxima de 250 m2, na etapa inicial de concepção de 

projeto, momento de definição do conceito formal da edificação. O partido do projeto 

deverá apresentar uma volumetria compondo formas retilíneas mais simples e 

formas curvas livres mais complexas, de maneira a justificar o uso do sistema de 

prototipagem rápida, e ao mesmo tempo apresentar fácil entendimento para a 

reprodução desse projeto em diferentes sistemas CAD. O programa de 

necessidades foi definido para elaborar um projeto de escritório de arquitetura, para 

5 (cinco) pessoas, contendo um banheiro, uma copa e uma sala de reunião. 

 

 

Figura 34 - Local do terreno do experimento (@-15.841028,-47.897456) 
Fonte: Google, 2012 
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O terreno existente e utilizado neste projeto possui área total estimada de 

820,00 m2, em formato trapezoidal com largura mínima de 18 metros e 42 metros de 

comprimento mínimo perpendicular ao lago. Fica localizado na cabeceira sudeste da 

ponte Presidente Médici, no Lago Sul na cidade de Brasília-DF, conforme área 

delimitada em hachura azul, na imagem da Figura 34. 

O enfoque deste experimento é avaliar informações do modelo na etapa 

inicial do projeto, para uma melhor delimitação do grau de detalhamento a ser 

considerado na modelagem. Foram considerados os aspectos formais de maquetes 

preliminares, etapa anterior às definições formais da maquete de desenvolvimento e 

de apresentação. 

As maquetes preliminares constituem a fase inicial das maquetes de estudo 

de projeto. De uma maneira geral, não são elaboradas com a preocupação de 

precisão e são produzidas em escalas relativamente reduzidas, abaixo de 1:500 no 

caso de edificações pequenas (inferiores a 500 m2) e, para edificações acima desta 

metragem, a escala pode variar para maior que 1:500. A preocupação é oferecer um 

recurso para visualização do espaço e da volumetria. Podem ser utilizadas para 

explorar alinhamentos, proporções e definições espaciais (MILLS, 2007, p. 22-26). 

No caso das maquetes de desenvolvimento, as decisões iniciais já foram 

tomadas, e outros tipos de análises e definições de detalhes de esquadrias, 

revestimentos, estrutura e cobertura devem ser considerados, enquanto que as 

maquetes de apresentação representam um projeto finalizado. Essas etapas não 

estão sendo consideradas para a elaboração deste experimento, pois são 

mencionadas no item - Desdobramentos Futuros, desta pesquisa. 

No sentido de efetuar o controle de qualidade do modelo CAD, o fechamento 

dos objetos deverá ser verificado por meio de comandos para unir as partes de um 

mesmo elemento. Na execução da modelagem dos elementos geométricos 

complexos, com dupla curvatura, será adotada a resolução padrão (default) do 

sistema CAD utilizado. 

A modelagem dos elementos do projeto deve seguir os limites especificados 

pelos fabricantes dos equipamentos, com especial importância para aqueles que 

definem espessuras mínimas. A escala poderá ser de 1:200 a 1:100, o que na etapa 

inicial oferece informações adequadas para a avaliação formal do projeto.  

O modelo deverá ser pensado como elemento inteiro, produzido de uma 

única vez, sem a necessidade de montagem de partes separadas. Por isto deverá 
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obedecer ao limite do tamanho da área disponível para a construção, e sua unidade 

adotada será o metro. 

O modelo não deverá ser pensado como um elemento todo maciço. No 

sentido de produzir um protótipo com aspecto o mais próximo ao produto final 

construído, o arquiteto deverá modelar a parte interna do projeto, contendo os 

elementos estruturais e de vedação, como por exemplo: paredes, coberturas, 

pilares, vigas e lajes. 

Os elementos que representam a transparência, como no caso dos vidros, 

não deverão ser modelados. Da mesma forma, os equipamentos utilizados para 

efeito de humanização, como mobiliário, vegetação, pessoas e terreno não deverão 

ser considerados no modelo para prototipagem. 

No caso da impressora Zprinter, que utiliza material em pó, há necessidade 

de se considerar uma abertura no invólucro para retirada do material interno. 

Conforme a definição do projeto, a ausência da representação dos vidros também 

poderá resolver essa questão. 

O modelo inteiro deverá estar localizado preferencialmente no quadrante 

positivo, coordenadas absolutas (X,Y,Z), de maneira a reduzir possíveis erros 

existentes no momento de tradução das normais, da geometria do modelo CAD para 

o formato STL. 

No sentido de melhorar as condições visuais de comparação entre o modelo 

virtual e o modelo prototipado, serão definidos os mesmos aspectos de acabamento: 

o material especificado para o modelo CAD deverá ser na cor branca opaca, e o 

fundo da imagem deverá ser na cor preta RGB (0,0,0).  

Após o término da definição da volumetria do projeto - no caso o modelo 

CAD A, construído no sistema CAD específico Revit (Autodesk) - será possível 

extrair os desenhos de plantas, cortes e fachadas com as respectivas medidas, para 

que se possa construir o mesmo projeto com a geometria original nos sistemas CAD 

genérico AutoCAD (Autodesk) e FormZ (AutoDesSys).  

A partir do modelo CAD A (Revit), também serão obtidas as imagens de 

diferentes pontos de vista, de cada vértice de duas fachadas, quatro perspectivas 

externas, uma com orientação nordeste, uma noroeste, uma sudeste e uma 

sudoeste. As imagens serão comparadas com as fotos das vistas equivalentes aos 

modelos prototipados digitalmente. 
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Por último, nesta Fase 1 (modelagem no sistema CAD), o arquivo do modelo 

CAD A (Revit) será exportado no formato STL padrão default binário. Importante 

ressaltar que, uma vez que a versão 2012 do Revit Architecture não possui 

originalmente o comando STLExport dentro do seu ambiente gráfico, é necessário 

que o usuário importe este comando na opção Add-Ins>External Tools. Entretanto, 

antes da importação deve-se baixar o Plug in STLExport do Revit 2012, que pode 

ser acessado livremente pelo site 

<http://sourceforge.net/projects/stlexporter/files/2012/>.   

No sistema CAD genérico, utilizando o software AutoCAD 2012 (Autodesk) e 

o software FormZ 6.7.3, serão construídos os modelos CAD B (AutoCAD) e CAD C 

(FormZ), um de cada vez, baseados nas informações do projeto, plantas, cortes e 

elevações dimensionadas, conforme definido anteriormente. 

A fim de garantir o controle de qualidade e a equidade entre os modelos, 

serão considerados os mesmos procedimentos anteriormente definidos para o 

modelo CAD A, com os respectivos ajustes para obtenção dos modelos CAD B 

(AutoCAD) e CAD C (FormZ). O mesmo material, com as mesmas vistas e imagens, 

deverá ser obtido para efeito de comparação entre os modelos CAD A (Revit), CAD 

B (AutoCAD) e CAD C (FormZ). Ainda, cada modelo será comparado com os seus 

respectivos protótipos. 

O término da Fase 1 (modelagem no sistema CAD) ocorrerá no momento 

em que os três arquivos de formato STL forem gerados, a partir de cada um dos 

arquivos de sistema CAD. 

 

 

7.3.2 Fase 2 (Planejamento) 

 

Na Fase 2 (planejamento) os arquivos STL gerados serão importados e 

avaliados um a um, pelo software de cada impressora tridimensional. Cada arquivo 

STL seguirá o mesmo procedimento após sua importação.  

Após importar o arquivo STL, no software da impressora tridimensional, a 

geometria de cada modelo de arquivo deverá ser representada integralmente dentro 

do ambiente gráfico do software da impressora tridimensional.  

A interoperabilidade entre os sistemas será registrada numa primeira etapa, 

por meio de uma imagem do modelo importado, em pontos de vista equivalentes 

http://sourceforge.net/projects/stlexporter/files/2012/
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àqueles obtidos no modelo CAD, utilizando a tecla print screen, PrtSc do teclado. 

Será observado se todos os elementos geométricos do modelo CAD estão sendo 

representados na imagem do ambiente gráfico, do software do equipamento de 

impressão tridimensional. 

Caso ocorram falhas na visualização do modelo, como a inversão das 

normais das faces da geometria, o único procedimento permitido será o uso de 

comando para inversão das normais, fornecido pelo software da impressora 

tridimensional, para não comprometer a geometria do modelo. Alguns softwares 

disponibilizam a opção de correção automática (ou manual), no momento da 

importação do arquivo. 

No caso de haver outros problemas de representação geométrica do 

modelo, o problema deverá ser registrado e a correção deverá ser efetuada no 

respectivo software de sistema CAD, de maneira a refazer todo o processo descrito 

na Fase 1 (modelagem no sistema CAD). 

Após a confirmação de que a geometria do modelo foi importada 

corretamente, ou seja, a interoperabilidade tenha ocorrido integralmente, os itens 

para impressão deverão ser configurados. Os itens a serem configurados deverão 

encontrar-se na mesma escala do modelo, observando-se o seu ponto de origem em 

relação à base de impressão, a necessidade de rotação, orientação e suporte, para 

que o modelo possa ser fabricado sem danos, durante a sobreposição de camadas, 

e no momento da retirada do mesmo da base de impressão. 

Por último, na Fase 2 (planejamento), o arquivo importado e avaliado será 

salvo no formato padrão do equipamento de impressão tridimensional. Serão 

gerados seis arquivos no total, sendo três a partir da impressora Zprinter, os quais 

são ZBD (AZ), (BZ) e (CZ), e outros três arquivos a partir da impressora Thing-O-

Matic, sob a denominação GCode (AX), (BX) e (CX). 

 

 

7.3.3 Fase 3 (Fabricação no sistema de prototipagem rápida) 

 

Na Fase 3 (fabricação), os arquivos no formato padrão de cada impressora 

tridimensional serão abertos, um de cada vez, no software do respectivo 

equipamento, e será acionado o comando para verificar o tempo gasto estimado e a 

quantidade de material necessário para produzir cada protótipo.  
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No sentido de fabricar os modelos, o usuário deverá seguir as instruções 

conforme manual do equipamento do fabricante. Deverá ser produzido um total de 

seis protótipos rápidos: (AZ), (BZ) e (CZ) da impressora da ZCorporation, e (AX), 

(BX) e (CX) da impressora da MakerBot. 

 

 

7.3.4 Fase 4 (Acabamento) 

 

Na Fase 4 (acabamento) serão executados os acabamentos de limpeza e de 

resinagem nos protótipos rápidos (AZ), (BZ) e (CZ), fabricados pela impressora da 

ZCorporation. Os protótipos rápidos (AX), (BX) e (CX), fabricados pela impressora 

Thing-O-Matic, serão lixados no caso de existência de excesso de material. Os 

protótipos rápidos acabados serão fotografados, considerando-se os mesmos 

pontos de vista definidos anteriormente nas imagens dos modelos CAD (A), (B) e 

(C). 

As imagens dos modelos CAD serão comparadas com as imagens das 

fotos, com as vistas equivalentes às dos protótipos rápidos. Desta maneira, será 

possível verificar a segunda etapa sobre a interoperabilidade entre os sistemas, 

como a similaridade da aparência geométrica, assim como a precisão das medidas 

dos elementos entre o modelo CAD e o respectivo protótipo rápido.  
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8 EXPERIMENTAÇÃO 

 

8.1 Fase 1 (Modelagem no sistema CAD) 

 

O projeto foi definido a partir do programa de necessidades e da localização 

do terreno, conforme apresentados anteriormente no item 7.3.1. A ideia do projeto 

foi concebida diretamente dentro do ambiente gráfico do software CAD específico 

Revit Architecture 2012. Este software foi escolhido para conceber o projeto por 

oferecer mais opções de recursos automatizados para representação dos desenhos 

bidimensionais, necessários para reproduzir os outros dois modelos CAD. 

A imagem em formato padrão JPG do terreno foi obtida no site Google Maps 

e importada para dentro do software, opção Floor Plans>Site. As curvas de níveis 

foram construídas com o comando Massing & Site>Toposurface, em declive na 

direção do lago. 

O partido do projeto do escritório de arquitetura teve como base um 

quadrado de 10x10 m, comando Home>Model Line>Rectangle, e um mezanino 

ocupando metade do pavimento superior, encostado na fachada sul, comando 

Home>Line. A entrada principal ficou localizada na fachada norte, que recebeu 

chanfros de 45 graus nas duas laterais, com a intenção de aumentar a visibilidade 

interna para a ponte e para o lado leste do Lago de Brasília. A fachada oeste 

recebeu paredes sem aberturas e acomodou o banheiro e a copa. A fachada leste, 

também sem aberturas, sustenta a escada do térreo ao mezanino.  

A proposta de volumetria foi trabalhar o piso e a cobertura como elementos 

contínuos, de maneira a oferecer um espaço mais reservado na fachada sul, 

definindo um ambiente de jardim interno. Ainda, estabelecemos uma proteção maior 

nas fachadas nordeste e noroeste, com o prolongamento da cobertura em balanço. 

A cobertura e piso avançam nas fachadas laterais oeste e leste, protegendo as 

paredes e possibilitando circulação de pedestre a partir do nível mais alto do terreno. 

A definição das espessuras de paredes, vigas, pilares e laje foi baseada nos 

cálculos de espessura mínima na escala 1:100 - na impressora 3D Zprinter igual a 2 

mm, ou seja, para dimensão mínima no projeto igual a 20 cm. No caso da 

impressora 3D Thing-O-Matic, a escala mínima para efeito de cálculo foi de 1:200, 
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com espessura limite igual a 1 mm, o que equivale à mesma espessura mínima de 

20 cm, igual à impressora anterior. 

Os mobiliários da biblioteca default do software Revit foram utilizados para 

auxiliar na definição dos espaços internos. Na entrada do escritório, o espaço para 

espera e recepção encontra-se localizado em área com pé-direito duplo. O espaço 

sob o mezanino abriga as estações de trabalho para quatro postos, bem como o 

banheiro e a copa (na lateral oeste do espaço). A porção superior do mezanino foi 

destinada à sala de reunião, comportando uma mesa para oito pessoas. A área total 

estimada, referente ao atelier de projeto, é de 222 m2, sendo área do térreo 172 m2 e 

mezanino 50 m2. 

Nesta primeira etapa de concepção de projeto foi definida a volumetria geral 

da forma do projeto, sem detalhes específicos como as esquadrias das portas e 

janelas. O modelo com a definição do projeto foi salvo com o nome "modelo CAD A - 

Definição", no formato rvt, para servir de base para o arquivo do Modelo CAD A, 

modelado no software Revit Architecture 2012. 

 

 

8.1.1 Modelo CAD A (Revit) 

 

A partir do modelo CAD A - Definição.rvt - foi obtido o arquivo modelo CAD A 

(Revit), contendo apenas os elementos geométricos necessários para serem 

fabricados na prototipagem. Os equipamentos utilizados para efeito de 

humanização, como por exemplo mobiliário, vegetação, pessoas e terreno foram 

excluídos do arquivo Modelo CAD A (Revit), por meio do comando>Delete. 

O projeto foi modelado a partir de algumas configurações dentro do 

ambiente gráfico do software, como a unidade de desenho no comando: 

Manage>Project Units> Lenght>Units>Meters.  

As alturas de pé-direito foram definidas em: Elevation (Building 

Elevation)>North com valor igual a (2.7).  

A partir do Level 2 com o comando: Modify / Levels>Copy, foi criado o nível 

para construção do mezanino, com valor de pé-direito igual a (2.7).  

As paredes e os pilares foram definidos no comando: 

Home>Wall>Basic Wall Generic - 200mm  

Edit Type>Duplicate>Name>Wall>material 1  
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Material>Wall>material 1 

Appearance>Color>RGB 255 255 255 

Image Fade>100 

Glossiness>50 

Highlights>Non-Metalic 

Self Illumination selecionada.  

As vigas foram definidas no comando: 

Structure>Beam>M_Concrete-Retangular 

Beam>Dimensions>b 0,20 e h 0,40 

Beam Material>Wall>material 1.  

Todos os elementos geométricos tiveram o material selecionado em: 

Wall>material 1.  

A base do modelo foi construída com o comando: 

Home>Floor>Structure>Thichness>0.80.  

A laje do mezanino foi definida com o mesmo comando e espessura 

diferente: Home>Floor>Structure>Thichness>0.30. 

Na construção da escada foi utilizado o comando: 

Home>Stair>Run 

Monolithic Stairs  

Minimum Tread Depth>0,28 

Tread Thickness>0,05 

Maximum Riser Hight>0,175 

Riser Thickness 0,0125 

as demais especificações com o valor Default. 

O volume do invólucro, sem a parte da frente da cobertura em balanço, foi 

construído com o comando: 

Home>Component>Model In place>Generic Models 

Void Extrusion 

A parte do volume em curva da cobertura em balanço foi construída 

posteriormente com o comando: 

Massing & Site>In-Place Mass. 

O elemento em dupla curvatura em balanço não pode ser transformado pelo 

comando de edição Massing & Site>Roof, para receber as características de 

telhado. 
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A geometria ficou definida como elemento geométrico genérico. O comando 

não permitiu a pré-definição nem a edição para o aumento de resolução da 

superfície, e também não permitiu que esse elemento fosse unido com o restante do 

elemento que forma a cobertura e piso, pelo uso do comando: 

Modify>Join 

Foram definidas quatro vistas diferentes, duas perspectivas isométricas 

externas com orientação sudoeste e sudeste, e duas axonométricas com orientação 

nordeste e noroeste, com ponto de vista na altura do observador. No sentido de 

melhor visualizar a parte interna do modelo, com o auxílio do botão central do mouse 

associado à tecla shift, foi utilizado o comando: 

View>3D View  

Após a visualização de cada uma das vistas o comando: 

View>Render  

Quality>Settings>Best 

Lighting>Scheme>Exterior>Sun only 

Background> Style>Color> Black 

as demais opções em default. 

Depois de processada a imagem foi exportada com os respectivos nomes, 

Sudoeste A, Sudeste A, Nordeste A e Noroeste A, em formato padrão JPG, com o 

comando: 

Image>Export  

A partir do modelo CAD A foi gerado o arquivo formato STL, com o nome 

Modelo CAD A.stl, utilizando a opção do comando: 

Add-Ins>External Tools>STLExport>Binary>Save 

 

 

8.1.2 Modelo CAD B (AutoCAD) 

 

O modelo CAD B foi reproduzido no software AutoCAD 2012, conforme as 

especificações dos desenhos gerados no modelo CAD A, planta baixa térreo, planta 

baixa mezanino, planta de cobertura, corte AA, corte BB, elevação norte, elevação 

sul, elevação leste e elevação oeste (Apêndice A). O arquivo foi salvo com o nome 

Modelo CAD B, formato de arquivo padrão DWG, utilizando o comando: 

File>Save 
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As configurações gerais no ambiente gráfico do software foram definidas 

para unidade de desenho: 

Format>Units>Meters 

Linewheight>default 

Layer>0 

Color>White 

Linetype>Continuous 

O modelo foi construído no quadrante positivo das coordenadas absolutas 

em X,Y,Z. O material especificado para todo o modelo foi nomeado como parede 

branca por meio dos comandos: 

Render>Materials Browser>Appearence  

Color>RGB 255 255 255 

Image Fade>100 

Glossiness>50 

Highlights>Non-Metallic 

Self Illumination selecionada 

A construção da geometria do modelo CAD B (AutoCAD) envolveu 

basicamente a utilização dos comandos: 

Pline 

Pedit>Close (para fechamento dos elementos de superfícies planas) 

Draw>Modeling>Extrude (para completar o volume de cada parte da representação 

da base, pilares, vigas, paredes, escada, laje do mezanino e do invólucro formado 

pelo piso e cobertura). 

As aberturas na superfície do invólucro foram subtraídas com o comando: 

Modify>Solid Editing>Subtract 

A parte da cobertura em balanço com dupla curvatura foi obtida utilizando o 

comando: 

Draw>Modeling>Loft (que uniu o perfil retangular da cobertura com o outro perfil 

definido com os comandos): 

Arc (três pontos) 

Pline  

Pedit>Close 

Depois da modelagem de todos os elementos, o comando: 
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Modify>Solid Editing>Union foi utilizado para unir as duas partes do invólucro da 

cobertura, formando um elemento único. O mesmo foi feito para unir as paredes, as 

vigas com os pilares, a laje do mezanino e os degraus da escada. 

Na configuração para o tratamento de imagem: 

View>Visual Styles>Realistic 

View>Render Environment  

Color>0,0,0 (preto)  

View>Render>Advaced Render Settings  

Presentation 

Output size>1024 x 768 

Apply materials>0n 

Force 2-sided>On 

Shadow map>Off  

De maneira a obter as imagens desejadas, duas perspectivas isométricas 

externas foram definidas com orientação sudoeste e sudeste, por meio da utilização 

do comando: 

View>3D Views>SW Isometric 

View>3D Views>SE Isometric  

Foram criadas duas perspectivas axonométricas com orientação nordeste e 

noroeste, por meio do comando View>3D Views  

Após a visualização de cada uma das vistas, com ponto de vista na altura do 

observador, foram obtidas as vistas com os respectivos nomes Sudoeste B, Sudeste 

B, Nordeste B e Noroeste B, em formato padrão JPG, com o comando: 

View>Render>Render  

File>Save  

Quality>Best 

A partir do modelo CAD B, para obter o arquivo Modelo CAD B.stl, foi 

acionado o comando: 

File>Export  

Files of type> Lithography (*.stl) 
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8.1.3 Modelo CAD C (FormZ) 

 

O modelo CAD C, formato de arquivo padrão FMZ, foi reproduzido no 

software FormZ 6.7.3, conforme as especificações dos desenhos gerados no modelo 

CAD A (Apêndice A) utilizando o comando: 

File>Save 

As configurações gerais no ambiente gráfico do software foram definidas 

para unidade de desenho: 

Options>Working Units>Meters 

O modelo foi construído no quadrante positivo das coordenadas absolutas 

em X,Y,Z. O material especificado para todo o modelo foi criado em: 

Surface Styles>Parede Branca 

com as especificações para cor 255,255,255 

Options>Reflection>Diffuse Reflection>100%  

Options>Reflection>Diffuse Reflection>Glow>20% 

No tratamento de imagem foi retirado o efeito de sombreamento com o 

comando: 

Display Options>Render Zone Options>Shading>shading shadows desmarcado 

Display Options>Render Zone Options>Scene>Backgraound>0,0,0 

Na construção da geometria do modelo CAD C foram utilizados 

basicamente, para construir as lajes e depois para construir as paredes os 

comandos: 

3D Extrusion  

3D Enclosure 

Boolean Split 

Difference 

Na modelagem da cobertura foram utilizados, para construir as curvas em 

balanço e a superfície maior, os comandos: 

3D Enclosure 

Difference 

Nurbz>By Boundary Curves 

3D Extrusion>0,40 

Union 
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As perspectivas isométricas foram visualizadas, para vista com orientação 

sudeste, sudoeste, noroeste e nordeste nesta sequência, com os comandos: 

View>z=45º e x=45º  

View>Custom View Angles>z=-45º e x=45º 

View>Custom View Angles>z=-135º e x=85º 

View>Custom View Angles>z=135º e x=85º 

Após a visualização de cada uma das vistas o comando: 

Display>Render Zone  

File>Export Image>formato JPG  

com os respectivos nomes, Sudoeste C, Sudeste C, Nordeste C e Noroeste C. 

A partir do modelo CAD C foi acionado, para obter o arquivo Modelo CAD 

C.stl, o comando: 

File>Export>STL 

O software FormZ apresentou na tela um aviso detectando erro no arquivo 

para exportar no formato STL e sugeriu para encontrar e consertar possíveis erros a 

utilização do comando: 

Object Doctor Tools 

Object Doctor>Tools Options>General All>Facetted All>Smooth All  

Action>Fix if possible  

Display results>selecionado  

Facetted>Collinear Segments>8 foram corrigidos 

Dessa forma foi possível gerar, a partir do modelo C, o arquivo padrão STL 

com sucesso, sem retrabalho de modelagem. 

 

 

8.2 Fase 2 (Planejamento) 

 

Na segunda fase do experimento foi possível obter as imagens necessárias 

para testar a primeira etapa de verificação da hipótese desta pesquisa. A verificação 

da ocorrência de interoperabilidade completa entre os sistemas envolvidos consiste 

em que todas as informações geométricas, necessárias para representar o modelo, 

sejam exportadas do sistema CAD e importadas pelo sistema de prototipagem 

rápida, de maneira a produzir um modelo físico seguindo as configurações pré-

definidas nesta etapa. 
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8.2.1 Software Zprint 

 

No software da impressora tridimensional da ZCorporation, o ZPrint 7.1, os 

arquivos com formato STL de cada um dos modelos A (Revit), B (AutoCAD) e C 

(FormZ) foram importados, um de cada vez, e seguiram a mesma sequência de 

configuração para fabricação do protótipo, pelo comando: 

 File>Open>STL 

No momento em que o arquivo STL é aberto automaticamente, surge a 

opção para definir a Unidade do modelo e não acrescentar suporte para apoio do 

modelo: 

Millimeters>Next 

Exit 

Para ajustar a visualização do modelo foram utilizados os comandos: 

3D Views>Zoom to Fit 

3D Views>Display Build Box>desmarcar 

3D Views>Backgraound Colors>Choose from Palettes>Black 

As vistas foram ajustadas pelo botão central do mouse, com pontos de vista 

similares àqueles definidos nas vistas dos modelos CAD. Cada imagem foi obtida 

por meio da tecla print screen do teclado e colada no quadro comparação da Fase 1 

com a Fase 2, para edição do tamanho. Cada modelo importado teve sua geometria 

observada, de maneira que se pode verificar se todos os elementos foram 

importados. 

Foi possível observar que todos os elementos geométricos que formam cada 

modelo A, B e C foram importados integralmente no software do sistema de 

prototipagem da impressora Zprinter, não havendo necessidade de retrabalho do 

modelo. A partir dessa confirmação o arquivo pode ser preparado para a fase 

seguinte, fabricação. 

Foi utilizado para definição da escala em 1:100 o comando : 

Transform>Scale> Fit to X=120 mm 

Para posicionar o modelo na base da impressora tridimensional foi utilizado 

o comando: 

Transform>Justify>Center>Front>Bottom 

Finalmente as configurações de cada modelo importado foram salvas no 

formato ZBD com o comando: 
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File>Save 

 

 

8.2.2 Software ReplicatorG 

 

No software da impressora tridimensional da Thing-O-Matic, o ReplicatorG 

29, os arquivos com formato STL de cada um dos modelos A, B e C foram 

importados pelo comando: 

File>Open>STL 

O software não oferece recursos para configuração da imagem com o 

modelo na cor branca e fundo totalmente preto. A escala foi definida em 1:200, pela 

limitação do tamanho da base para impressão, no comando: 

Scale Object>5>Scale 

As vistas foram ajustadas pelo botão central do mouse, com pontos de vista 

similares àqueles definidos nas vistas dos modelos CAD. No intuito de obter cada 

imagem foi utilizada a tecla print screen do teclado e colada no quadro comparação 

da Fase 1 com a Fase 2. Cada modelo importado teve sua geometria observada, de 

maneira que se pode verificar se todos os elementos foram importados. 

Foi possível observar que todos os elementos geométricos que formam cada 

modelo A, B e C foram importados integralmente no software do sistema de 

prototipagem da impressora Thing-O-Matic, não havendo necessidade de retrabalho 

do modelo. A partir dessa confirmação o arquivo pode ser preparado para a fase 

seguinte, a fabricação. 

Após a geração das imagens, o modelo foi rotacionado na plataforma de 

construção, considerando as condições do tipo de processo de adição de material, 

com o comando: 

Rotate>Y - 

Move>Center>Put on plataform 

Por último aciona-se o comando: 

Generate GCode 

Use Raft, Use Support Material>Exterior Support 

Use Print-O-Matic (Stepper Extruders Only) 

Object in Fill (%) = 100 

Layer Height (mm) = .31 
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Number of Shells = 1 

Feedrate9mm/s) = 40 

Cada arquivo de Modelo CAD A, B e C gerou um arquivo GCode com as 

configurações finais pré-definidas para a próxima fase. 

Nos quadros a seguir podem-se observar os resultados obtidos na Fase1 

(CAD), comparados com os resultados da Fase 2 (planejamento) do experimento. 

Na primeira coluna são apresentadas as imagens das vistas externas obtidas na 

Fase 1 CAD, as quantidades e os tipos de elementos geométricos. Na segunda 

coluna, as imagens obtidas com as vistas equivalentes do modelo CAD, importado 

pelo software da impressora tridimensional, as quantidades e os tipos de elementos 

geométricos. A última coluna registra a verificação sobre as três maneiras que 

podem ocorrer a transferência das informações, do modelo CAD original para o 

software de prototipagem:  

a) geometrias integralmente importadas, quando todos os elementos de 

cada tipo de geometria do modelo são importados e representados integralmente; 

b) geometrias parcialmente importadas, quando parte ou alguns dos 

elementos de cada tipo de geometria do modelo são importados e representados 

integralmente; ou 

c) geometrias não importadas, quando nenhum dos elementos de cada tipo 

de geometria do modelo é importado e representado integralmente. 
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Quadro 10 - Comparação entre os resultados da Fase 1 e da Fase 2 (Modelo AZ) 

FASE 1 
Imagem Modelo CAD A (REVIT) 

FASE 2 
Imagem Modelo AZ (ZPRINT) 

 RESULTADOS 
FASE 1 x FASE 2 

 
 

 
 
 
Geometrias importadas 
integralmente 

  

 
 
 
Geometrias importadas 
integralmente 

  

 
 
 
 
Geometrias importadas 
integralmente 

  

 
 
 
 
Geometrias importadas 
integralmente 

QTD TIPO DE GEOMETRIA 
DO MODELO 

QTD TIPO DE GEOMETRIA 
DO MODELO 

 RESULTADOS 
FASE 1 x FASE 2 

01 Base 01 Base Geometria importada 
integralmente 

01 
 

Piso Externo com Elemento Vazado 01 Piso Externo com Elemento Vazado Geometrias importadas 
integralmente 

06 Vigas Frontais Externas  06 Vigas Frontais Externas Geometrias importadas 
integralmente 

02 Pilares Externos 02 Pilares Externos Geometrias importadas 
integralmente 

02 
02 

Paredes Laterais 
Paredes Fundos 

02 
02 

Paredes Laterais 
Paredes Fundos 

Geometrias importadas 
integralmente 

 
01 
01 

Cobertura Maior: 
Curva com Elemento Vazado e Plano 
Curva Menor 

 
01 
01 

Cobertura Maior: 
Curva com Elemento Vazado e Plano 
Curva Menor 

Geometrias importadas 
integralmente 

01 Cobertura em Balanço: 
Superfície Complexa  

01 Cobertura em Balanço: 
Superfície Complexa  

Geometria importada 
integralmente 

 
01 
01 
01 
04 
02 

Elementos internos: 
Escada 
Pilar 
Laje Mezanino 
Paredes Internas 
Vigas Fundos 

 
01 
01 
01 
04 
02 

Elementos internos: 
Escada 
Pilar 
Laje Mezanino 
Paredes Internas 
Vigas Fundos 

 
Geometrias importadas 
integralmente 

Fonte: Autoria nossa 
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Quadro 11 - Comparação entre os resultados da Fase 1 e da Fase 2 (Modelo BZ) 

FASE 1 
Imagem Modelo CAD B (AUTOCAD) 

FASE 2 
Imagem Modelo BZ (ZPRINT) 

 RESULTADOS 
FASE 1 x FASE 2 

  

 
 
 
Geometrias importadas 
integralmente 

  

 
 
 
Geometrias importadas 
integralmente 

  

 
 
 
 
Geometrias importadas 
integralmente 

 
 

 
 
 
 
Geometrias importadas 
integralmente 

QTD TIPO DE GEOMETRIA 
DO MODELO 

QTD TIPO DE GEOMETRIA 
DO MODELO 

 RESULTADOS 
FASE 1 x FASE 2 

01 Base 01 Base Geometria importada 
integralmente 

01 
 

Piso Externo com Elemento Vazado 01 Piso Externo com Elemento Vazado Geometrias importadas 
integralmente 

06 Vigas Frontais Externas  06 Vigas Frontais Externas Geometrias importadas 
integralmente 

02 Pilares Externos 02 Pilares Externos Geometrias importadas 
integralmente 

02 
02 

Paredes Laterais 
Paredes Fundos 

02 
02 

Paredes Laterais 
Paredes Fundos 

Geometrias importadas 
integralmente 

 
01 
01 

Cobertura Maior: 
Curva com Elemento Vazado e Plano 
Curva Menor 

 
01 
01 

Cobertura Maior: 
Curva com Elemento Vazado e 
Plano 
Curva Menor 

Geometrias importadas 
integralmente 

01 Cobertura em Balanço: 
Superfície Complexa  

01 Cobertura em Balanço: 
Superfície Complexa  

Geometria importada 
integralmente 

 
01 
01 
01 
04 
02 

Elementos internos: 
Escada 
Pilar 
Laje Mezanino 
Paredes Internas 
Vigas Fundos 

 
01 
01 
01 
04 
02 

Elementos internos: 
Escada 
Pilar 
Laje Mezanino 
Paredes Internas 
Vigas Fundos 

 
Geometrias importadas 
integralmente 

Fonte: Autoria nossa 
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Quadro 12 - Comparação entre os resultados da Fase 1 e da Fase 2 (Modelo CZ) 

FASE 1 
Imagem Modelo CAD B (AUTOCAD) 

FASE 2 
Imagem Modelo BZ (ZPRINT) 

 RESULTADOS 
FASE 1 x FASE 2 

  

 
 
 
Geometrias importadas 
integralmente 

 
 

 
 
 
Geometrias importadas 
integralmente 

  

 
 
 
 
Geometrias importadas 
integralmente 

 
 

 
 
 
 
Geometrias importadas 
integralmente 

QTD TIPO DE GEOMETRIA 
DO MODELO 

QTD TIPO DE GEOMETRIA 
DO MODELO 

 RESULTADOS 
FASE 1 x FASE 2 

01 Base 01 Base Geometria importada 
integralmente 

01 
 

Piso Externo com Elemento Vazado 01 Piso Externo com Elemento Vazado Geometrias importadas 
integralmente 

06 Vigas Frontais Externas  06 Vigas Frontais Externas Geometrias importadas 
integralmente 

02 Pilares Externos 02 Pilares Externos Geometrias importadas 
integralmente 

02 
02 

Paredes Laterais 
Paredes Fundos 

02 
02 

Paredes Laterais 
Paredes Fundos 

Geometrias importadas 
integralmente 

 
01 
01 

Cobertura Maior: 
Curva com Elemento Vazado e Plano 
Curva Menor 

 
01 
01 

Cobertura Maior: 
Curva com Elemento Vazado e 
Plano 
Curva Menor 

Geometrias importadas 
integralmente 

01 Cobertura em Balanço: 
Superfície Complexa  

01 Cobertura em Balanço: 
Superfície Complexa  

Geometria importada 
integralmente 

 
01 
01 
01 
04 

Elementos internos: 
Escada 
Pilar 
Laje Mezanino 
Paredes Internas 

 
01 
01 
01 
04 

Elementos internos: 
Escada 
Pilar 
Laje Mezanino 
Paredes Internas 

 
Geometrias importadas 
integralmente 

Fonte: Autoria nossa 
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Quadro 13 - Comparação entre os resultados da Fase 1 e da Fase 2 (Modelo AX) 

FASE 1 
Imagem Modelo CAD A (REVIT) 

FASE 2 
Imagem Modelo AX (ReplicatorG) 

 RESULTADOS 
FASE 1 x FASE 2 

  

 
 
 
Geometrias importadas 
integralmente 

  

 
 
 
Geometrias importadas 
integralmente 

  

 
 
 
 
Geometrias importadas 
integralmente 

  

 
 
 
Geometrias importadas 
integralmente 

QTD TIPO DE GEOMETRIA 
DO MODELO 

QTD TIPO DE GEOMETRIA 
DO MODELO 

 RESULTADOS 
FASE 1 x FASE 2 

01 Base 01 Base Geometria importada 
integralmente 

01 
 

Piso Externo com Elemento Vazado 01 Piso Externo com Elemento Vazado Geometrias importadas 
integralmente 

06 Vigas Frontais Externas  06 Vigas Frontais Externas Geometrias importadas 
integralmente 

02 Pilares Externos 02 Pilares Externos Geometrias importadas 
integralmente 

02 
02 

Paredes Laterais 
Paredes Fundos 

02 
02 

Paredes Laterais 
Paredes Fundos 

Geometrias importadas 
integralmente 

 
01 
01 
01 
04 
02 

Elementos internos: 
Escada 
Pilar 
Laje Mezanino 
Paredes Internas 
Vigas Fundos 

 
01 
01 
01 
04 
02 

Elementos internos: 
Escada 
Pilar 
Laje Mezanino 
Paredes Internas 
Vigas Fundos 

 
Geometrias importadas 
integralmente 

 
01 
01 

Cobertura Maior: 
Curva com Elem. Vazado e Plano 
Curva Menor 

 
01 
01 

Cobertura Maior: 
Curva com Elem. Vazado e Plano 
Curva Menor 

Geometrias importadas 
integralmente 

01 Cobertura em Balanço: 
Superfície Complexa  

01 Cobertura em Balanço: 
Superfície Complexa  

Geometria importada 
integralmente 

Fonte: Autoria nossa 
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Quadro 14 - Comparação entre os resultados da Fase 1 e da Fase 2 (Modelo BX) 

FASE 1 
Imagem Modelo CAD B (AUTOCAD) 

FASE 2 
Imagem Modelo BX (ReplicatorG) 

 RESULTADOS 
FASE 1 x FASE 2 

  

 
 
 
Geometrias importadas 
integralmente 

  

 
 
 
Geometrias importadas 
integralmente 

 
 

 
 
 
 
Geometrias importadas 
integralmente 

  

 
 
 
Geometrias importadas 
integralmente 

QTD TIPO DE GEOMETRIA 
DO MODELO 

QTD TIPO DE GEOMETRIA 
DO MODELO 

 RESULTADOS 
FASE 1 x FASE 2 

01 Base 01 Base Geometria importada 
integralmente 

01 
 

Piso Externo com Elemento Vazado 01 Piso Externo com Elemento Vazado Geometrias importadas 
integralmente 

06 Vigas Frontais Externas  06 Vigas Frontais Externas Geometrias importadas 
integralmente 

02 Pilares Externos 02 Pilares Externos Geometrias importadas 
integralmente 

02 
02 

Paredes Laterais 
Paredes Fundos 

02 
02 

Paredes Laterais 
Paredes Fundos 

Geometrias importadas 
integralmente 

 
01 
01 
01 
04 
02 

Elementos internos: 
Escada 
Pilar 
Laje Mezanino 
Paredes Internas 
Vigas Fundos 

 
01 
01 
01 
04 
02 

Elementos internos: 
Escada 
Pilar 
Laje Mezanino 
Paredes Internas 
Vigas Fundos 

 
Geometrias importadas 
integralmente 

 
01 
01 

Cobertura Maior: 
Curva com Elem. Vazado e Plano 
Curva Menor 

 
01 
01 

Cobertura Maior: 
Curva com Elem. Vazado e Plano 
Curva Menor 

Geometrias importadas 
integralmente 

01 Cobertura em Balanço: 
Superfície Complexa  

01 Cobertura em Balanço: 
Superfície Complexa  

Geometria importada 
integralmente 

Fonte: Autoria nossa 
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Quadro 15 - Comparação entre os resultados da Fase 1 e da Fase 2 (Modelo CX) 
FASE 1 

Imagem Modelo CAD C (FORMZ) 
FASE 2 

Imagem Modelo CX (ReplicatorG) 
 RESULTADOS 

FASE 1 x FASE 2 

  

 
 
 
Geometrias importadas 
integralmente 

  

 
 
 
Geometrias importadas 
integralmente 

  

 
 
 
 
Geometrias importadas 
integralmente 

 
 

 
 
 
Geometrias importadas 
integralmente 

QTD TIPO DE GEOMETRIA 
DO MODELO 

QTD TIPO DE GEOMETRIA 
DO MODELO 

 RESULTADOS 
FASE 1 x FASE 2 

01 Base 01 Base Geometria importada 
integralmente 

01 
 

Piso Externo com Elemento Vazado 01 Piso Externo com Elemento Vazado Geometrias importadas 
integralmente 

06 Vigas Frontais Externas  06 Vigas Frontais Externas Geometrias importadas 
integralmente 

02 Pilares Externos 02 Pilares Externos Geometrias importadas 
integralmente 

02 
02 

Paredes Laterais 
Paredes Fundos 

02 
02 

Paredes Laterais 
Paredes Fundos 

Geometrias importadas 
integralmente 

 
01 
01 

Cobertura Maior: 
Curva com Elem. Vazado e Plano 
Curva Menor 

 
01 
01 

Cobertura Maior: 
Curva com Elem. Vazado e Plano 
Curva Menor 

Geometrias importadas 
integralmente 

01 Cobertura em Balanço: 
Superfície Complexa  

01 Cobertura em Balanço: 
Superfície Complexa  

Geometria importada 
integralmente 

 
01 
01 
01 
04 
02 

Elementos internos: 
Escada 
Pilar 
Laje Mezanino 
Paredes Internas 
Vigas Fundos 

 
01 
01 
01 
04 
02 

Elementos internos: 
Escada 
Pilar 
Laje Mezanino 
Paredes Internas 
Vigas Fundos 

 
Geometrias importadas 
integralmente 

Fonte: Autoria nossa 

 

O quadro a seguir apresenta o tamanho em KB (Kilobyte), de cada um dos 

arquivos de modelo CAD, os seus respectivos arquivos STL e o número de faces 

existente em cada modelo: 
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Quadro 16 - Tamanho dos arquivos dos modelos CAD, STL e número de faces 

FORMATO MODELO A (REVIT) MODELO B (AUTOCAD) MODELO C (FORMZ) 

MODELO CAD 26.696 KB 318 KB 672 KB 

ARQUIVO STL 1.560 KB 69 KB 69 KB 

Nº FACES 6.340 1.402 1.398 

Fonte: Autoria nossa 

 

Os softwares de prototipagem Zprint 7.10 e ReplicatorG 29, nessas versões, 

não fornecem as informações sobre a quantidade de faces dos objetos que formam 

cada modelo A (Revit), B (AutoCAD) e C (FormZ). Entre os softwares CAD 

escolhidos para elaborar o experimento, somente o FormZ permite importar o 

arquivo STL. Observamos também que este arquivo pode ser exportado pelo FormZ 

e pelos outros softwares.  

Os arquivos obtidos a partir do mesmo sistema CAD específico - Revit 

Architecture 2012, tanto o modelo CAD como o formato STL, apresentam o maior 

tamanho em KB (Kilobyte) e mais de quatro vezes a quantidade de faces dos 

objetos do modelo. No caso dos arquivos obtidos a partir dos sistemas CAD 

genéricos - AutoCAD 2012 e FormZ 6.7.3, mesmo com o arquivo do modelo CAD C 

tendo o dobro do tamanho em Kilobytes, o seu arquivo formato STL possui tamanho 

igual ao modelo CAD B que, por sua vez, também resultam em número de faces dos 

objetos praticamente iguais entre si. 

 

 

8.3 Fase 3 (Fabricação no sistema de prototipagem rápida) 

 

A terceira fase consistiu na produção dos modelos CAD A, B e C, gerados 

em diferentes sistemas CAD, a partir de dois diferentes tipos de sistemas de 

prototipagem rápida, por processo de adição de camadas. Os resultados foram seis 

protótipos rápidos, baseados em um mesmo projeto, sendo três modelos obtidos na 

impressora 3DP Zprinter (Z), em escala 1:100, e os outros três modelos obtidos a 

partir da impressora FDM Thing-O-Matic (X), em escala 1:200.  

Os arquivos das impressoras anteriormente configurados na Fase 2 

(planejamento) foram abertos no software de cada impressora tridimensional, um de 

cada vez, e as informações sobre o tempo estimado de fabricação do protótipo e a 

quantidade de material foram obtidas, conforme descreve o quadro a seguir: 
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Quadro 17 - Tempo e material gasto no processo de prototipagem dos experimentos 

SISTEMA CAD +  
SISTEMA PROTOTIPAGEM RÁPIDA 

TEMPO DE 
FABRICAÇÃO 

MATERIAL 
UTILIZADO 

Protótipo Rápido AZ 
(Modelo CAD A + Impressora Zprinter) 

2 horas 58 minutos 
(+1 hora espera para 

cura do material) 

117,50 ml (Aglutinante ZBinder 60) 
271.011,15 mm

3 
(Pó ZP150) 

Protótipo Rápido BZ 
(Modelo CAD B + Impressora Zprinter) 

2 horas 58 minutos 
(+1 hora espera para 

cura do material) 

112,80 ml (Aglutinante ZBinder 60) 
271.079,00 mm

3 
(Pó ZP150) 

Protótipo Rápido CZ 
(Modelo CAD C + Impressora Zprinter) 

2 horas 57 minutos 
(+1 hora espera para 

cura do material) 

116,50 ml (Aglutinante ZBinder 60) 
271.295,20 mm

3 
(Pó ZP150) 

Protótipo Rápido AX 
(Modelo CAD A + Imp. Thing-O-Matic) 

2 horas 36 minutos  
17 segundos 

(Plástico ABS Branco e=0,175 
mm) quantidade não informada 

pelo software 

Protótipo Rápido BX 
(Modelo CAD B + Imp.Thing-O-Matic) 

2 horas 29 minutos 
(Plástico ABS Branco e=0,175 

mm) quantidade não informada pelo 
software 

Protótipo Rápido CX 
(Modelo CAD C + Imp. Thing-O-Matic) 

2 horas 27 minutos 
58 segundos 

(Plástico ABS Branco e=0,175 
mm) quantidade não informada pelo 

software 

Fonte: Autoria nossa 

 

Na impressora Zprinter foi utilizado como material sólido o pó (powder) ZP 

150, associado ao líquido aglutinante zb60 clear fornecido pelo fabricante 

ZCorporation. As instruções recomendadas no manual do fabricante foram seguidas 

para a utilização do equipamento. O processo de prototipagem na Zprinter iniciou-se 

com uma barra com cabeçote aplicando o líquido aglutinante no formato da base do 

modelo, na plataforma direita do equipamento. Em seguida, quando a barra retorna 

para a direita, traz uma camada do material sólido contido na plataforma do lado 

esquerdo.  

Este processo se repete sucessivamente até completar o formato do 

modelo, em várias fatias de baixo para cima. Enquanto a plataforma do lado 

esquerdo sobe diminuindo o material sólido, o lado direito desce com o modelo 

totalmente coberto por dentro e por fora pelo pó. Ao término do processo, o 

fabricante da impressora Zprinter recomenda aguardar pelo menos 1 hora, antes de 

dar início à retirada do protótipo de dentro do equipamento. 

As fotos da Figura 35 a seguir apresentam a sequência, da esquerda para 

direita, do início meio e término do processo de fabricação dos modelos CAD A, B e 

C utilizando a impressora tridimensional, modelo Zprinter 310 plus monocromática 

da ZCorporation: 
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Figura 35 - Fotos do processo de fabricação na impressora ZCorporation 
Fonte: Arquivo pessoal 

 

No caso da impressora modelo Thing-O-Matic, o material sólido utilizado foi 

o ABS com espessura igual a 0,175 mm na cor branca. A impressão foi iniciada 

após o aquecimento do material que desce do bico extrusor, que percorreu o 

caminho com o formato do perfil lateral do modelo, expelindo o plástico derretido. A 

base da impressora também possui temperatura alta, para manter o material em 

condições de adicionar as próximas camadas. O processo repete-se 

sucessivamente até completar todas as camadas sobrepostas do modelo. O 

protótipo permanece com temperatura alta por alguns minutos. Ao esfriar o material 

permanece rígido.  

O processo de fabricação dos modelos CAD A, B e C utilizando a 

impressora FDM (Fused Deposition Modeling) modelagem por deposição e fusão, 

modelo Thing-O-Matic da MakerBot é apresentado na figura abaixo: 

 

             
Figura 36 - Fotos do processo de fabricação na impressora Thing-O-Matic da MakerBot 

Fonte: Arquivo pessoal 
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8.4 Fase 4 (acabamento) 

 

Na última Fase 4 (acabamento) os protótipos rápidos AZ, BZ e CZ foram 

obtidos, um de cada vez, na impressora Zprinter. No primeiro momento, foi 

necessário remover o pó da parte de cima e dos lados do protótipo, com o auxílio de 

um pincel, devido à fragilidade do material.  

No processo de limpeza do protótipo CZ, um dos pilares e viga da fachada 

norte foram quebrados e em seguida foram colados com cola de cianocrilato (super 

bonder).  

A sequência do processo de limpeza pode ser observada na figura abaixo: 

 

       

Figura 37 - Fotos do processo de limpeza do protótipo na impressora Zprinter 
Fonte: Arquivo pessoal 

 

Cada um dos protótipos foi retirado da impressora e levado para a estação 

de reciclagem de pó, que acompanha o equipamento da ZCorporation. O pó que 

ainda estava contido dentro do protótipo foi retirado utilizando um compressor de ar. 

De maneira a reforçar a resistência dos protótipos foi aplicado, nas superfícies 

externas, o material Z-Bond 101 que possui consistência bastante viscosa, inodoro, 

transparente e de rápida secagem. 

Por causa dessas características do material, a melhor opção foi utilizar 

luvas cirúrgicas para aplicar e espalhar o material sobre o protótipo. A seguir, a 

figura 38 apresenta os equipamentos de estação de reciclagem de pó, impressora 

Zprinter e microcomputador do laboratório de Fabricação Digital e Customização em 

Massa (LFDC). 
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Figura 38 - Fotos dos equipamentos de prototipagem rápida do LFDC 
Fonte: Arquivo pessoal 

 

Após a resinagem, o aspecto final dos protótipos não se mostrou uniforme e 

algumas superfícies apresentavam a resina acumulada, formando bolhas - para 

retirar o excesso do material foi empregada uma lixa fina. A preocupação na fase do 

acabamento foi a de não alterar a geometria do protótipo, para não interferir na 

avaliação dos resultados deste experimento. O tempo gasto no processo de 

acabamento dos protótipos, produzidos na Zprinter, variou entre 3 a 4 horas para 

cada protótipo. 

No caso dos protótipos rápidos AX, BX e CX fabricados pela impressora 

Thing-O-Matic, o acabamento foi basicamente retirar o suporte com alicate e lixa 

fina, nas partes com saliência de material plástico. O tempo gasto nesse processo 

variou entre 30 a 60 minutos para cada protótipo. 

Todos os seis protótipos rápidos finalizados na Fase 4 (acabamento) foram 

fotografados, considerando os mesmos pontos de vista definidos anteriormente nas 

imagens dos modelos CAD A, B e C. O equipamento fotográfico utilizado foi a 

máquina fotográfica digital marca Sony modelo nex7. As fotos dos protótipos rápidos 

AX, AZ, BX, BZ, CX e CZ são apresentadas nos quadros a seguir, no capítulo 9, 

Análise de Resultados e no Apêndice D. 
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9 ANÁLISE DOS RESULTADOS 

 

Os resultados obtidos da Fase 1 (modelagem no sistema CAD), Fase 2 

(planejamento) e Fase 4 (acabamento) foram utilizados para verificar a hipótese em 

duas etapas distintas. 

A primeira etapa consistiu em verificar a interoperabilidade entre os 

diferentes softwares de sistemas CAD e os softwares de prototipagem rápida. Os 

resultados obtidos na Fase 1 (modelagem no sistema CAD) foram organizados nos 

quadros a seguir, com a primeira coluna contendo, nas linhas superiores, as 

imagens das vistas externas renderizadas do modelo CAD, para efeito de registro da 

observação efetuada. Nas linhas abaixo das imagens a coluna é subdividida, 

informando a quantidade e depois o tipo de geometria com as dimensões em 

largura, profundidade e altura, na unidade em metro. Os aspectos de resolução das 

formas curvas e superfícies complexas foram descritos, conforme quantidade e 

formato das faces representadas. 

A segunda coluna informa os resultados obtidos a partir da verificação 

efetuada nas imagens do modelo importado na Fase 2 (planejamento), apresentada 

nas primeiras linhas. A coluna é subdividida, abaixo das imagens, para descrever a 

quantidade e o tipo de geometria, especificando a condição de interoperabilidade 

entre geometrias integralmente importadas, parcialmente importadas, ou geometrias 

não importadas. 

A terceira coluna registra as imagens das fotos obtidas dos protótipos 

rápidos, Fase 4 (acabamento), com as vistas equivalentes às do modelo CAD 

original. De maneira a verificar a hipótese na segunda etapa, os graus de 

semelhança geométrica formal entre estes modelos foram comparados. Nas linhas 

superiores, as imagens permitiram registrar o grau de resolução das formas. No 

sentido de permitir comparação entre os modelos, logo abaixo de suas respectivas 

imagens, a coluna é subdividida, informando a quantidade e depois o tipo de 

geometria com as dimensões em largura, profundidade e altura, na unidade em 

metro.  

Os aspectos de resolução das formas curvas e superfícies complexas 

também foram descritos, conforme quantidade e formato das faces representadas. A 

seguir, o Quadro 18 reúne todos os resultados obtidos em cada fase de elaboração 
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do experimento utilizando o modelo CAD A (Revit) e a impressora tridimensional 

Thing-O-Matic (X). 

 
Quadro 18 - Comparação entre os resultados da Fase 1, Fase 2 e Fase 4 (Modelo AX) 

FASE 1 
Imagem Modelo CAD A (Revit) 

FASE 2 
Imagem Modelo AX (ReplicatorG) 

FASE 4 
Foto Protótipo AX (Thing-O-Matic) 

 
 

 

 
  

 
 

 

  
 

QTD TIPO DE GEOMETRIA 
Modelo CAD (L x P x H) m 

QTD INTEROPERABILIDADE 
ENTRE OS SOFTWARES 

QTD TIPO DE GEOMETRIA 
Protótipo (L x P x H) m 

01 Base = 10,00x10,00x0,80 01 Base: Geom. importada integralmente 01 Base = 10,00x10,00x0,80 

01 Piso Externo=12,00x16,00x0,40 
Elemento Vazado= 
10,00x2,00x0,40 

01 Piso Externo com Elem. Vazado: 
Geom. importada integralmente 

01 Piso Externo = 12,00x16,00x0,40* 
*parte removida com o suporte  
Elem. Vazado = 10,00x2,00x0,40 

 
04 
02 

Vigas Externas Frontais= 
4,25x0,20x0,40 
3,20x0,20x0,40 

06 Vigas Externas Frontais:  
Geometrias importadas integralmente 

 
03 
01 
01 
01 

Vigas Externas Frontais: 
4,25x0,20x0,40 
4,25x0,20x0,40~0,20* 
3,20x0,20x0,40 
3,20x0,20~0,10x0,40~0,60* 

*forma e dimensão altura irregular 

 
02 

Pilares Externos= 
0,40x0,20x5,20 

02 Pilares Externos: 
Geometrias importadas integralmente 

 
02 

Pilares Externos: 
0,40x0,20x5,20 

 
02 
 

02 

Paredes Laterais=  
0,20x7,00x5,60 
Paredes Fundos= 
 0,20x1,70x4,80 

04 Paredes Laterais: 
Geometrias importadas integralmente 
Paredes Fundos: 
Geometrias importadas integralmente 

 
02 

 
02 

Paredes Laterais: 
0,20x7,00x5,60 
Paredes Fundos: 
0,20x1,70x4,80 

 
01 
01 
01 
04 
02 

Elementos internos: Não medidos 
Escada 
Pilar 
Laje Mezanino 
Paredes Internas 
Vigas Fundos 

09 Elementos internos:  
Escada 
Pilar 
Laje Mezanino 
Paredes Internas 
Vigas Fundos 
Geometrias importadas Integralmente 

 
01 
01 
01 
02 
02 
02 

Elementos internos: (Não medidos) 
Escada 
Pilar 
Laje Mezanino 
Paredes Internas 
Paredes int. não representadas 
Vigas Fundos 

01  Cobertura Curva Menor = 
12,00x0,56x0,40 
Não apresenta faces planas  

01 Cobertura Curva Menor: 
Geometria importada integralmente 
Apresenta 22 faces  

01 Cobertura Curva Menor = 
12,00x0,56x0,40 
Não apresenta faces planas  

01 Cobertura Maior: 
Elemento Plano= 
12,00x6,48x0,40 
Elemento Vazado= 
10,00x2,00x0,40 
Curva Maior= 
12,00x6,96x0,40 
Não apresenta faces planas 

01 Cobertura Maior: 
Elemento plano 
Geometria importada integralmente 
Elemento Vazado 
Geometria importada integralmente 
Curva Maior  
Geometria importada integralmente 
Apresenta 10 faces  

01 Cobertura Maior: 
Elemento Plano= 
12,00x6,48x0,40 
Elemento Vazado= 
10,00x2,00x0,40 
Curva Maior= 
12,00x6,96x0,40 
Apresenta 10 faces  

01 Cobertura em Balanço: 
 Curva 1 = 6,90x3,00x0,40 
 Curva 2 = 5,10x3,00x0,40 
Não apresenta faces planas 

01 Cobertura em Balanço  
Geometria importada integralmente 
Não apresenta faces planas 

01 Cobertura em Balanço: 
 Curva 1 = 6,90x3,00x0,40 
 Curva 2 = 5,10x3,00x0,40 
Não apresenta faces planas 
 

Fonte: Autoria nossa (fotos do protótipo rápido: Sílvio Uehara) 
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O quadro abaixo destaca a imagem ampliada do quadro anterior, e as 

diferenças observadas no protótipo rápido AX (Thing-O-Matic) comparado ao 

modelo CAD A (Revit). 

 

Quadro 19 - Diferenças na representação do protótipo rápido AX (Thing-O-Matic) comparado ao 
modelo CAD A (Revit) 

 
Fonte: Autoria nossa 

 

Em comparação com o modelo CAD A (Revit), o protótipo rápido AX da 

impressora Thing-O-Matic apresentou algumas falhas na construção de elementos 

geométricos, conforme destacado nas figuras acima. Estes problemas de 

prototipagem rápida provavelmente são decorrentes da maneira como o arquivo 

padrão STL gerou as informações para serem fabricadas, associado ao limite de 

precisão do equipamento e ao seu respectivo processo construtivo.  

O grau de resolução da curva maior representada de forma facetada, caso 

necessário, pode ser modificado e a resolução aumentada para uma quantidade 

Vigas Externas 
Frontais com forma e 
dimensão da altura 
irregular 

Paredes Internas 
não representadas 

Curva Maior com 
faces  
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maior de faces no modelo CAD A (Revit). As faces da curva menor, que são 

observadas no modelo importado pelo software ReplicatorG, não são visíveis no 

protótipo AX, provavelmente por causa da escala 1:200 adotada na referida 

prototipagem rápida. 

A seguir, o Quadro 20 reúne todos os resultados obtidos em cada fase de 

elaboração do experimento (modelo CAD A (Revit) e impressora Zprinter (Z)). 
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Quadro 20 - Comparação entre os resultados da Fase 1, Fase 2 e Fase 4 (Modelo AZ) 
FASE 1 

Imagem Modelo CAD A (Revit) 
FASE 2 

Imagem Modelo AZ (Zprint) 
FASE 4 

Foto Protótipo AZ (Zprinter) 

   

   

   

 
 

 
QTD TIPO DE GEOMETRIA 

Modelo CAD (L x P x H) m 
QTD INTEROPERABILIDADE 

entre os softwares 
QTD TIPO DE GEOMETRIA 

Protótipo (L x P x H) m 
01 Base = 10,00x10,00x0,80 01 Base: Geom. importada integralmente 01 Base = 10,00x10,00x0,80 

01 Piso Externo=12,00x16,00x0,40 
Elem. Vazado=10,00x2,00x0,40 

01 Piso Externo com Elem. Vazado: 
Geom. importada integralmente 

01 Piso Externo = 12,00x16,00x0,40 
Elem. Vazado = 10,00x2,00x0,40 

 
04 
02 

Vigas Externas Frontais= 
4,25x0,20x0,40 
3,20x0,20x0,40 

06 Vigas Externas Frontais:  
Geometrias importadas integralmente 

 
04 
02 

Vigas Externas Frontais= 
4,25x0,20x0,40 
3,20x0,20x0,40 

 
02 

Pilares Externos= 
0,40x0,20x5,20 

02 Pilares Externos: 
Geometrias importadas integralmente 

 
02 

Pilares Externos: 
0,40x0,20x5,20 

 
02 
 

02 

Paredes Laterais=  
0,20x7,00x5,60 
Paredes Fundos= 
 0,20x1,70x4,80 

04 Paredes Laterais: 
Geometrias importadas integralmente 
Paredes Fundos: 
Geometrias importadas integralmente 

 
02 

 
02 

Paredes Laterais: 
0,20x7,00x5,60 
Paredes Fundos: 
0,20x1,70x4,80 

 
01 
01 
01 
04 
02 

Elementos internos: Não medidos 
Escada 
Pilar 
Laje Mezanino 
Paredes Internas 
Vigas Fundos 

09 Elementos internos:  
Escada 
Pilar 
Laje Mezanino 
Paredes Internas 
Vigas Fundos 
Geometrias importadas Integralmente 

 
01 
01 
01 
04 
02 

Elementos internos: Não medidos 
Escada 
Pilar 
Laje Mezanino 
Paredes Internas 
Vigas Fundos 

01  Cobertura Curva Menor = 
12,00x0,56x0,40 
Não apresenta faces planas  

01 Cobertura Curva Menor: 
Geometria importada integralmente 
Apresenta 28 faces  

01 Cobertura Curva Menor = 
12,00x0,56x0,40 
Não apresenta faces planas 

01 Cobertura Maior: 
Elemento Plano= 
12,00x6,48x0,40 
Elemento Vazado= 
10,00x2,00x0,40 
Curva Maior= 
12,00x6,96x0,40 
Não apresenta faces planas 

01 Cobertura Maior: 
Elemento plano 
Geometria importada integralmente 
Elemento Vazado 
Geometria importada integralmente 
Curva Maior  
Geometria importada integralmente 
Apresenta 10 faces  

01 Cobertura Maior: 
Elemento Plano= 
12,00x6,48x0,40 
Elemento Vazado= 
10,00x2,00x0,40 
Curva Maior= 
12,00x6,96x0,40 
Apresenta 10 faces  

01 Cobertura em Balanço: 
 Curva 1 = 6,90x3,00x0,40 
 Curva 2 = 5,10x3,00x0,40 
Não apresenta faces planas 

01 Cobertura em Balanço: 
Geometria importada integralmente 
Não apresenta faces planas 

01 Cobertura em Balanço: 
 Curva 1 = 6,90x3,00x0,40 
 Curva 2 = 5,10x3,00x0,40 
Não apresenta faces planas 
 

Fonte: Autoria nossa (fotos do protótipo rápido: Sílvio Uehara) 
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O quadro abaixo destaca a imagem ampliada do quadro anterior, e as 

diferenças observadas no protótipo rápido AZ (Zprinter) comparado ao modelo CAD 

A (Revit). 

 
Quadro 21 - Diferença na representação do protótipo rápido AZ (Zprinter) comparado ao 

modelo CAD A (Revit) 

 

Fonte: Autoria nossa 

 

A única diferença observada no protótipo AZ (Zprinter), comparado com o 

modelo CAD A (Revit), foi o grau de resolução da curva maior representada de 

forma facetada. Caso haja necessidade, a curva pode ser modificada e a resolução 

aumentada para uma maior quantidade de faces no modelo CAD A (Revit). As faces 

da curva menor, que são observadas no modelo importado pelo software Zprint, não 

são visíveis no protótipo AZ, provavelmente por causa da escala 1:100 adotada 

nesta prototipagem rápida. 

A seguir, o Quadro 22 reúne todos os resultados obtidos em cada fase de 

elaboração do experimento, utilizando o modelo CAD B (AutoCAD) e a impressora 

tridimensional Thing-O-Matic (X). 

 

 
 
 
 
 
 

Curva Maior com 
faces   
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Quadro 22 - Comparação entre os resultados da Fase 1, Fase 2 e Fase 4 (Modelo BX) 
FASE 1 

Imagem Modelo CAD B  (AutoCAD) 
FASE 2 

Imagem Modelo BX (ReplicatorG) 
FASE 4 

Foto Protótipo BX (Thing-O-Matic) 

 
 

 

  
 

   

   
QTD TIPO DE GEOMETRIA 

Modelo CAD (L x P x H) m 
QTD INTEROPERABILIDADE 

entre os softwares 
QTD TIPO DE GEOMETRIA 

Protótipo (L x P x H) m 
01 Base = 10,00x10,00x0,80 01 Base: Geom. importada integralmente 01 Base = 10,00x10,00x0,80 

01 Piso Externo=12,00x16,00x0,40 
Elemento Vazado= 
10,00x2,00x0,40 

01 Piso Externo com Elem. Vazado: 
Geom. importada integralmente 

01 Piso Externo = 12,00x16,00x0,40* 
*parte removida com o suporte  
Elem. Vazado = 10,00x2,00x0,40 

 
04 
02 

Vigas Externas Frontais= 
4,25x0,20x0,40 
3,20x0,20x0,40 

06 Vigas Externas Frontais:  
Geometrias importadas integralmente 

 
04 
01 
01 

 

Vigas Externas Frontais: 
4,25x0,20x0,40 
3,20x0,20x0,40 
3,20x0,20~0,10x0,40~0,60* 

*forma e dimensão altura  irregular 

 
02 

Pilares Externos= 
0,40x0,20x5,20 

02 Pilares Externos: 
Geometrias importadas integralmente 

 
02 

Pilares Externos: 
0,40x0,20x5,20 

 
02 
 

02 

Paredes Laterais=  
0,20x7,00x5,60 
Paredes Fundos= 
 0,20x1,70x4,80 

04 Paredes Laterais: 
Geometrias importadas integralmente 
Paredes Fundos: 
Geometrias importadas integralmente 

 
02 

 
02 

Paredes Laterais: 
0,20x7,00x5,60 
Paredes Fundos: 
0,20x1,70x4,80 

 
01 
01 
01 
04 
02 

Elementos internos: Não medidos 
Escada 
Pilar 
Laje Mezanino 
Paredes Internas 
Vigas Fundos 

09 Elementos internos:  
Escada 
Pilar 
Laje Mezanino 
Paredes Internas 
Vigas Fundos 
Geometrias importadas Integralmente 

 
01 
01 
01 
04 
02 

Elementos internos: Não medidos 
Escada 
Pilar 
Laje Mezanino 
Paredes Internas 
Vigas Fundos  

01  Cobertura Curva Menor = 
12,00x0,56x0,40 
Não apresenta faces planas  

01 Cobertura Curva Menor: 
Geometria importada integralmente 
Apresenta 8 faces  

01 Cobertura Curva Menor = 
12,00x0,56x0,40 
Apresenta 8 faces  

01 Cobertura Maior: 
Elemento Plano= 
12,00x6,48x0,40 
Elemento Vazado= 
10,00x2,00x0,40 
Curva Maior= 
12,00x6,96x0,40 
Não apresenta faces planas 

01 Cobertura Maior: 
Elemento plano 
Geometria importada integralmente 
Elemento Vazado 
Geometria importada integralmente 
Curva Maior  
Geometria importada integralmente 
Apresenta 7 faces  

01 Cobertura Maior: 
Elemento Plano= 
12,00x6,48x0,40 
Elemento Vazado= 
10,00x2,00x0,40 
Curva Maior= 
12,00x6,96x0,40 
Apresenta 7 faces  

01 Cobertura em Balanço: 
 Curva 1 = 6,90x3,00x0,40 
 Curva 2 = 5,10x3,00x0,40 
Não apresenta faces planas 

01 Cobertura em Balanço  
Geometria importada integralmente 
Apresenta faces padrão irregular e 
regular 

01 Cobertura em Balanço: 
 Curva 1 = 6,90x3,00x0,40 
 Curva 2 = 5,10x3,00x0,40 
Apresenta faces muito pouco 
visíveis 

Fonte: Autoria nossa (fotos do protótipo rápido: Sílvio Uehara) 
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O quadro abaixo destaca a imagem ampliada do quadro anterior, e as 

diferenças observadas no protótipo rápido BX (Thing-O-Matic) comparado ao 

modelo CAD B (AutoCAD). 

 

Quadro 23 - Diferenças na representação do protótipo rápido BX (Thing-O-Matic) comparado ao 
modelo CAD B (AutoCAD) 

 

 
Fonte: Autoria nossa 

 

O protótipo rápido BX da impressora Thing-O-Matic, comparado com o 

modelo CAD B (AutoCAD), apresentou falha somente na construção de um 

elemento geométrico, conforme destacado na figura acima. Este problema de 

prototipagem rápida decorre provavelmente pelo limite de precisão do equipamento 

e de seu respectivo processo construtivo.  

O grau de resolução da curva maior, da curva menor e da superfície 

complexa representadas de forma facetada, caso necessário, podem ser 

modificados e a resolução aumentada para uma maior quantidade de faces no 

modelo CAD B (AutoCAD). A cobertura em balanço, constituída pela superfície 

complexa, apresenta faces no formato triangular irregular e trapezoidal regular no 

Viga Externa Frontal 
com forma e dimensão 
da altura irregular 

Superfície 
Complexa com 
faces pouco visíveis 

Curva Maior e 
Curva Menor com 
faces   
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protótipo BX (Thing-O-Matic), pouco visível provavelmente por causa da 

representação em escala reduzida de 1:200. 

A seguir, o Quadro 24 reúne todos os resultados obtidos em cada fase de 

elaboração do experimento, utilizando o modelo CAD B (AutoCAD) e a impressora 

tridimensional Zprinter (Z). 
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Quadro 24 - Comparação entre os resultados da Fase 1, Fase 2 e Fase 4 (Modelo BZ) 
FASE 1 

Imagem Modelo CAD B (AutoCAD) 
FASE 2 

Imagem Modelo BZ (Zprint) 
FASE 4 

Foto Protótipo BZ (Zprinter) 

   

  
 

   

  
 

QTD TIPO DE GEOMETRIA 
Modelo CAD (L x P x H) m 

QTD INTEROPERABILIDADE 
entre os softwares 

QTD TIPO DE GEOMETRIA 
Protótipo (L x P x H) m 

01 Base = 10,00x10,00x0,80 01 Base: Geom. importada integralmente 01 Base = 10,00x10,00x0,80 

01 Piso Externo=12,00x16,00x0,40 
Elemento Vazado= 
10,00x2,00x0,40 

01 Piso Externo com Elem. Vazado: 
Geom. importada integralmente 

01 Piso Externo=12,00x16,00x0,40 
Elemento Vazado= 10,00x2,00x0,40 

 
04 
02 

Vigas Externas Frontais= 
4,25x0,20x0,40 
3,20x0,20x0,40 

06 Vigas Externas Frontais:  
Geometrias importadas integralmente 

 
04 
02 

Vigas Externas Frontais= 
4,25x0,20x0,40 
3,20x0,20x0,40 

02 Pilares Externos= 
0,40x0,20x5,20 

02 Pilares Externos: 
Geometrias importadas integralmente 

02 Pilares Externos= 
0,40x0,20x5,20 

02 
 

02 

Paredes Laterais=  
0,20x7,00x5,60 
Paredes Fundos= 
 0,20x1,70x4,80 

04 Paredes Laterais: 
Geometrias importadas integralmente 
Paredes Fundos: 
Geometrias importadas integralmente 

 
02 

 
02 

Paredes Laterais= 0,20x7,00x5,60 
Paredes Fundos= 
 0,20x1,70x4,80 

 
01 
01 
01 
04 
02 

Elementos internos: Não medidos 
Escada 
Pilar 
Laje Mezanino 
Paredes Internas 
Vigas Fundos 

09 Elementos internos:  
Escada 
Pilar 
Laje Mezanino 
Paredes Internas 
Vigas Fundos 
Geometrias importadas Integralmente 

 
01 
01 
01 
04 
02 

Elementos internos: Não medidos 
Escada 
Pilar 
Laje Mezanino 
Paredes Internas 
Vigas Fundos 

01  Cobertura Curva Menor = 
12,00x0,56x0,40 
Não apresenta faces planas  

01 Cobertura Curva Menor: 
Geometria importada integralmente 
Apresenta 8 faces 

01 Cobertura Curva Menor = 
12,00x0,56x0,40 
Apresenta 8 faces  

01 Cobertura Maior: 
Elemento Plano= 
12,00x6,48x0,40 
Elemento Vazado= 
10,00x2,00x0,40 
Curva Maior= 
12,00x6,96x0,40 
Não apresenta faces planas 

01 Cobertura Maior: 
Elemento plano 
Geometria importada integralmente 
Elemento Vazado 
Geometria importada integralmente 
Curva Maior  
Geometria importada integralmente 
Apresenta 7 faces  

01 Cobertura Maior: 
Elemento Plano= 
12,00x6,48x0,40 
Elemento Vazado= 
10,00x2,00x0,40 
Curva Maior= 
12,00x6,96x0,40 
Apresenta 7 faces 

01 Cobertura em Balanço: 
 Curva 1 = 6,90x3,00x0,40 

 Curva 2 = 5,10x3,00x0,40 
Não apresenta faces planas 

01 Cobertura em Balanço  
Geometria importada integralmente 
Apresenta faces no padrão irregular 
e regular 

01 Cobertura em Balanço: 
 Curva 1 = 6,90x3,00x0,40 

 Curva 2 = 5,10x3,00x0,40 
Apresenta faces no padrão 
irregular e regular 

Fonte: Autoria nossa (fotos do protótipo rápido: Sílvio Uehara) 
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O quadro abaixo destaca a imagem ampliada do quadro anterior, e as 

diferenças observadas no protótipo rápido BZ (Zprinter) comparado ao modelo CAD 

B (AutoCAD). 

 
Quadro 25 - Diferenças na representação do protótipo rápido BZ (Zprinter) comparado ao modelo 

CAD B (AutoCAD) 

 

Fonte: Autoria nossa 
 

As curvas e a superfície complexa do protótipo BZ (Zprinter) apresentam 

faces com tamanho e formas variadas em comparação com o modelo CAD B 

(AutoCAD). A representação das faces do protótipo BZ (Zprinter) é idêntica à 

representação da imagem do modelo CAD B (AutoCAD) importado no software 

Zprint da impressora tridimensional. A resolução destas geometrias pode ser 

alterada, para que as faces não sejam visivelmente representadas, e o número de 

divisão das superfícies curvas e complexas pode ser aumentado no software do 

modelo CAD B (AutoCAD). 

A seguir, o Quadro 26 reúne todos os resultados obtidos em cada fase de 

elaboração do experimento utilizando o modelo CAD C (FormZ) e a impressora 

tridimensional Thing-O-Matic (X). 

 

 

 

 

 

Superfície 
Complexa com 
faces no 
formato 
irregular e 
regular 

Curva Maior e 
Curva Menor  
com faces  
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Quadro 26 - Comparação entre os resultados da Fase 1, Fase 2 e Fase 4 (Modelo CX) 
FASE 1 

Imagem Modelo CAD C (FormZ) 
FASE 2 

Imagem Modelo CX (ReplicatorG) 
FASE 4 

Foto Protótipo CX (Thing-O-Matic) 

  
 

  
 

 
  

   

QTD TIPO DE GEOMETRIA 
Modelo CAD (L x P x H) m 

QTD INTEROPERABILIDADE 
entre os softwares 

QTD TIPO DE GEOMETRIA 
Protótipo (L x P x H) m 

01 Base = 10,00x10,00x0,80 01 Base: Geom. importada integralmente 01 Base = 10,00x10,00x0,80 

01 Piso Externo=12,00x16,00x0,40 
Elemento Vazado= 
10,00x2,00x0,40 

01 Piso Externo com Elem. Vazado: 
Geom. importada integralmente 

01 Piso Externo = 12,00x16,00x0,40* 
*parte removida com o suporte  
Elem. Vazado = 10,00x2,00x0,40 

 
04 
02 

Vigas Externas Frontais= 
4,25x0,20x0,40 
3,20x0,20x0,40 

06 Vigas Externas Frontais:  
Geometrias importadas integralmente 

 
04 
01 
01 

 

Vigas Externas Frontais: 
4,25x0,20x0,40 
3,20x0,20x0,40 
3,20x0,20~0,10x0,40~0,60* 
*forma e dimensão altura irregular 

 
02 

Pilares Externos= 
0,40x0,20x5,20 

02 Pilares Externos: 
Geometrias importadas integralmente 

 
02 

Pilares Externos: 
0,40x0,20x5,20 

 
02 
 

02 

Paredes Laterais=  
0,20x7,00x5,60 
Paredes Fundos= 
 0,20x1,70x4,80 

04 Paredes Laterais: 
Geometrias importadas integralmente 
Paredes Fundos: 
Geometrias importadas integralmente 

 
02 

 
02 

Paredes Laterais: 
0,20x7,00x5,60 
Paredes Fundos: 
0,20x1,70x4,80 

 
01 
01 
01 
04 
02 

Elementos internos: Não medidos 
Escada 
Pilar 
Laje Mezanino 
Paredes Internas 
Vigas Fundos 

09 Elementos internos:  
Escada 
Pilar 
Laje Mezanino 
Paredes Internas 
Vigas Fundos 
Geometrias importadas Integralmente 

 
01 
01 
01 
04 
02 

 

Elementos internos: (Não medidos) 
Escada 
Pilar 
Laje Mezanino 
Paredes Internas 
Vigas Fundos 

01  Cobertura Curva Menor = 
12,00x0,56x0,40 
Não apresenta faces planas  

01 Cobertura Curva Menor: 
Geometria importada integralmente 
Apresenta 12 faces  

01 Cobertura Curva Menor = 
12,00x0,56x0,40 
Apresenta 12 faces  

01 Cobertura Maior: 
Elemento Plano= 
12,00x6,48x0,40 
Elemento Vazado= 
10,00x2,00x0,40 
Curva Maior= 
12,00x6,96x0,40 
Não apresenta faces planas 

01 Cobertura Maior: 
Elemento plano 
Geometria importada integralmente 
Elemento Vazado 
Geometria importada integralmente 
Curva Maior  
Geometria importada integralmente 
Apresenta 5 faces  

01 Cobertura Maior: 
Elemento Plano= 
12,00x6,48x0,40 
Elemento Vazado= 
10,00x2,00x0,40 
Curva Maior= 
12,00x6,96x0,40 
Apresenta 5 faces  

01 Cobertura em Balanço: 
 Curva 1 = 6,90x3,00x0,40 
 Curva 2 = 5,10x3,00x0,40 
Não apresenta faces planas 

01 Cobertura em Balanço  
Geometria importada integralmente 
Apresenta faces no padrão 
regular 

01 Cobertura em Balanço: 
 Curva 1 = 6,90x3,00x0,40 
 Curva 2 = 5,10x3,00x0,40 
Apresenta faces no padrão 
regular  

Fonte: Autoria nossa (fotos do protótipo rápido: Sílvio Uehara) 
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O quadro abaixo destaca a imagem ampliada do quadro anterior, e as 

diferenças observadas no protótipo rápido CX (Thing-O-Matic) comparado ao 

modelo CAD C (FormZ). 

 

Quadro 27 - Diferenças na representação do protótipo rápido CX (Thing-O-Matic) comparado ao 
modelo CAD C (FormZ) 

 

 
Fonte: Autoria nossa 

 

A mesma falha na representação da viga externa frontal pode ser observada 

em todos os três protótipos rápidos produzidos pela impressora Thing-O-Matic (AX, 

BX e CX). Este fato reforça a probabilidade do problema ser decorrente do limite de 

precisão do equipamento e do processo construtivo, no qual o modelo foi 

configurado em uma posição que utilizou como base para produção as dimensões 

mínimas de perfil da viga externa frontal. 

A cobertura em balanço constituída pela superfície complexa apresenta 

faces no formato regular e uniforme, tanto na imagem do modelo CAD C (FormZ) 

importado, como no protótipo CX (Thing-O-Matic). Assim como ocorreu nos demais 

sistemas CAD, o grau de resolução da curva maior, da curva menor e da superfície 

Viga Externa Frontal 
com forma e dimensão 
da altura irregular 

Curva Maior e 
Curva Menor 
com faces  

Superfície 
Complexa com 
faces no formato 
regular 
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complexa representadas de forma facetada, também pode ser aumentado com a 

quantidade de faces no modelo CAD C (FormZ). 

A seguir, o Quadro 28 reúne todos os resultados obtidos em cada fase de 

elaboração do experimento utilizando o modelo CAD C (FormZ) e a impressora 

tridimensional Zprinter (Z). 
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Quadro 28 - Comparação entre os resultados da Fase 1, Fase 2 e Fase 4 (Modelo CZ) 
FASE 1 

Imagem Modelo CAD C (FormZ) 
FASE 2 

Imagem Modelo CZ (Zprint) 
FASE 4 

Foto Protótipo CZ (Zprinter) 

   

   

   

 
 

 
QTD TIPO DE GEOMETRIA 

Modelo CAD (L x P x H) m 
QTD INTEROPERABILIDADE 

ENTRE OS SOFTWARES 
QTD TIPO DE GEOMETRIA 

Protótipo (L x P x H) m 
01 Base = 10,00x10,00x0,80 01 Base: Geom. importada integralmente 01 Base = 10,00x10,00x0,80 

01 Piso Externo=12,00x16,00x0,40 
Elemento Vazado= 
10,00x2,00x0,40 

01 Piso Externo com Elem. Vazado: 
Geom. importada integralmente 

01 Piso Externo=12,00x16,00x0,40 
Elemento Vazado= 10,00x2,00x0,40 

 
04 
02 

Vigas Externas Frontais= 
4,25x0,20x0,40 
3,20x0,20x0,40 

06 Vigas Externas Frontais:  
Geometrias importadas integralmente 

 
04 
02 

Vigas Externas Frontais= 
4,25x0,20x0,40 
3,20x0,20x0,40 

02 Pilares Externos= 
0,40x0,20x5,20 

02 Pilares Externos: 
Geometrias importadas integralmente 

02 Pilares Externos= 
0,40x0,20x5,20 

02 
 

02 

Paredes Laterais=  
0,20x7,00x5,60 
Paredes Fundos= 
 0,20x1,70x4,80 

04 Paredes Laterais: 
Geometrias importadas integralmente 
Paredes Fundos: 
Geometrias importadas integralmente 

 
02 

 
02 

Paredes Laterais= 0,20x7,00x5,60 
Paredes Fundos= 
 0,20x1,70x4,80 

 
01 
01 
01 
04 
02 

Elementos internos: Não medidos 
Escada 
Pilar 
Laje Mezanino 
Paredes Internas 
Vigas Fundos 

09 Elementos internos:  
Escada 
Pilar 
Laje Mezanino 
Paredes Internas 
Vigas Fundos 
Geometrias importadas Integralmente 

 
01 
01 
01 
04 
02 

Elementos internos: Não medidos 
Escada 
Pilar 
Laje Mezanino 
Paredes Internas 
Vigas Fundos 

01  Cobertura Curva Menor = 
12,00x0,56x0,40 
Não apresenta faces planas  

01 Cobertura Curva Menor: 
Geometria importada integralmente 
Apresenta 12 faces  

01 Cobertura Curva Menor = 
12,00x0,56x0,40 
Apresenta 12 faces  

01 Cobertura Maior: 
Elemento Plano= 
12,00x6,48x0,40 
Elemento Vazado= 
10,00x2,00x0,40 
Curva Maior= 
12,00x6,96x0,40 
Não apresenta faces planas 

01 Cobertura Maior: 
Elemento plano 
Geometria importada integralmente 
Elemento Vazado 
Geometria importada integralmente 
Curva Maior  
Geometria importada integralmente 
Apresenta 5 faces  

01 Cobertura Maior: 
Elemento Plano= 
12,00x6,48x0,40 
Elemento Vazado= 
10,00x2,00x0,40 
Curva Maior= 
12,00x6,96x0,40 
Apresenta 5 faces  

01 Cobertura em Balanço: 
 Curva 1 = 6,90x3,00x0,40 
 Curva 2 = 5,10x3,00x0,40 
Não apresenta faces planas 

01 Cobertura em Balanço  
Geometria importada integralmente 
Apresenta faces no padrão regular 

01 Cobertura em Balanço: 
 Curva 1 = 6,90x3,00x0,40 
 Curva 2 = 5,10x3,00x0,40 
Apresenta faces no padrão regular 

Fonte: Autoria nossa (fotos do protótipo rápido: Sílvio Uehara) 
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O quadro abaixo destaca a imagem ampliada do quadro anterior, e as 

diferenças observadas no protótipo rápido CZ (Zprinter) comparado ao modelo CAD 

C (FormZ). 

 

Quadro 29 - Diferenças na representação do protótipo rápido CZ (Zprinter) comparado ao modelo 
CAD C (FormZ) 

 

Fonte: Autoria nossa 

 

A representação do protótipo CZ (Zprinter) é idêntica à representação da 

imagem do modelo CAD C (FormZ), importado no software Zprint da impressora 

tridimensional, cuja superfície complexa apresenta faces no formato regular e as 

curvas também facetadas. O software do modelo CAD C (FormZ) permite que a 

configuração da resolução padrão (default) das geometrias curvas possa ser 

alterada, e o número de divisão das superfícies curvas e complexas pode ser 

aumentado, para que as faces não sejam visivelmente representadas.  

Todas as imagens utilizadas nos quadros demonstrados anteriormente, que 

contém os resultados dos experimentos, estão ampliadas para obter uma melhor 

visualização das mesmas, e encontram-se disponíveis nos apêndices B, C e D. 

O arquiteto deve considerar as medidas das cotas do desenho e não a 

escala informada no apêndice A, para modelar com precisão o mesmo projeto 

arquitetônico utilizado na realização dos experimentos desta Dissertação. 

O último apêndice, denominado apêndice E, apresenta as imagens dos três 

modelos CAD A (Revit), B (AutoCAD) e C (FormZ) no formato padrão STL, quando 

Superfície 
Complexa com 
faces no formato 
regular 

Curva Maior e 
Curva Menor 
com faces  
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importados pelo sistema CAD C (FormZ). Nestas imagens observamos que o 

modelo importado apresenta muito mais formas facetadas e trianguladas, 

comparado ao protótipo rápido, sendo assim não recomendamos a verificação da 

integridade do modelo CAD para prototipagem utilizando este processo.    

Nos próximos quadros, os dados dos experimentos são organizados de 

maneira a destacar as informações com diferenças na representação da geometria 

do modelo, e os diferentes tipos de geometrias agrupados.  

As geometrias ortogonais simples (externas) compreendem a base, o piso, o 

elemento vazado do piso, a laje plana da cobertura, as vigas, os pilares, as paredes 

laterais e de fundos do modelo. As geometrias ortogonais simples (internas) 

consideram a escada, o pilar interno, a laje do mezanino e as paredes internas da 

copa e do banheiro. A curva simples maior faz parte da cobertura e possui um 

elemento vazado, enquanto que a curva simples menor é o elemento que une o piso 

com a cobertura do modelo. A superfície curva complexa é formada por dupla 

curvatura invertida, na cobertura em balanço. 

A intenção é comparar as informações das geometrias de cada modelo CAD 

virtual original com as geometrias importadas no software da impressora 

tridimensional, e com o resultado obtido com a fabricação do modelo. Os critérios de 

comparação entre os aspectos da representação da geometria são a precisão em 

termos de resolução pelo número de faces, e a resolução por dimensionamento 

(largura x profundidade x altura), conferidos em escala.  

A primeira coluna lista os tipos de geometrias que compõem o modelo CAD. 

A segunda coluna quantifica o número de elementos de cada tipo de geometria. A 

terceira representa a condição de importação de todas as geometrias do modelo 

CAD pelo software da impressora tridimensional, por meio de arquivo padrão STL 

gerado pelo modelo CAD, possibilitando definir outro modelo virtual com nome e 

padrão de arquivo da impressora tridimensional.  

A quarta coluna contém dados sobre a precisão, em termos de resolução por 

números de faces, que representa o modelo virtual importado. A quinta coluna 

apresenta uma avaliação da precisão, em termos de resolução por números de 

faces, que representa o modelo prototipado. Por fim, a sexta coluna compara as 

dimensões dos elementos geométricos em relação ao projeto do modelo CAD 

original. 
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Quanto à interoperabilidade entre os sistemas, os resultados referentes à 

comparação entre os tipos de geometrias dos modelos são demonstrados em três 

níveis distintos: geometrias importadas integralmente, geometrias parcialmente 

importadas e geometrias não importadas.  

Os resultados referentes ao grau de semelhança do aspecto formal, em 

termos de precisão entre o modelo virtual, modelo importado e modelo físico são 

categorizados como geometrias totalmente idênticas, geometrias parcialmente 

idênticas e geometrias não idênticas. Cada experimento apresenta seu próprio 

quadro para análise e comparação, a seguir: 
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Quadro 30 - Comparação entre o resumo dos resultados do experimento (Modelo AX) 
MODELO CAD A 

 Revit  
(RVT) 

QUANTID. 
Geometrias 
(Unidades) 

MODELO AX 
Revit>ReplicatorG 

(STL) 
 

MODELO AX 
Revit>ReplicatorG 

PRECISÃO 
Nº Faces 

PROTÓTIPO AX 
Revit>Thing-O-Matic 

PRECISÃO 
Nº Faces 

PROTÓTIPO AX 
Revit>Thing-O-Matic 

PRECISÃO 
Dimensionamento 

Geometrias 
Ortogonais 

Simples 
(Externas) 

14 14 Geometrias do 
Modelo CAD A 

Importadas 
Integralmente 

para o 
ReplicatorG 

14 Geometrias 
do  

Modelo AX 
Totalmente 
Idênticas ao 

Modelo CAD A 

14 Geometrias  
do 

Protótipo AX 
Totalmente 
Idênticas ao 

Modelo CAD A 

12 Geometrias do 
Protótipo AX 
Totalmente 
Idênticas ao 

Modelo CAD A 

02 Geometrias do 
Protótipo AX 
Parcialmente 
Idênticas ao 

Modelo CAD A 
Variação Altura 

Geometrias 
Ortogonais 

Simples 
(Internas) 

09 09 Geometrias do 
Modelo CAD A 

Importadas 
Integralmente 

para o 
ReplicatorG 

09 Geometrias 
do  

Modelo AX 
Totalmente 
Idênticas ao 

Modelo CAD A 

09 Geometrias 
do 

Protótipo AX 
Totalmente 
Idênticas ao 

Modelo CAD A 

07 Geometrias  
do 

Protótipo AX 
Totalmente 
Idênticas ao 

Modelo CAD A 

02 Geometrias do 
Protótipo AX  

Não Idênticas ao 
Modelo CAD A 

Ausência Paredes 

Curva Simples 
Menor 

 
(Não Facetada) 

01 Geometria do 
Modelo CAD A 

Importada 
Integralmente 

para o 
ReplicatorG 

Geometria do 
Modelo AX 

Parcialmente 
Idêntica ao 

Modelo CAD A 
22 Faces 

Geometria do 
Protótipo AX 

Totalmente Idêntica 
ao 

Modelo CAD A 

Geometria do 
Protótipo AX 

Totalmente Idêntica 
ao 

Modelo CAD A 

Curva Simples 
Maior 

 
(Não Facetada) 

01 Geometria do 
Modelo CAD A 

Importada 
Integralmente 

para o 
ReplicatorG 

Geometria do 
Modelo AX 

Parcialmente 
Idêntica ao 

Modelo CAD A 
10 Faces 

Geometria do 
Modelo AX 

Parcialmente 
Idêntica ao 

Modelo CAD A 
10 Faces 

Geometria do 
Protótipo AX 

Totalmente Idêntica 
ao 

Modelo CAD A 

Superfície 
Curva 

Complexa 
 

(Não Facetada) 

01 Geometria do 
Modelo CAD A 

Importada 
Integralmente 

para o 
ReplicatorG 

Geometria do 
Modelo AX 
Totalmente 
Idêntica ao 

Modelo CAD A 

Geometria do 
Protótipo AX 

Totalmente Idêntica 
ao 

Modelo CAD A 

Geometria do 
Protótipo AX 

Totalmente Idêntica 
ao 

Modelo CAD A 

Fonte: Autoria nossa 
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Quadro 31 - Comparação entre o resumo dos resultados do experimento (Modelo AZ) 
MODELO CAD A 

 Revit  
(RVT) 

QUANTID. 
Geometrias 
(Unidades) 

MODELO AZ 
Revit>Zprint 

(STL) 
 

MODELO AZ 
Revit>Zprint 

PRECISÃO 
Nº Faces 

PROTÓTIPO AZ 
Revit>Zprinter 

PRECISÃO 
Nº Faces 

PROTÓTIPO AZ 
Revit>Zprinter 

PRECISÃO 
Dimensionamento 

Geometrias 
Ortogonais 

Simples 
(Externas) 

14 14 Geometrias do 
Modelo CAD A 

Importadas 
Integralmente 

para o 
Zprint 

14 Geometrias  
do  

Modelo AZ 
Totalmente 
Idênticas ao 

Modelo CAD A 

14 Geometrias  
do 

Protótipo AZ 
Totalmente 
Idênticas ao 

Modelo CAD A 

14 Geometrias 
do 

Protótipo AZ 
Totalmente 
Idênticas ao 

Modelo CAD A 

Geometrias 
Ortogonais 

Simples 
(Internas) 

09 09 Geometrias do 
Modelo CAD A 

Importadas 
Integralmente 

para o 
Zprint 

09 Geometrias 
do  

Modelo AZ 
Totalmente 
Idênticas ao 

Modelo CAD A 

09 Geometrias  
do 

Protótipo AZ 
Totalmente 
Idênticas ao 

Modelo CAD A 

09 Geometrias  
do 

Protótipo AZ 
Totalmente 
Idênticas ao 

Modelo CAD A 

Curva Simples 
Maior 

 
(Não Facetada) 

01 Geometria do 
Modelo CAD A 

Importada 
Integralmente 

para o 
Zprint 

Geometria do 
Modelo AZ 

Parcialmente 
Idêntica ao 

Modelo CAD A 
10 Faces 

Geometria do 
Modelo AX 

Parcialmente 
Idêntica ao 

Modelo CAD A 
10 Faces 

Geometria do 
Protótipo AZ 

Totalmente Idêntica 
ao 

Modelo CAD A 

Curva Simples 
Menor 

 
(Não Facetada) 

01 Geometria do 
Modelo CAD A 

Importada 
Integralmente 

para o 
Zprint 

Geometria do 
Modelo AZ 

Parcialmente 
Idêntica ao 

Modelo CAD A 
28 Faces 

Geometria do 
Protótipo AZ 

Totalmente Idêntica 
ao 

Modelo CAD A 

Geometria do 
Protótipo AZ 

Totalmente Idêntica 
ao 

Modelo CAD A 

Superfície 
Curva 

Complexa 
 

(Não Facetada) 

01 Geometria do 
Modelo CAD A 

Importada 
Integralmente 

para o 
Zprint 

Geometria do 
Modelo AZ 
Totalmente 
Idêntica ao 

Modelo CAD A 

Geometria do 
Protótipo AZ 

Totalmente Idêntica 
ao 

Modelo CAD A 

Geometria do 
Protótipo AZ 

Totalmente Idêntica 
ao 

Modelo CAD A 

Fonte: Autoria nossa 
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Quadro 32 - Comparação entre o resumo dos resultados do experimento (Modelo BX) 
MODELO CAD B 

 AutoCAD  

(DWG) 

QUANTID. 
Geometrias 
(Unidades) 

MODELO BX 
AutoCAD>Replicator

G 

(STL) 
 

MODELO BX 
AutoCAD>Replicator

G 

PRECISÃO 
Nº Faces 

PROTÓTIPO BX 
AutoCAD>Thing-O-

Matic 

PRECISÃO 
Nº Faces 

PROTÓTIPO BX 
AutoCAD>Thing-O-

Matic 

PRECISÃO 
Dimensionamento 

Geometrias 
Ortogonais 

Simples 
(Externas) 

14 14 Geometrias do 
Modelo CAD B 

Importadas 
Integralmente 

para o 
ReplicatorG 

14 Geometrias 
do  

Modelo BX 
Totalmente 
Idênticas ao 

Modelo CAD B 

14 Geometrias  
do 

Protótipo BX 
Totalmente 
Idênticas ao 

Modelo CAD B 

13 Geometrias do 
Protótipo BX 

Totalmente Idêntica 
ao 

Modelo CAD B 

01 Geometria do 
Protótipo BX 
Parcialmente 
Idêntica ao 

Modelo CAD B 
Variação Altura 

Geometrias 
Ortogonais 

Simples 
(Internas) 

09 09 Geometrias do 
Modelo CAD B 

Importadas 
Integralmente 

para o 
ReplicatorG 

09 Geometrias 
do  

Modelo BX 
Totalmente 
Idênticas ao 

Modelo CAD B 

09 Geometrias  
do 

Protótipo BX 
Totalmente 
Idênticas ao 

Modelo CAD B 

09 Geometrias  
do 

Protótipo BX 
Totalmente 
Idênticas ao 

Modelo CAD B 

Curva Simples 
Maior 

 
(Não Facetada) 

01 Geometria do 
Modelo CAD B 

Importada 
Integralmente 

para o 
ReplicatorG 

Geometria do 
Modelo BX 

Parcialmente 
Idêntica ao 

Modelo CAD B 
07 Faces 

Geometria do 
Modelo BX 

Parcialmente 
Idêntica ao 

Modelo CAD B 
07 Faces 

Geometria do 
Protótipo BX 

Totalmente Idêntica 
ao 

Modelo CAD B 

Curva Simples 
Menor 

 
(Não Facetada) 

01 Geometria do 
Modelo CAD B 

Importada 
Integralmente 

para o 
ReplicatorG 

Geometria do 
Modelo BX 

Parcialmente 
Idêntica ao 

Modelo CAD B 
08 Faces 

Geometria do 
Modelo BX 

Parcialmente 
Idêntica ao 

Modelo CAD B 
08 Faces 

Geometria do 
Protótipo BX 

Totalmente Idêntica 
ao 

Modelo CAD B 

Superfície 
Curva 

Complexa 
 

(Não Facetada) 

01 Geometria do 
Modelo CAD B 

Importada 
Integralmente 

para o 
ReplicatorG 

Geometria do 
Modelo BX 

Parcialmente 
Idêntica ao 

Modelo CAD B 
Facetada 

padrão irregular 
e regular 

Geometria do 
Protótipo BX 
Parcialmente 
Idêntica ao 

Modelo CAD B 
Facetada  
padrão 

irregular e regular 

Geometria do 
Protótipo BX 

Totalmente Idêntica 
ao 

Modelo CAD B 

Fonte: Autoria nossa 
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Quadro 33 - Comparação entre o resumo dos resultados do experimento (Modelo BZ) 
MODELO CAD B 

AutoCAD  

(DWG) 

QUANTID. 
Geometrias 
(Unidades) 

MODELO BZ 
AutoCAD>Zprint 

(STL) 
 

MODELO BZ 
AutoCAD>Zprint 

PRECISÃO 
Nº Faces 

PROTÓTIPO BZ 
AutoCAD>Zprinter 

PRECISÃO 
Nº Faces 

PROTÓTIPO BZ 
AutoCAD>Zprinter 

PRECISÃO 
Dimensionamento 

Geometrias 
Ortogonais 

Simples 
(Externas) 

14 14 Geometrias do 
Modelo CAD B 

Importadas 
Integralmente 

para o 
Zprint 

14 Geometrias 
do  

Modelo BZ 
Totalmente 
Idênticas ao 

Modelo CAD B 

14 Geometrias  
do 

Protótipo BZ 
Totalmente 
Idênticas ao 

Modelo CAD B 

14 Geometrias  
do 

Protótipo BZ 
Totalmente Idêntica 

ao 
Modelo CAD B 

Geometrias 
Ortogonais 

Simples 
(Internas) 

09 09 Geometrias do 
Modelo CAD B 

Importadas 
Integralmente 

para o 
Zprint 

09 Geometrias 
do  

Modelo BZ 
Totalmente 
Idênticas ao 

Modelo CAD B 

09 Geometrias  
do 

Protótipo BZ 
Totalmente 
Idênticas ao 

Modelo CAD B 

09 Geometrias  
do 

Protótipo BZ 
Totalmente Idêntica 

ao 
Modelo CAD B 

Curva Simples 
Maior 

 
(Não Facetada) 

01 Geometria do 
Modelo CAD B 

Importada 
Integralmente 

para o 
Zprint 

Geometria do 
Modelo BZ 

Parcialmente 
Idêntica ao 

Modelo CAD B 
07 Faces 

Geometria do 
Modelo BX 

Parcialmente 
Idêntica ao 

Modelo CAD B 
07 Faces 

Geometria do 
Protótipo BZ 

Totalmente Idêntica 
ao 

Modelo CAD B 

Curva Simples 
Menor 

 
(Não Facetada) 

01 Geometria do 
Modelo CAD B 

Importada 
Integralmente 

para o 
Zprint 

Geometria do 
Modelo BZ 

Parcialmente 
Idêntica ao 

Modelo CAD B 
08 Faces 

Geometria do 
Modelo BZ 

Parcialmente 
Idêntica ao 

Modelo CAD B 
08 Faces 

Geometria do 
Protótipo BZ 

Totalmente Idêntica 
ao 

Modelo CAD B 

Superfície 
Curva 

Complexa 
 

(Não Facetada) 

01 Geometria do 
Modelo CAD B 

Importada 
Integralmente 

para o 
Zprint 

Geometria do 
Modelo BZ 

Parcialmente 
Idêntica ao 

Modelo CAD B 
Facetada 

padrão irregular 
e regular 

Geometria do 
Protótipo BZ 
Parcialmente 
Idêntica ao 

Modelo CAD B 
Facetada 

Padrão irregular 
e regular 

Geometria do 
Protótipo BZ 

Totalmente Idêntica 
ao 

Modelo CAD B 

Fonte: Autoria nossa 
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Quadro 34 - Comparação entre o resumo dos resultados do experimento (Modelo CX) 
MODELO CAD C 

 FormZ  

(FMZ) 

QUANTID. 
Geometrias 
(Unidades) 

MODELO CX 
FormZ>ReplicatorG 

(STL) 
 

MODELO CX 
FormZ>ReplicatorG 

PRECISÃO 
Nº Faces 

PROTÓTIPO CX 
FormZ>Thing-O-Matic 

PRECISÃO 
Nº Faces 

PROTÓTIPO CX 
FormZ>Thing-O-Matic 

PRECISÃO 
Dimensionamento 

Geometrias 
Ortogonais 

Simples 
(Externas) 

14 14 Geometrias do 
Modelo CAD C 

Importadas 
Integralmente 

para o 
ReplicatorG 

14 Geometrias 
do 

Modelo CX 
Totalmente 
Idênticas ao 

Modelo CAD C 

14 Geometrias  
do 

Protótipo CX 
Totalmente 
Idênticas ao 

Modelo CAD C 

13 Geometria do 
Protótipo CX 

Totalmente Idêntica 
ao 

Modelo CAD C 
 

01 Geometria do 
Protótipo CX 
Parcialmente 
Idêntica ao 

Modelo CAD C 
Variação Altura 

Geometrias 
Ortogonais 

Simples 
(Internas) 

09 09 Geometrias do 
Modelo CAD C 

Importadas 
Integralmente 

para o 
ReplicatorG 

09 Geometrias 
do  

Modelo CX 
Totalmente 
Idênticas ao 

Modelo CAD C 

09 Geometrias  
do 

Protótipo CX 
Totalmente 
Idênticas ao 

Modelo CAD C 

09 Geometrias 
do 

Protótipo CX 
Totalmente Idêntica 

ao 
Modelo CAD C 

Curva Simples 
Maior 

 
(Não Facetada) 

01 Geometria do 
Modelo CAD C 

Importada 
Integralmente 

para o 
ReplicatorG 

Geometria do 
Modelo CX 

Parcialmente 
Idêntica ao 

Modelo CAD C 
05 Faces 

Geometria do 
Modelo CX 

Parcialmente 
Idêntica ao 

Modelo CAD C 
05 Faces 

Geometria do 
Protótipo CX 

Totalmente Idêntica 
ao 

Modelo CAD C 

Curva Simples 
Menor 

 
(Não Facetada) 

01 Geometria do 
Modelo CAD C 

Importada 
Integralmente 

para o 
ReplicatorG 

Geometria do 
Modelo CX 

Parcialmente 
Idêntica ao 

Modelo CAD C 
12 Faces 

Geometria do 
Modelo CX 

Parcialmente 
Idêntica ao 

Modelo CAD C 
12 Faces 

Geometria do 
Protótipo CX 

Totalmente Idêntica 
ao 

Modelo CAD C 

Superfície 
Curva 

Complexa 
 

(Não Facetada) 

01 Geometria do 
Modelo CAD C 

Importada 
Integralmente 

para o 
ReplicatorG 

Geometria do 
Modelo CX 

Parcialmente 
Idêntica ao 

Modelo CAD C 
Facetada 

padrão regular 

Geometria do 
Protótipo CX 
Parcialmente 
Idêntica ao 

Modelo CAD C 
Facetada 

padrão regular 

Geometria do 
Protótipo CX 

Totalmente Idêntica 
ao 

Modelo CAD C 

Fonte: Autoria nossa 
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Quadro 35 - Comparação entre o resumo dos resultados do experimento (Modelo CZ) 
MODELO CAD C 

 FormZ  

(FMZ) 

QUANTID. 
Geometrias 
(Unidades) 

MODELO CZ 
FormZ>Zprint 

(STL) 
 

MODELO CZ 
FormZ>Zprint 

PRECISÃO 
Nº Faces 

PROTÓTIPO CZ 
FormZ>Zprinter 

PRECISÃO 
Nº Faces 

PROTÓTIPO CZ 
FormZ>Zprinter 

PRECISÃO 
Dimensionamento 

Geometrias 
Ortogonais 

Simples 
(Externas) 

14 14 Geometrias do 
Modelo CAD C 

Importadas 
Integralmente 

para o 
Zprint 

14 Geometrias 
do  

Modelo CZ 
Totalmente 
Idênticas ao 

Modelo CAD C 

14 Geometrias  
do 

Protótipo CZ 
Totalmente 
Idênticas ao 

Modelo CAD C 

14 Geometrias  
do 

Protótipo CZ 
Totalmente Idêntica 

ao 
Modelo CAD C 

Geometrias 
Ortogonais 

Simples 
(Internas) 

09 09 Geometrias do 
Modelo CAD C 

Importadas 
Integralmente 

para o 
Zprint 

09 Geometrias 
do  

Modelo CZ 
Totalmente 
Idênticas ao 

Modelo CAD C 

09 Geometrias  
do 

Protótipo CZ 
Totalmente 
Idênticas ao 

Modelo CAD C 

09 Geometrias  
do 

Protótipo CZ 
Totalmente Idêntica 

ao 
Modelo CAD C 

Curva Simples 
Maior 

 
(Não Facetada) 

01 Geometria do 
Modelo CAD C 

Importada 
Integralmente 

para o 
Zprint 

Geometria do 
Modelo CZ 

Parcialmente 
Idêntica ao 

Modelo CAD C 
05 Faces 

Geometria do 
Modelo CZ 

Parcialmente 
Idêntica ao 

Modelo CAD C 
05 Faces 

Geometria do 
Protótipo CZ 

Totalmente Idêntica 
ao 

Modelo CAD C 

Curva Simples 
Menor 

 
(Não Facetada) 

01 Geometria do 
Modelo CAD C 

Importada 
Integralmente 

para o 
Zprint 

Geometria do 
Modelo CZ 

Parcialmente 
Idêntica ao 

Modelo CAD C 
12 Faces 

Geometria do 
Modelo CZ 

Parcialmente 
Idêntica ao 

Modelo CAD C 
12 Faces 

Geometria do 
Protótipo CZ 

Totalmente Idêntica 
ao 

Modelo CAD C 

Superfície 
Curva 

Complexa 
 

(Não Facetada) 

01 Geometria do 
Modelo CAD C 

Importada 
Integralmente 

para o 
Zprint 

Geometria do 
Modelo CZ 

Parcialmente 
Idêntica ao 

Modelo CAD C 
Facetada 

padrão regular 

Geometria do 
Protótipo CZ 
Parcialmente 
Idêntica ao 

Modelo CAD C 
Facetada 

padrão regular 

Geometria do 
Protótipo CZ 

Totalmente Idêntica 
ao 

Modelo CAD C 

Fonte: Autoria nossa 

 

Todos os elementos geométricos dos modelos gerados nos três diferentes 

tipos de sistema CAD foram importados integralmente nos dois diferentes softwares 

do sistema de prototipagem rápida, durante a realização dos experimentos. Foi 

possível obter resultados bastante homogêneos e as pequenas diferenças foram 

identificadas basicamente na resolução das curvas e superfícies complexas. 

Os resultados destes experimentos diferem da expectativa levantada na 

problemática descrita no início desta Dissertação, no primeiro Capítulo Introdução, 

onde foram apresentadas falhas na fabricação do protótipo. Inicialmente, isto nos fez 

crer na possível existência de variados problemas de interoperabilidade entre os 

sistemas utilizados, como por exemplo inversão de normais, rachaduras, erros de 

cavidades nas superfícies do modelo importado, entre outros. Estes mesmos 

problemas não ocorreram no momento da experimentação deste trabalho.  

De forma a esclarecer os vários problemas ocorridos no exemplo citado 

anteriormente, uma entrevista informal foi realizada com a autora do modelo, Bianca 
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Ilha, seguindo como roteiro as recomendações sugeridas no final do décimo 

capítulo. Pode-se constatar que as questões a seguir levaram inevitavelmente aos 

problemas de falhas na construção do modelo físico digital: 

 antes mesmo de ser exportado, o modelo CAD apresentava erros de 

formação de elementos geométricos e na fabricação - estes erros 

persistiram; 

 o software escolhido para modelagem não possuía opção para exportação 

do modelo, no formato compatível com a impressora tridimensional. Houve 

necessidade de incluir outro software de modelagem para realizar esta 

tarefa; e 

 o modelo virtual não foi pensado inicialmente para ser reproduzido como 

modelo físico, mas somente quando o mesmo já estava finalizado.  

Constatamos, a partir da análise dos resultados obtidos por meio dos 

experimentos da presente pesquisa, que a modelagem digital é fase essencial no 

processo de prototipagem. O arquiteto deve entender e construir virtualmente cada 

elemento do seu projeto de maneira precisa, conforme a sua intenção, para garantir 

a qualidade do seu modelo. 

Um mesmo projeto arquitetônico, modelado em diferentes sistemas CAD, 

pode apresentar diferentes graus de resolução, na representação de superfícies 

curvas e complexas, importadas e produzidas a partir de um mesmo sistema de 

prototipagem rápida. 

Em todos os casos da experimentação, a resolução das superfícies curvas e 

complexas é reproduzida de maneira idêntica ao modelo virtual do arquivo formato 

STL, importado no software de prototipagem, e não como a imagem do modelo 

virtual original do sistema CAD. 

O modelo gerado no sistema CAD específico - o modelo CAD A (Revit), e 

importado nos diferentes sistemas de prototipagem rápida, apresenta a resolução da 

superfície complexa de forma idêntica à do modelo virtual original. No momento da 

modelagem, Fase 1 (modelagem no sistema CAD), esta geometria não permitiu 

acessar as ferramentas para edição do grau de resolução das superfícies. Mas, no 

caso da superfície curva simples, os comandos de edição tornaram-se disponíveis.  

Por outro lado, os modelos dos sistemas CAD genéricos utilizados no 

experimento, apesar de apresentarem o mesmo tamanho de arquivo STL, 

representam o tamanho e o formato das faces das superfícies curvas complexas, de 
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maneira diferente entre si, conforme as imagens dos modelos CAD importados no 

formato STL que constam no Apêndice E. 

As curvas simples dos três modelos virtuais originais são representadas 

tanto nos modelos virtuais importados pelos softwares das impressoras 

tridimensionais, quanto nos protótipos com as faces, conforme resolução padrão 

(default) do sistema CAD. 

Todos os elementos geométricos do modelo gerado nos três diferentes tipos 

de sistema CAD foram reproduzidos, na impressora tridimensional Zprinter, com a 

mesma dimensão em largura, profundidade e altura do modelo CAD original. 

No caso da impressora tridimensional da MakerBot, mesmo com todos os 

elementos geométricos importados e modelados a partir dos três diferentes tipos de 

sistemas CAD, o protótipo apresentou irregularidades quanto ao aspecto de 

precisão, no dimensionamento e na representação de algumas formas simples 

ortogonais.  

A maior quantidade de erros pode ser observada no modelo produzido na 

impressora tridimensional da Makerbot, a partir do sistema CAD específico, modelo 

CAD A (Revit), posto que não obteve sucesso na construção de duas paredes 

internas, e reproduziu com variação na forma e na dimensão da altura duas vigas 

frontais. No caso dos modelos gerados nos sistemas CAD genéricos, apenas uma 

das vigas frontais foi reproduzida com variação na forma e na dimensão da altura. 

Deve-se observar que estes problemas de prototipagem rápida 

provavelmente são decorrentes da maneira como o arquivo padrão STL gerou as 

informações, associado ao limite de precisão do equipamento e de seu respectivo 

processo construtivo.  

As informações a seguir são agrupadas com o intuito de avaliar a relação 

entre o tamanho dos formatos de arquivo, a resolução dos elementos geométricos e 

o tempo de fabricação gasto para cada um dos modelos CAD.  

Os tipos de formatos de arquivos de modelo CAD e STL são quantificados 

em KB (Kilobyte) nas duas primeiras linhas. O número de faces, de todos os 

elementos de cada modelo, também foi registrado. As duas últimas linhas registram 

o tempo total estimado de fabricação, em cada tipo de impressora tridimensional 

utilizada no experimento (soma do tempo de fabricação com o tempo de espera, 

acrescido do tempo aproximado gasto para efetuar o acabamento do protótipo 

rápido), conforme demonstra o quadro a seguir: 
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Quadro 36 - Tamanho dos arquivos dos modelos CAD e STL e tempo total de fabricação 

FORMATO MODELO A (REVIT) MODELO B (AUTOCAD) MODELO C (FORMZ) 

MODELO CAD 26.696 KB 318 KB 672 KB 

ARQUIVO STL 1.560 KB 69 KB 69 KB 

Nº FACES 6.340 1.402 1.398 

TEMPO TOTAL 
FABRICAÇÃO 

Zprinter 
8 Horas 7 Horas 7 Horas e 30 minutos 

TEMPO TOTAL 
FABRICAÇÃO 
Thing-O-Matic 

3 Horas e 30 minutos 3 Horas 3 Horas 

Fonte: Autoria nossa 

 

A variação do tamanho de arquivos formato CAD e STL do sistema CAD 

específico - muito maiores que os arquivos dos sistemas CAD genérico, não resultou 

no aumento de tempo na fabricação dos modelos físicos, pelo processo de adição 

de camadas. Constatou-se que a diferença de tempo resulta tão somente do 

trabalho manual, que consistiu em retirada do excesso de material, lixamento, e a 

resinagem no caso do protótipo da impressora Zprinter, na fase de acabamento.  

O modelo CAD A (Revit) apresenta o arquivo e o número de faces com 

tamanho muito maior, comparado com os arquivos modelo CAD B (AutoCAD) e C 

(FormZ). Isto pode estar relacionado com a resolução maior da superfície complexa, 

o que possibilitou produzir esta geometria sem formas facetadas, de maneira 

idêntica ao modelo virtual original. 

No caso do arquivo STL gerado a partir do modelo CAD A (Revit), também 

com tamanho muito maior, comparado com os outros dois arquivos no mesmo 

formato, este pode estar relacionado tanto com a resolução maior da superfície 

complexa quanto ao fato deste arquivo não ser nativo do software Revit.  
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10 CONCLUSÃO 

 

Os resultados obtidos por meio dos experimentos desenvolvidos nesta 

Dissertação sugerem que a hipótese é promissora, uma vez que afirma que o uso de 

diferentes tipos de sistemas CAD e de prototipagem rápida resulta em diferentes 

níveis de sucesso, na transferência de informações entre os mesmos. Apesar do 

variado grau de precisão, verificou-se que tais sistemas podem representar de forma 

satisfatória os modelos físicos digitais, em relação aos modelos virtuais originais, 

portanto sem necessidade de retrabalho. 

A interoperabilidade, ou seja, a transferência das informações de um dado 

sistema CAD para outro de prototipagem rápida, ocorreu com sucesso quanto à 

integralidade de todos os elementos geométricos que formam o modelo original, 

considerando a utilização do formato padrão STL nas atividades de exportação e 

importação.  

Se por um lado a interoperabilidade entre os sistemas utilizados neste 

experimento ocorreu integralmente, por outro a questão de precisão pode ser 

avaliada de maneira distinta. O protótipo resultante não foi exatamente igual para 

todos os sistemas utilizados, devido aos diferentes níveis de resolução dos arquivos 

STL gerados para a transferência de dados, e devido às limitações em termos de 

precisão dos sistemas de prototipagem.  

Em termos de precisão na representação dos modelos, a resolução das 

superfícies curvas e complexas ocorreu de forma diferenciada em cada tipo de 

sistema CAD utilizado. O sistema CAD específico gerou o arquivo STL com número 

de faces muito maior do que os arquivos gerados pelos sistemas CAD genéricos, 

consequentemente reproduziu a superfície curva complexa com maior resolução e 

igualdade, em relação ao modelo CAD original.  

No caso dos sistemas CAD genéricos, estes produziram arquivos STL com 

tamanhos e número de faces muito similares entre si. Mesmo assim, a resolução 

ocorreu de forma diferenciada quanto à representação do formato e tamanho das 

faces das superfícies complexas, baseada no padrão do arquivo STL exportado.  

Os diferentes sistemas CAD necessitam de uma resolução maior do que a 

usualmente padrão, para representar da mesma forma o modelo importado nos 

sistemas de prototipagem rápida. O grau de precisão em termos de resolução das 
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superfícies curvas e complexas depende da definição maior ou menor desses 

mesmos parâmetros, dentro do sistema CAD, que podem variar conforme o 

interesse do usuário no momento da modelagem. 

Os dois sistemas de prototipagem rápida reproduzem de maneira idêntica a 

representação do modelo CAD importado, sendo assim o usuário não necessita 

produzir o modelo físico para verificar se a resolução das superfícies curvas e 

complexas atende a sua intenção de projeto.  

Conforme a intenção de produzir as superfícies curvas sem o aspecto 

facetado, as informações obtidas nos experimentos sugerem que no momento da 

modelagem a resolução dos elementos geométricos das superfícies curvas seja 

aumentada ao máximo possível. O arquivo STL gerado não aumenta o tempo de 

fabricação do modelo prototipado, considerando o processo por adição de camadas. 

Se a intenção da representação for tirar partido da resolução facetada das 

superfícies curvas, sugere-se manter a resolução baixa desses elementos 

geométricos ou ainda mantê-los na resolução padrão (default) do sistema CAD. 

A reprodução idêntica dos modelos CAD original, em modelos prototipados, 

não depende somente da interoperabilidade entre os sistemas. Nos diferentes 

sistemas CAD, além da configuração de resolução das superfícies curvas e 

complexas, depende também das características dos equipamentos de 

prototipagem, como a resolução de camadas, resistência do material e escala 

empregada.  

Sintetizando, por um lado os sistemas CAD definem a precisão em termos 

de resolução das faces do modelo, observada principalmente nas curvas e 

superfícies complexas. Por outro lado, os sistemas de prototipagem rápida são 

responsáveis pela precisão em temos de dimensionamento dos elementos 

geométricos. Em outras palavras, a obtenção de um protótipo rápido idêntico ao 

modelo virtual original depende tanto da resolução definida inicialmente no sistema 

CAD quanto do grau de precisão oferecido pelo equipamento de prototipagem 

rápida.  

Os resultados obtidos sugerem que a modelagem em diferentes sistemas 

CAD e de prototipagem rápida, desde o início do processo de projetação, pode ser 

considerada um recurso confiável, pelo fato de oferecer ferramentas capazes de 

representar de maneira rápida e fidedigna a intenção formal do arquiteto.  
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As especificações definidas em cada fase dos experimentos realizados 

podem auxiliar o arquiteto a produzir modelos físicos digitais, a partir de modelos 

CAD, com menor quantidade de retrabalho. Portanto elaboramos as seguintes 

recomendações, divididas em dois quadros apresentados a seguir: o primeiro com 

as recomendações gerais que devem ser seguidas antes do início do processo de 

projeto e, o segundo, com as recomendações específicas, que reúnem as 

descrições de cada item de todo o processo de modelagem e prototipagem rápida. 

 

Quadro 37 - Recomendações gerais para modelagem em CAD e prototipagem rápida por adição 

RECOMENDAÇÕES 
GERAIS 

ITENS DESCRIÇÃO 

Escolha do Sistema CAD 

 Geometrias Complexas O software escolhido de sistema CAD 
deve oferecer ferramentas para 
modelagem de geometrias complexas, 
de maneira a não limitar a proposta de 
projeto. 

 Parametrização Deve disponibilizar ferramentas de 
parametrização de elementos 
geométricos, pois reduzem o tempo de 
remodelagem manual. 
 

 Arquivo STL ou padrão 
3DP 

Deve disponibilizar o comando ou plug 
in para exportação no formato padrão 
STL ou compatível com impressora 
tridimensional escolhida. 

Escolha do Sistema de 
Prototipagem Rápida 

 Arquivo STL ou padrão 
CAD 

O software de prototipagem rápida deve 
oferecer o comando para importação no 
formato padrão STL ou compatível com 
o software CAD escolhido 

 Especificações do 
Equipamento 

Verificar o tamanho máximo em 
comprimento, largura e altura da base 
de construção do protótipo e o limite de 
espessura, para calcular a relação entre 
a escala e o menor tamanho permitido 
para modelar um elemento geométrico. 

 Protótipo Inteiro ou por 
Montagem 

Prever a produção do protótipo por 
inteiro ou em partes separadas, o que 
requer cuidados específicos no encaixe 
e montagem (assunto não abordado 
neste trabalho). 

Divisão de Todo o Processo 
em Fases 

 Fase 1 (modelagem no 
sistema CAD) 

 Fase 2 (Planejamento) 

 Fase 3 (Fabricação no 
sistema de 
prototipagem rápida) 

 Fase 4 (Acabamento) 

Dividir e organizar o processo de 
prototipagem desde a modelagem para 
possibilitar a economia de tempo e 
custos. 

Fonte: Autoria nossa 
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Quadro 38 - Recomendações específicas para modelagem em CAD e prototipagem rápida por adição 

RECOMENDAÇÕES 
ESPECÍFICAS 

ITENS DESCRIÇÃO 

Fase 1 
(modelagem no 
sistema CAD) 

 Elementos Fechados 
ou Unidos 

Construir o modelo virtual com elementos 
geométricos fechados ou unidos. 

 Quadrante + x, y, z Construir o modelo virtual nos quadrantes 
positivos em x, y, z, do ambiente gráfico. 

 Resolução da 
Geometria Curva ou 
Complexa 

Aumentar a resolução da geometria curva ou 
complexa, conforme a intenção de 
representação do modelo físico. 

 Elementos 
Transparentes 

Optar em não representar os elementos 
transparentes no protótipo; caso haja intenção 
do protótipo todo fechado, verificar necessidade 
de orifício para retirada do material interno (pó). 

 Exportar STL ou 
padrão 3DP 

Exportar o arquivo no formato STL ou 
compatível entre os sistemas CAD/CAM 
escolhidos. 

Fase 2 
(Planejamento) 

 

 Importar STL ou 
padrão 3DP 

Importar o arquivo no formato STL ou 
compatível entre os sistemas CAD/CAM 
escolhidos. 

 Interoperabilidade Verificar se todos os elementos que formam o 
modelo são representados dentro do software 
da impressora tridimensional. 

 Inversão de Normais Caso algum ou vários elementos da geometria 
do modelo não sejam representados, utilizar o 
comando para inversão de normais do sistema 
de prototipagem. 

 Resolução Conferir o grau de resolução das curvas e 
superfícies complexas, que devem ser 
representadas conforme intenção proposta. 

 Correção do Modelo 
Virtual 

Retornar à Fase 1 (modelagem no sistema CAD) 
para efetuar a correção da geometria e 
resolução do modelo. 

 Modelo Correto O modelo deve ser representado corretamente, 
para poder ser configurado para prototipagem. 

 Escala Definir a escala do modelo, conforme a unidade 
de desenho definida no sistema CAD. 

 Suporte Verificar a necessidade de suporte para 
construção estável do protótipo. 

 Rotação e Origem Verificar a melhor posição, rotação, ponto de 
origem e os afastamentos conforme 
necessidade no momento de retirada do 
protótipo do equipamento. 

 Estimativa do Tempo 
de Fabricação 

Verificar o tempo estimado para fabricação, 
geralmente disponibilizado pelo comando print 
preview do sistema de prototipagem rápida. 

Fase 3 
(Fabricação no 

sistema de 
prototipagem rápida) 

 

 Manual de Instruções Seguir o manual de instrução do equipamento 
escolhido para produzir o protótipo rápido. 

Fase 4 
(Acabamento) 

 Acabamento Efetuar o acabamento do protótipo conforme 
recomendações do fabricante. 

 Tempo Total de 
Fabricação 

Considerar o somatório do tempo de fabricação, 
com o tempo de pós-fabricação e a estimativa 
do tempo para acabamento final do protótipo. 

Fonte: Autoria nossa 
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10.1 Desdobramentos Futuros 

 

A proposta para a continuidade deste estudo sugere a utilização dos 

sistemas CAD/CAM para o desenvolvimento e finalização do mesmo projeto 

arquitetônico, definido inicialmente no experimento desta Dissertação. Outras 

condicionantes poderiam ser consideradas, como a análise de desempenhos 

estruturais e energético, para o desenvolvimento das próximas etapas de 

desenvolvimento do projeto, utilizando-se softwares específicos. Até chegar à etapa 

final, poderiam ser incorporados outros sistemas de fabricação digital para a 

produção e montagem do protótipo do projeto, com maior grau de detalhamento e 

em escala tamanho real de pré-produção.  

As ferramentas digitais poderiam ser estudadas para serem aplicadas, ainda 

no contexto de processo de projeto arquitetônico, de maneira integrada com as 

demais áreas especializadas da própria arquitetura e das engenharias, com o intuito 

de otimizar a qualidade do projeto e de sua execução. 
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APÊNDICE A - DESENHOS DO PROJETO ARQUITETÔNICO DO 

MODELO DO EXPERIMENTO 
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APÊNDICE B - VISTAS EXTERNAS RENDERIZADAS DOS MODELOS 

CAD 

 

 

VISTA NORDESTE – MODELO CAD A (REVIT) 

 

 

 

VISTA NOROESTE – MODELO CAD A (REVIT) 
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VISTA SUDESTE – MODELO CAD A (REVIT) 

 

 

 

VISTA SUDOESTE – MODELO CAD A (REVIT) 
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VISTA NORDESTE – MODELO CAD B (AUTOCAD) 

 

 

 

VISTA NOROESTE – MODELO CAD B (AUTOCAD) 
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VISTA SUDESTE – MODELO CAD B (AUTOCAD) 

 

 

 

VISTA SUDOESTE – MODELO CAD B (AUTOCAD) 
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VISTA NORDESTE – MODELO CAD C (FORMZ) 

 

 

 

VISTA NOROESTE – MODELO CAD C (FORMZ) 
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VISTA SUDESTE – MODELO CAD C (FORMZ) 

 

 

 

VISTA SUDOESTE – MODELO CAD C (FORMZ) 
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APÊNDICE C - VISTAS EXTERNAS DOS MODELOS 

IMPORTADOS PARA PROTOTIPAGEM 

 

 

VISTA NORDESTE – MODELO AX (REVIT > REPLICATORG) 

 

 

 

VISTA NOROESTE – MODELO AX (REVIT > REPLICATORG) 
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VISTA SUDESTE – MODELO AX (REVIT > REPLICATORG) 

 

 

 

VISTA SUDOESTE – MODELO AX (REVIT > REPLICATORG) 
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VISTA NORDESTE – MODELO BX (AUTOCAD > REPLICATORG) 

 

 

 

VISTA NOROESTE – MODELO BX (AUTOCAD > REPLICATORG) 
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VISTA SUDESTE – MODELO BX (AUTOCAD > REPLICATORG) 

 

 

 

VISTA SUDOESTE – MODELO BX (AUTOCAD > REPLICATORG) 
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VISTA NORDESTE – MODELO CX (FORMZ > REPLICATORG) 

 

 

 

VISTA NOROESTE – MODELO CX (FORMZ > REPLICATORG) 
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VISTA SUDESTE – MODELO CX (FORMZ > REPLICATORG) 

 

 

 

VISTA SUDOESTE – MODELO CX (FORMZ > REPLICATORG) 
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VISTA NORDESTE – MODELO AZ (REVIT > ZPRINT) 

 

 

 

VISTA NOROESTE – MODELO AZ (REVIT > ZPRINT) 
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VISTA SUDESTE – MODELO AZ (REVIT > ZPRINT) 

 

 

 

VISTA SUDOESTE – MODELO AZ (REVIT > ZPRINT) 
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VISTA NORDESTE – MODELO BZ (AUTOCAD > ZPRINT) 

 

 

 

VISTA NOROESTE – MODELO BZ (AUTOCAD > ZPRINT) 
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VISTA SUDESTE – MODELO BZ (AUTOCAD > ZPRINT) 

 

 

 

VISTA SUDOESTE – MODELO BZ (AUTOCAD > ZPRINT) 
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VISTA NORDESTE – MODELO CZ (FORMZ > ZPRINT) 

 

 

 

 

VISTA NOROESTE – MODELO CZ (FORMZ > ZPRINT) 
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VISTA SUDESTE – MODELO CZ (FORMZ > ZPRINT) 

 

 

 

VISTA SUDOESTE – MODELO CZ (FORMZ > ZPRINT) 
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APÊNDICE D - FOTOS DOS PROTÓTIPOS RÁPIDOS 

 

 

VISTA NORDESTE – FOTO PROTÓTIPO AX (REVIT > THING-O-MATIC) 

 

 

 

VISTA NOROESTE – FOTO PROTÓTIPO AX (REVIT > THING-O-MATIC) 
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VISTA SUDESTE – FOTO PROTÓTIPO AX (REVIT > THING-O-MATIC) 

 

 

 

VISTA SUDOESTE – FOTO PROTÓTIPO AX (REVIT > THING-O-MATIC) 
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VISTA NORDESTE – FOTO PROTÓTIPO BX (AUTOCAD > THING-O-MATIC) 

 

 

 

VISTA NOROESTE – FOTO PROTÓTIPO BX (AUTOCAD > THING-O-MATIC) 
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VISTA SUDESTE – FOTO PROTÓTIPO BX (AUTOCAD > THING-O-MATIC) 

 

 

 

VISTA SUDOESTE – FOTO PROTÓTIPO BX (AUTOCAD > THING-O-MATIC) 
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VISTA NORDESTE – FOTO PROTÓTIPO CX (FORMZ > THING-O-MATIC) 

 

 

 

VISTA NOROESTE – FOTO PROTÓTIPO CX (FORMZ > THING-O-MATIC) 
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VISTA SUDESTE – FOTO PROTÓTIPO CX (FORMZ > THING-O-MATIC) 

 

 

 

VISTA SUDOESTE – FOTO PROTÓTIPO CX (FORMZ > THING-O-MATIC) 
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VISTA NORDESTE – FOTO PROTÓTIPO AZ (REVIT > ZPRINTER) 

 

 

 

VISTA NOROESTE – FOTO PROTÓTIPO AZ (REVIT > ZPRINTER) 
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VISTA SUDESTE – FOTO PROTÓTIPO AZ (REVIT > ZPRINTER) 

 

 

 

VISTA SUDOESTE – FOTO PROTÓTIPO AZ (REVIT > ZPRINTER) 
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VISTA NORDESTE – FOTO PROTÓTIPO BZ (AUTOCAD > ZPRINTER) 

 

 

 

VISTA NOROESTE – FOTO PROTÓTIPO BZ (AUTOCAD > ZPRINTER) 
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VISTA SUDESTE – FOTO PROTÓTIPO BZ (AUTOCAD > ZPRINTER) 

 

 

 

VISTA SUDOESTE – FOTO PROTÓTIPO BZ (AUTOCAD > ZPRINTER) 
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VISTA NORDESTE – FOTO PROTÓTIPO CZ (FORMZ > ZPRINTER) 

 

 

 

VISTA NOROESTE – FOTO PROTÓTIPO CZ (FORMZ > ZPRINTER) 
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VISTA SUDESTE – FOTO PROTÓTIPO CZ (FORMZ > ZPRINTER) 

 

 

 

VISTA SUDOESTE – FOTO PROTÓTIPO CZ (FORMZ > ZPRINTER) 
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APÊNDICE E - IMAGENS DOS ARQUIVOS STL DOS MODELOS 

CAD IMPORTADOS NO SOFTWARE FORMZ 

 

 

IMAGEM NO MODO WIREFRAME DE VISUALIZAÇÃO DO ARQUIVO STL DO 

MODELO CAD A (REVIT) IMPORTADO NO SOFTWARE FORMZ 

 

 

 

 

IMAGEM NO MODO HIDDENLINES DE VISUALIZAÇÃO DO ARQUIVO STL DO 

MODELO CAD A (REVIT) IMPORTADO NO SOFTWARE FORMZ 
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IMAGEM NO MODO WIREFRAME DE VISUALIZAÇÃO DO ARQUIVO STL DO 

MODELO CAD B (AUTOCAD) IMPORTADO NO SOFTWARE FORMZ 

 

 

 

 

IMAGEM NO MODO HIDDENLINES DE VISUALIZAÇÃO DO ARQUIVO STL DO 

MODELO CAD B (AUTOCAD) IMPORTADO NO SOFTWARE FORMZ 
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IMAGEM NO MODO WIREFRAME DE VISUALIZAÇÃO DO ARQUIVO STL DO 

MODELO CAD C (FORMZ) IMPORTADO NO SOFTWARE FORMZ 

 

 

 

 

IMAGEM NO MODO HIDDENLINES  DE VISUALIZAÇÃO DO ARQUIVO STL DO 

MODELO CAD C (FORMZ) IMPORTADO NO SOFTWARE FORMZ 
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